Copyright

© 2008 KONICA MINOLTA BUSINESS TECHNOLOGIES, INC.
Copyright © 2008 Creo Inc. All rights reserved.
This document is also distributed in Adobe Systems Incorporated’s PDF (Portable Document Format). You may reproduce the document from the PDF file for internal use. Copies produced from the PDF file must be reproduced in whole.

Trademarks

KONICA MINOLTA, the KONICA MINOLTA logo, and The essentials of imaging are registered trademarks of KONICA MINOLTA HOLDINGS, INC.
bizhub and bizhub PRO are registered trademarks of KONICA MINOLTA BUSINESS TECHNOLOGIES.
The Creo wordmark, the Creo logo, and the names of the Creo products and services referred to in this document are trademarks of Creo Inc.
Apple, iMac, Power Macintosh, AppleShare, AppleTalk, TrueType, and ImageWriter are registered trademarks of Apple Computer, Inc. Macintosh is a trademark of Apple Computer, Inc., registered in the U.S.A. and other countries.
PANTONE, Hexachrome, PANTONE Hexachrome, and PANTONE MATCHING SYSTEM are the property of Pantone, Inc.
PEARL, PEARLsetter, PEARLhdp, PEARLdry, and PEARLgold are registered trademarks of Presstek, Inc.
Other brand or product names are the trademarks or registered trademarks of their respective owners.

FCC Compliance

Any Creo equipment referred to in this document complies with the requirements in part 15 of the FCC Rules for a Class A digital device. Operation of the Creo equipment in a residential area may cause unacceptable interference to radio and TV reception, requiring the operator to take whatever steps are necessary to correct the interference.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard this product, it must be sent to appropriate facilities for recovery and recycling. Contact your local Creo PODS representative or refer to http://www.pod-wf.com for additional information on the collection and recovery programs available for this product.

Limitation of Liability

The product, software or services are being provided on an “as is” and “as available” basis. Except as may be stated specifically in your contract, Creo and its parents, subsidiaries, and affiliates expressly disclaim all warranties of any kind, whether express or implied, including, but not limited to, any implied warranties of merchantability, fitness for a particular purpose and non-infringement.
You understand and agree that, except as may be stated specifically in your contract, Creo and its parents, subsidiaries, and affiliates shall not be liable for any direct, indirect, incidental, special, consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Creo has been advised of the possibility of such damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of procurement of substitute goods and services resulting from any products, goods, data, software, information or services purchased; (iii) unauthorized access to or alteration of your products, software or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product, software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they are based are subject to change. Creo may, at any time and without notice, make changes to this document. Creo, for itself and on behalf of its parents, subsidiaries, and affiliates, assumes no liability for technical or editorial errors or omissions made herein, and shall not be liable for incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration of data, delays, or lost profits or savings arising from the use of this document.

Print On-Demand Solutions Group
http://www.pod-wf.com
Internal 731-00952B-EN
Revised March 2008
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Welcome</td>
<td>1</td>
</tr>
<tr>
<td>Welcome to the IC-304 Print Controller</td>
<td>2</td>
</tr>
<tr>
<td>Overview of IC-304 Print Controller</td>
<td>2</td>
</tr>
<tr>
<td>Hardware and Software Components</td>
<td>3</td>
</tr>
<tr>
<td>Supported File Formats</td>
<td>4</td>
</tr>
<tr>
<td>Workflow</td>
<td>5</td>
</tr>
<tr>
<td>IC-304 Print Controller Network Printers</td>
<td>5</td>
</tr>
<tr>
<td>2 Getting Started</td>
<td>7</td>
</tr>
<tr>
<td>Turning On the IC-304 Print Controller</td>
<td>8</td>
</tr>
<tr>
<td>The Workspace</td>
<td>9</td>
</tr>
<tr>
<td>The Printer Status Pane</td>
<td>11</td>
</tr>
<tr>
<td>The Alerts Window</td>
<td>12</td>
</tr>
<tr>
<td>The Job Info Area</td>
<td>12</td>
</tr>
<tr>
<td>The Preferences Window</td>
<td>14</td>
</tr>
<tr>
<td>The Resource Center</td>
<td>15</td>
</tr>
<tr>
<td>The Job Parameters Window</td>
<td>16</td>
</tr>
<tr>
<td>The Help Menu</td>
<td>18</td>
</tr>
<tr>
<td>Turning Off the IC-304 Print Controller</td>
<td>19</td>
</tr>
<tr>
<td>3 Working at a Client Workstation</td>
<td>21</td>
</tr>
<tr>
<td>Printing a Job from a Client Workstation</td>
<td>22</td>
</tr>
<tr>
<td>Defining a Printer in Windows</td>
<td>23</td>
</tr>
<tr>
<td>Defining a Printer on Macintosh</td>
<td>26</td>
</tr>
<tr>
<td>Working With Hot Folders</td>
<td>29</td>
</tr>
<tr>
<td>Print Driver Software</td>
<td>32</td>
</tr>
<tr>
<td>Installing the Print Driver Software on Macintosh</td>
<td>32</td>
</tr>
<tr>
<td>Accessing the Print Driver Software</td>
<td>38</td>
</tr>
<tr>
<td>Setting Job Parameters</td>
<td>40</td>
</tr>
<tr>
<td>Using Profiles</td>
<td>40</td>
</tr>
<tr>
<td>Controlled Printing</td>
<td>42</td>
</tr>
<tr>
<td>Viewing the Printer Status</td>
<td>43</td>
</tr>
<tr>
<td>PostScript Settings</td>
<td>46</td>
</tr>
<tr>
<td>Working Offline</td>
<td>46</td>
</tr>
<tr>
<td>Disabling the Print Driver Software</td>
<td>47</td>
</tr>
<tr>
<td>Uninstalling the Print Driver Software</td>
<td>49</td>
</tr>
<tr>
<td>EZ Connect</td>
<td>51</td>
</tr>
<tr>
<td>Launching EZ Connect</td>
<td>52</td>
</tr>
<tr>
<td>Adding a Server to the EZ Connect Window</td>
<td>53</td>
</tr>
<tr>
<td>Changing the Server Display Name</td>
<td>54</td>
</tr>
<tr>
<td>Deleting a Server</td>
<td>54</td>
</tr>
</tbody>
</table>
IC-304 Print Controller User Guide

4 Basic Workflows

- Basic Job Workflow .......................................................... 68
- Submitting ......................................................................... 68
- Processing ......................................................................... 68
- Storage ............................................................................. 69
- Importing and Printing Jobs ............................................. 70
  - Importing Files ............................................................... 71
  - Resubmitting ................................................................. 72
- Remote Scanning Application .......................................... 72
  - Setting Up Scan Boxes .................................................. 73
- Managing Scanned Images .............................................. 77

5 Managing Jobs

- Managing the Job Queues ................................................ 80
  - The Queues ..................................................................... 81
  - Status Information .......................................................... 84
  - Suspending and Resuming Queues ................................. 84
  - Changing the Order of Jobs in the Queues ..................... 85
  - Aborting a Running Job .................................................. 85
  - Batching Jobs .................................................................. 86
  - Moving a Waiting Job to the Storage Area ...................... 87
  - Deleting a Job .................................................................. 88
  - Unlocking a Job .............................................................. 88
- Managing the Storage Area ............................................. 89
- Preparing a Job .................................................................. 93
  - Navigation Buttons ........................................................ 94
  - Using the Preview Tools ................................................ 94
  - Viewing Pages in the Job Preview & Editor Window ......... 95
## Contents

- Editing an RTP Job ................................................................. 97
- Job Accounting................................................................................. 100
  - Viewing the Accounting Information ........................................... 101
  - Printing and Exporting the Accounting Log .............................. 103
  - Clearing the Information from the Accounting Viewer .............. 105
- Creating Virtual Printers ............................................................. 105
- Job Report .................................................................................. 107

### 6 Production Printing

- Imposition .................................................................................... 110
- Imposition Workflows ..................................................................... 110
- Printing with Page Exceptions .................................................... 117
- High-Resolution Workflow .......................................................... 119
- Creo APR ................................................................................... 120
- Export as PDF2Go ....................................................................... 120
- Fonts .......................................................................................... 121
  - Font List ................................................................................ 121
  - Managing Fonts on the IC-304 Print Controller ........................ 124
  - Downloading Fonts ................................................................. 124
- Managing Paper Type Profiles .................................................... 127
- Printing on Tabs Using the Tabs Plug-In for Acrobat .................... 129
  - Managing Tabs in the Tab Printing Window .............................. 135

### 7 Color Workflow

- Calibration .................................................................................. 138
  - Color Calibration Method .......................................................... 138
  - Choosing a Calibration Mode .................................................... 139
  - Performing Off-the-glass Calibration ........................................ 139
  - Performing Calibration with a Spectrophotometer .................... 142
  - Viewing Calibrated Media Type Information .............................. 145
- Color Tools ................................................................................ 146
  - Managing Profiles ................................................................. 146
  - Editing and Creating Spot Colors ............................................ 149
  - Protecting RGB and CMYK Colors .......................................... 152
  - Using the Gradation Tool to Adjust Color ................................. 154

### 8 VI Workflow

- VI Overview ................................................................................ 162
- VI Document Formats .............................................................. 163
  - Kodak Variable Print Specification .......................................... 164
  - PPML ...................................................................................... 165
  - PostScript Files ....................................................................... 165
- Using Variable Print Specification to Print a VI Job .................... 165
# System Administration

Setting Up and Configuring the IC-304 Print Controller ................................................................. 168
  Server Setup ................................................................................................................................. 169
  Network Setup ............................................................................................................................. 172
  Remote Tools Setup .................................................................................................................... 176
  Security ........................................................................................................................................ 177
  System Disks ............................................................................................................................... 180
  Scan Management ....................................................................................................................... 181
  Mail Service ............................................................................................................................... 183
  Connected Finishers .................................................................................................................... 184
  Localization ................................................................................................................................. 185
  Deletion Policy ............................................................................................................................ 186
  Pre-RIP Preview ......................................................................................................................... 187
  Print Queue Manager ................................................................................................................. 188
  Default Image Size ..................................................................................................................... 189
  Calibration Device ...................................................................................................................... 190
  JDF Output Path .......................................................................................................................... 191
  Paper Size Switch ....................................................................................................................... 192
  System Messages ....................................................................................................................... 193
  Job History ................................................................................................................................. 194
  Messages .................................................................................................................................... 195
  Backing Up and Restoring the Configuration ........................................................................... 198

# Setting Parameters

Setting Parameters in the Job Parameters Window ........................................................................... 202
  Print ............................................................................................................................................ 202
  Imposition ................................................................................................................................. 205
  Quality ......................................................................................................................................... 212
  Color ......................................................................................................................................... 216
  Finishing .................................................................................................................................... 220
  Exceptions .................................................................................................................................. 226
  Services ....................................................................................................................................... 229
  Setting Parameters in the PPD File .............................................................................................. 233

# Glossary

Glossary ........................................................................................................................................ 239

# Index

Index ............................................................................................................................................ 253
Welcome to the IC-304 Print Controller User Guide

Welcome to your IC-304 Print Controller User Guide.

This user guide is for IC-304 print controller operators and system administrators and explains how you can quickly and easily print from the IC-304 print controller or from a client workstation.

Overview of IC-304 Print Controller

The IC-304 print controller is an on-demand prepress system that uses Creo advanced prepress technologies to drive a printer.

As an optimal digital color solution for printers, the IC-304 print controller enables you to print from Windows®, Macintosh®, and UNIX® client workstations. The IC-304 print controller processes image files in page-description language (PDL) formats—for example, PostScript®, PDF, and Variable Information—using RIP (Raster Image Processor) technology. The system converts image files into a suitable processed format for direct, high-quality digital printing. The IC-304 print controller also streamlines the printing process by allowing printing with preset workflows.

In combination with the printer, the IC-304 print controller enables you to efficiently print flyers, brochures, pamphlets, dummy catalogs, short-run trials, and print-on-demand publications. When installed as a fast network printer with the IC-304 print controller, the printer prints up to 65 full-color/black and white A4 (210mm x 297mm)/Letter (8.5 inches x 11 inches) pages per minute.

The IC-304 print controller combines RIP functionalities, automation, control tools and special hardware development capabilities with PC architecture.
Hardware and Software Components

The IC-304 print controller includes:

- Interface boards
- Software
- Windows XP Professional software system
- Adobe® Acrobat® 8.0
Supported File Formats

The IC-304 print controller supports the following file formats:

- PostScript (composite or pre-separated files)
- PDF
- EPS
- Creo VPS (Variable Print Specification)
- PPML (Personalized Print Markup Language)
- JPG
- Pre-separated formats

The IC-304 print controller can import and covert the following GAP (Graphic Art Port) file types:

- Brisque Jobs
- TIFF
- TIFF IT
- CT / LW
Workflow

The IC-304 print controller basic workflow is as follows:

1. User activates Print in the DTIP application (for example, Microsoft PowerPoint).
2. User selects one of the default IC-304 print controller virtual printers (for example, Processor).
3. File is spooled to the IC-304 print controller.
4. File begins processing according to settings predefined in the file or for the selected virtual printer.
5. After the job has completed processing, the file is printed to the printer and a processed format of the job is stored in the Storage area on the IC-304 print controller.

IC-304 Print Controller Network Printers

The IC-304 print controller provides three default network printers, known also as virtual printers.

Virtual printers are a function used for automating workflows, which then define job streaming. They contain preset workflows that are automatically applied to all print jobs processed with that virtual printer. There is no need to reset job settings for each job, thus increasing printing efficiency.

**Note:** By default, the job parameters set in the job (from the client workstation) override the parameters set in the virtual printer. If you add or edit a virtual printer, you can select the **Override PPD parameters** check box to override the parameters set in the PPD file.
The three default virtual printers are:

- **Store**
  Files are spooled directly to the **Storage** area and await operator processing. You can only import PDL files (such as: PostScript, PDF, VPS) to this virtual printer, not RIPped - processed files.

- **Print**
  Files sent to this virtual printer are processed and printed directly to the printer via the IC-304 print controller.

- **Process**
  Files sent to this virtual printer are automatically processed. After processing, the files are stored in the **Storage** area of the IC-304 print controller until the print operator re-submits them for printing.

With printing workflows tailored to your job requirements, the IC-304 print controller enables you to:

- Define new virtual printers
- Choose from which virtual printer to print

For more information on creating and editing virtual printers, see *Creating Virtual Printers* on page 105.
Getting Started

Turning On the IC-304 Print Controller ..................................................8
The Workspace .......................................................................................9
The Preferences Window .......................................................................14
The Resource Center ...........................................................................15
The Job Parameters Window .................................................................16
The Help Menu .....................................................................................18
Turning Off the IC-304 Print Controller ...............................................19
Turning On the IC-304 Print Controller

1. Turn on the monitor.

2. Open the front panel of the IC-304 print controller, and then press the power control button.
   The power indicator on the front panel lights up and the Windows operating system starts.

3. By default the IC-304 print controller workspace automatically opens at start up without the need to log on. In this case, the IC-304 print controller splash screen appears followed by the workspace.

4. If user logon has been specified, the Log On dialog box appears. To log on, in the Log On dialog box, select your user type and enter your password.
   For more information about specifying user logon see Security on page 177.

Note: If the IC-304 print controller workspace does not appear automatically after the power button is pressed, from the Windows Start menu, select IC-304 > IC-304.
The Workspace

After you turn on the IC-304 print controller, the workspace automatically appears.

Table 1 describes the IC-304 print controller workspace.

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Title bar</td>
<td>Displays the name of your server and the access level with which you logged on</td>
</tr>
<tr>
<td>2</td>
<td>Menu bar</td>
<td>Consists of the <strong>File</strong>, <strong>Manage</strong>, <strong>Queues</strong>, <strong>Tools</strong>, <strong>Info</strong>, and <strong>Help</strong> menus. Click a menu name to open the corresponding menu.</td>
</tr>
<tr>
<td>3</td>
<td>Toolbar</td>
<td>Consists of shortcut buttons for the Import window, Resource Center, Calibration, Spot Color Editor, Gradation, and Alerts</td>
</tr>
</tbody>
</table>
Chapter 2 — Getting Started

4 Printer Status Displays messages about the current printer state and your printer configuration. You can also find information about the paper in each tray, the connected finishing devices, toner availability, and disk space and network details.

5 Queues Consists of the Process Queue, which lists the files to be processed. After a file has been processed successfully, it moves either to the Print Queue (the upper area) or to the Storage area.

6 Storage The Storage area contains files that:
   • were successfully printed
   • were held, were aborted, or failed during processing or printing
   • were sent directly from the client workstation to the Storage area or were imported to the Storage area

Table 1: IC-304 print controller workspace

<table>
<thead>
<tr>
<th>Item</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Printer Status</td>
<td>Displays messages about the current printer state and your printer configuration. You can also find information about the paper in each tray, the connected finishing devices, toner availability, and disk space and network details.</td>
</tr>
<tr>
<td>5</td>
<td>Queues</td>
<td>Consists of the Process Queue, which lists the files to be processed. After a file has been processed successfully, it moves either to the Print Queue (the upper area) or to the Storage area.</td>
</tr>
<tr>
<td>6</td>
<td>Storage</td>
<td>The Storage area contains files that:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• were successfully printed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• were held, were aborted, or failed during processing or printing</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• were sent directly from the client workstation to the Storage area or were imported to the Storage area</td>
</tr>
</tbody>
</table>
The Printer Status pane displays information about the current printer status—for example, Printing.

The printer icon displays the current printer configuration, according to the connected feeders and finishers.

Click **Trays**, **Finishers**, **Toners**, or **Server** to display information about the size and type of paper in each tray, the connected finishing devices, the available toner, and disk space and network details.

Under **Server**, you can also view the date that the printer was most recently calibrated. Progress bars display information about incoming and outgoing jobs.

If there is a problem with one of the printer components or with the server, a red indicator appears in the printer icon and next to the relevant component—for example, if a tray is empty.
The Alerts Window

The Alerts window lists all of the alert messages that are generated during the workflow.

To view alerts:

- On the toolbar, click **Alerts**.

  The window has two view options:
  - **All**: To view all messages
  - **Selected**: To view alerts related to a selected job. This is the default view.

The Job Info Area

The **Job Info** area displays a small image of each page in the selected processed job. The **Job Info** area also contains the
following information:

- Job’s title
- File type
- Paper size
- Print range
- Total number of pages in the job
- Total number of copies to print
- A box to enter the required page number and arrow buttons to browse through the pages of your job

**To open the Job Info area:**

- Right-click a job in the Process Queue or Print Queue, and select Job Info.
The Preferences Window

You can set all system preferences in the Preferences window.

To open the Preferences window:

➢ From the File menu, select Preferences.

The window is divided into two areas:

• **Administrator**: Users can view these settings, but configuring these settings depends on the access level defined for each user.

• **General**: All users can view these settings, but only an administrator or operator can configure the settings.

**Note**: If you log on to the IC-304 print controller as a guest, the Preferences window is unavailable.

For more information about setting system preferences, see *Setting Up and Configuring the IC-304 Print Controller* on page 168.
The Resource Center enables you to add, remove, and manage external resources for the IC-304 print controller.

To open the Resource Center:

> On the toolbar, click Resource Center.

The Resource Center provides access to the following resources:

- Virtual printers, in which you can create, edit and remove virtual printers, see Creating Virtual Printers on page 105
- Fonts, see Managing Fonts on the IC-304 Print Controller on page 124
- Profile Manager, see Managing Profiles on page 146
- Backup & Restore configuration, see Backing Up and Restoring the Configuration on page 198
- Paper Type Profiles ID, see Managing Paper Type Profiles on page 127
The Job Parameters Window

The IC-304 print controller enables you to edit imported PDL files and change the job settings—for example, paper size, imposition, and color settings—in the job parameters window.

➢ In the queues or Storage area, double-click the job whose parameters you want to view.

**Note:** In the queues, you can edit the parameters of jobs that have not begun to run. If you want to edit the parameters of a running job, you must first suspend the queue (click the suspend button).

The job parameters window appears.

**Note:** If you edit the parameters of a job in the Print Queue and the changes require re-RIPing of the job, it automatically moves to the Process Queue.
Each area in the job parameters window—for example, **Print**, **Imposition**, or **Quality**—has a set of related parameters and values that you can select.

<table>
<thead>
<tr>
<th>This button</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print</strong></td>
<td>Set print related parameters—for example, <strong>Print range</strong> and <strong>Media Type</strong>. See <em>Print</em> on page 202</td>
</tr>
<tr>
<td><strong>Imposition</strong></td>
<td>Set parameters related to print layout—for example, <strong>Trim Size</strong> and <strong>Imposition Method</strong>. See <em>Imposition</em> on page 205</td>
</tr>
<tr>
<td><strong>Quality</strong></td>
<td>Set parameters related to print quality—for example, <strong>Trapping</strong> and <strong>High Image Quality</strong>— and improve the quality of printed jobs. See <em>Quality</em> on page 212</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Apply last minute color corrections, or set the output job to match other output devices. See <em>Color</em> on page 216</td>
</tr>
<tr>
<td><strong>Finishing</strong></td>
<td>Set parameters related to finalizing your printed document—for example, define settings for the front and back cover. See <em>Finishing</em> on page 220</td>
</tr>
<tr>
<td><strong>Exceptions</strong></td>
<td>Include special exceptions in a job—for example, use a different media type for a front and back cover. See <em>Exceptions</em> on page 226</td>
</tr>
<tr>
<td><strong>Services</strong></td>
<td>Set parameters that will assist your job workflow—for example, delete jobs, change the location of the entire printed image, or enter job information. See <em>Services</em> on page 229</td>
</tr>
</tbody>
</table>
The Help Menu

The Help menu enables you to access the user guide and provides information about the current version of the IC-304 print controller installed on your computer.

To open the About window:
- From the Help menu, select About.

The About window displays the following information:
- IC-304 print controller version number
- Date the version was installed
- Any IC-304 print controller updates that were installed on top of the version

To open the user guide:
- From the Help menu, select Topics.
Turning Off the IC-304 Print Controller

1. From the **File** menu in the workspace, select **Exit**.
   If there are jobs that are being processed or printed, the following message appears:
   
   **There are currently jobs running, are you sure you want to exit the application?**
   
   If there are no jobs being processed or printed, the following message appears:
   
   **Are you sure you want to exit the application?**
   
   The IC-304 print controller workspace closes, and you return to the Windows desktop.

2. Verify that the IC-304 icon does not appear in the notification area.

3. From the Windows **Start** menu, **Shut Down**.

4. In the Shut Down Windows dialog box, select **Shut down** and click **OK**.

5. When the Windows shutdown is complete, turn off the monitor.

6. On the IC-304 print controller, click the power button behind the front door.
   
   The power LED on the front panel turns off.

   **Note:** Some situations may require the power button to be depressed for more than 4 seconds.
Working at a Client Workstation

Printing a Job from a Client Workstation ........................................ 22
Print Driver Software ...................................................................... 32
EZ Connect ...................................................................................... 51
Remote Workspace ........................................................................ 55
Creo Color Server Job Ticket Software .......................................... 57
Web Center ...................................................................................... 63
Printing a Job from a Client Workstation

To print a job from a client workstation, select one of the following methods:

- Print the job via one of the IC-304 print controller network (virtual) printers—for example, **Print**.
  
The job is spooled and then processed or printed (according to the selected job flow of the virtual printer). If you use this method, you can print from any application—for example, Microsoft Word—and use any file format from any client workstation (Windows, Macintosh, or UNIX).

  For more information about printing from a client workstation, see "Printing From Windows" on page 24 and "Printing from a Macintosh" on page 28.

- Drag the files to a hot folder.
  
The job is spooled and processed or printed (according to the selected job flow of the corresponding virtual printer).

  For more information about hot folders, see "Print Driver Software" on page 32.

  If you use the hot folder method, you can print most PDL files on the IC-304 print controller—for example, PostScript, PDF, EPS, and Variable Print Specification files.

**Note:** PDL jobs that are spooled to the IC-304 print controller must have the appropriate file name extensions—for example, *.ps or *.pdf.
Defining a Printer in Windows

The IC-304 print controller can print from a Windows client workstation that has one of the following operating systems:

- Windows NT® 4.0 Service Pack 6
- Windows 2000 Service Pack 4
- Windows XP Version 2002 Service Pack 1 and Service Pack 2
- Windows Server 2003 Standard
- Windows 2000 Server Service Pack 4
- Windows Vista®

When you add an IC-304 print controller network printer to a client workstation, the following is installed automatically:

- Print Driver software which enables you to set job parameters when printing to the IC-304 print controller from any application on your client workstation. The Print Driver also enables you to see the IC-304 print controller configuration, monitor the printer status, and save a set of print parameters for reuse. For more information about the Print Driver software, see "Print Driver Software" on page 32.

- IC-304 print controller PPD file which enables you to set job parameters when printing to the IC-304 print controller from any application on your client workstation. The PPD file is enabled when the Print Driver software is disabled. For more information about the PPD file, see "Appendix A, Setting Parameters in the PPD File".

- Adobe PostScript printer driver.

The following section describes how to define a IC-304 print controller network printer for Windows XP.

To define a printer:

1. From the Start menu, select Run.
2. In the Open box, type \ followed by the host name or IP address of the print controller, and click OK.

   The server window opens.
3. Double-click the desired network printer icon.
4. The network printer is defined on your Windows client workstation.

**Copying the Printer Driver from Windows**

Perform this procedure if your client workstation is not on the same network as the printer and you want to create PostScript files.

1. In the IC-304 print controller, locate drive D and then double-click the **Utilities** folder.
2. Click **PC utilities**, and then **Printer Driver**.
3. Find the directory of the driver relevant to your version of Windows.
4. Compress the directory, and either copy it to a disk or send it by email to the client workstation.

**Printing From Windows**

1. Open the file you would like to print in the corresponding application—for example, open a PDF file in Adobe Acrobat.
2. From the **File** menu, select **Print**.
   The Print dialog box appears.
3. In the **Name** list, select the desired IC-304 print controller network printer—for example, `<servername>_Print`. 
4. If desired, click **Properties** and modify the job parameters.

   **Note:** By default, the job parameters are displayed through the Print Driver software. For more information about modifying job parameters, see "Print Driver Software" on page 32.

   If the Print Driver software is disabled, the job parameters are displayed through the PPD file. For more information about the PPD file parameters, and disabling the Print Driver software, see "Setting Parameters in the PPD File" on page 233.

5. **Click OK.**

6. **Click OK** in the Print dialog box.

   The file is sent to the IC-304 print controller.
Defining a Printer on Macintosh

This section describes how to define an IC-304 print controller network printer for Macintosh client workstations. The IC-304 print controller can print to Macintosh client workstations running Mac OS 9 and Mac OS X (10.4).

You can also submit jobs using the IC-304 print controller virtual printers over a TCP/IP protocol. This connection enables a significantly higher spooling speed.

Before you set up an IC-304 print controller network printer to a Macintosh-based client workstation, you must first install the PPD file. This enables you to set job parameters when printing to the IC-304 print controller from any application on your client workstation. The PPD file is enabled when the Print Driver software is disabled. For more information about the parameters available in the PPD file, see "Appendix A, Setting Parameters in the PPD File".

After the network printer has been set up, you can install the Print Driver software which enables you to set job parameters when printing to the IC-304 print controller from any application on your client workstation. The Print Driver also enables you to see the IC-304 print controller configuration, monitor the printer status, and save a set of print parameters for reuse.

Copying the IC-304 Print Controller PPD File for Mac OS X (10.4)

To print from your Macintosh computer to the printer, you first need to manually copy the IC-304 print controller PPD file to the Macintosh.

1. From the Finder menu, select Go > Connect to Server.
   The Connect to Server dialog box appears.
2. In the Server Address box, type the exact name of the server: smb:// <server_name>, and click Connect.
3. In the Connect to Server dialog box, select Guest, and click Connect.
4. Select the Utilities volume, and click OK.
5. Double-click the Utilities volume icon.
6. Double-click the PPD folder.
7. Double-click the English folder.
8. Double-click the MacOSX folder and locate either the Europe-A4 or US-Letter folders. (The IC-304V2.PPD file is inside these folders.)

   It is recommended that you copy the folder by dragging it to the specified folder on your local disk. To do this, open another Finder window.

9. From the Go menu, select Computer.
10. Click the MacOSX disk icon, and locate the following folder: Library\Printers\PPDs\Contents\Resources\en.lproj.
11. Drag either the Europe-A4 or US-Letter folder to the en.lproj folder.

Setting the Network Printer for Mac OS X (10.4)

1. Make sure the IC-304v2.PPD file has been copied to the computer.
2. From the Go menu, select Applications.
3. Open the Utilities folder and then double-click Printer Setup Utility.

   The Printer List dialog box appears.
4. Click Add Printer.

   The Printer Browser dialog box appears.
5. Click Default Browser.
6. Select either Default Browser or IP Printer.
7. Browse to the print controller (if you are defining an IP printer, enter the print controller IP address or host name, and the exact name of the printer to which you want to print—for example, IC-304_ProcessPrint).
8. In the Printer Using list, select Other.
9. Browse to the folder in which you copied the PPD file: MACOSX\Library\PPDs\Contents\Resources\en.lproj\Europe-A4 or US-Letter.
10. Locate the **IC-304V2.PPD** file and double-click it.

11. Click **Add**.

You have successfully installed a network printer for the IC-304 print controller and are ready to start printing.

**Printing from a Macintosh**

1. Open the file you would like to print, in the corresponding application—for example, open a Quark file.

2. From the **File** menu, select **Print**.

   ![Print window]

3. In the **Printer** list, select the desired printer—for example, `<server_name>_Print`.

   **Note:** If you previously used the Print Driver software for this printer, you must disable the print driver software before you can print using the PPD file parameters. See "Disabling the Print Driver Software for Macintosh" on page 48.
4. In the **Copies & Pages** list, select **Printer Features**.
   A window similar to the one shown below appears. You can set job parameters.

![Printer Features Window](image)

5. Adjust the printer options as desired.

   **Notes:**
   - The **Printer's Default** option indicates that the value is taken from the virtual printer that is currently selected.

6. After modifying the job settings, click **Print**.
   The file is sent to the IC-304 print controller.

---

**Working With Hot Folders**

For every published IC-304 print controller network printer that you define on a client workstation, a corresponding hot folder is automatically created in the IC-304 print controller **D:\Hot Folders** folder.

The IC-304 print controller has three default hot folders, **HF_Print**, **HF_Process**, and **HF_Store**. These hot folders correspond to the three default printers.

Each hot folder carries the virtual printer's name.
When you connect from a client workstation to the IC-304 print controller over the network, you can use the hot folder to submit PDL jobs to the IC-304 print controller. When you establish a connection, drag your jobs onto the desired hot folder (according to the selected workflow).

**Tip:** You can also drag the hot folder icon to your desktop and create a short cut to the hot folder.

Jobs that reside in the hot folder will automatically be submitted to the IC-304 print controller through the corresponding virtual printer. Consequently, all of the virtual printer job parameters, inclusive of the workflow, will be applied to the job.

As soon as the job has been spooled to the IC-304 print controller, it disappears from the hot folder and enters the IC-304 print controller **Process Queue** or **Storage area**, according to the selected workflow.

**Note:** If you send files for printing through a hot folder while the IC-304 print controller application is down, when the application restarts, the files that reside in hot folders will immediately be imported to the system.

**Hot Folder File Formats**

Hot folders may contain all PDL formats that are supported by the IC-304 print controller, PS, PDF, EPS, PRN, VPS, PPML, TIF, JPG and GAP.

**Note:** When you use hot folders to print GAP jobs, the process is automated and the job is converted to a PDF, which is displayed in the IC-304 print controller queues. The PDF files can then be programmed and printed as any other PDF file.

Files with unsupported formats that are moved to a hot folder, will not be imported to the IC-304 print controller and will remain in the hot folder.
Using Hot Folders From Your Computer
You can use hot folders to process and print files from any computer. The following procedures explain how to print using hot folders from Windows and Macintosh OS X.

To print a job using a hot folder from Windows:
1. On your Windows desktop, double-click the Network Neighborhood icon.
2. Find your IC-304 print controller.
3. Double-click the IC-304 print controller.
4. Double-click the desired hot folder—for example, HF_Process.
   
   Tip: You can also drag the hot folder icon to your desktop to create and use a shortcut to the folder in the future.

You can now drag the desired files to the hot folder. All the files are processed and printed automatically to the printer, according to the hot folder workflow.

To print a job using a hot folder from a Mac OS X:
1. From the Finder menu bar, select Go>Connect to Server. The Connect to Server window appears.
2. Locate your IC-304 print controller on the network, and click Connect.
3. Select Guest, and then click Connect.
4. From the list, select the desired hot folder—for example, HF_Process—and then click OK.

The hot folder icon appears on your desktop. You can now drag the desired files to the hot folder icon. All the files are processed and printed automatically to the printer, according to the hot folder workflow.
Print Driver Software

IC-304 print controller Print Driver software enables you to set job parameters when printing to the IC-304 print controller from any application on your Windows-based and Macintosh-based client workstation. The Print Driver also enables you to see the IC-304 print controller configuration, monitor the printer status, and save a set of print parameters for reuse.

The Print Driver software is automatically installed in the Windows-based client workstation when you set up a network printer. When working with a Macintosh client workstation, you must install the Print Driver software manually, as described in the next section.

Installing the Print Driver Software on Macintosh

You can find the Print Driver software installation file from one of the following locations:

- Web center
- D:\Utilities\Mac Utilities folder
To install the Print Driver software:

1. In the Mac Utilities folder, double-click the IC-304V2_ColorServerPrintDriverInstaller.dmg file.

2. Double-click the IC-304V2_ColorServerPrintDriverInstaller. The Print Driver installation wizard appears.
3. Click **Continue**.

4. In the Licensing window, click **Continue**.

5. In the Easy Install window, click **Upgrade**.

6. Type your name and password, and click **OK**.
The Print Driver software is installed.

7. Click **Close**.

**To define a printer with the Print Driver software:**

1. In the System Preferences window, double-click **Print & Fax**.
2. In the Print & Fax window, click **Add** to add a printer.
3. In the Printer Browser window, click More Printers.
4. Select the desired network printer.
5. In the Printer Model list, select Other.
6. Browse to the folder in which you copied the PPD file, MACOSX\Library\PPDs\Contents\Resources\en.lproj\Europe-A4 or US-Letter, and select the IC-304V2.ppd file.
7. Click **Add**.

The Printer Driver software is installed for the network printer.
To enable the Print Driver software:

1. In the Print & Fax window, double-click the network printer.

2. Click Utility.

3. In the Enable Enhanced User Interface list, select On.

4. Click Apply.

Accessing the Print Driver Software

1. Open the file that you want to print, for example, a PDF file.
2. From the File menu, select Print.
3. In the Print dialog box do one of the following.

   - For Windows, click **Properties**.
   - For Macintosh:
     - Select the desired printer, and then select **Special features**.

   - Click **Job Parameters**

   If this is the first time that you are using the Print Driver software, a message tells you that the software is loading. Then a dialog box with the print settings appears.

   **Note:** The loading process might take a few minutes. Afterwards, accessing the Print Driver software takes less time.
Chapter 3—Working at a Client Workstation

Setting Job Parameters

In the Print Driver window, click the tab on which you want to set job parameters.
The job parameters are described in full on page 202.

Using Profiles

Once you have set the parameters for a job, you can save the settings as a profile for future use. Profiles are useful when you want to print different jobs with the same settings, or if you want to reprint a job.
To create a profile:

1. Set the desired job parameters, and click **Save Settings**.

2. Locate the folder in which you want to save the settings.

3. In the **File name** box, type the desired file name.

4. Click **Save**.

To retrieve a profile:

1. In the Print Driver window, click **Load Settings**.

2. Locate the profile, and click **Open**.

The saved settings are applied to the job.

**Note:** You can modify any of the settings as desired.
Controlled Printing

The controlled printing feature controls and protects printing of sensitive data. You can password-protect a job on the client workstation in the Print Driver window and submit it to print. When the job has finished printing, it is automatically deleted. If the job fails during processing or printing—for example, due to a paper jam, or the job was aborted, the job is moved to the Storage area and requires a password to reprint it.

You cannot perform the following actions on a controlled job that resides in the Storage area.

- Archive
- Export as PDF2GO
- Duplicate
- Preview
- View a thumbnail image

To lock the job:

1. In the Print Driver window, click Controlled Printing.
2. In the Password box, type a password consisting of four digits, and click OK.
3. Submit the job to one of the published printers:
   • Print—the job is processed and waits for the correct password in the Print queue
   • Process—the job is processed and stored in the Storage area
   • Store—the job is not processed and waits in the Storage area

The job appears in the Print queue/Storage area with the locked indicator. The job must be unlocked before you can change job parameters or send the job to print. For information about how to unlock the job, see page 88.

Viewing the Printer Status

1. In the Print Driver window, click **Printer Status**.
2. Click the **Trays** tab to view information on the paper stock in the trays.
3. Click the **Finishers** tab to view information on the finishing options.

4. Click the **Toner** tab to view information on the toners.
Note: The resource information is not refreshed dynamically. Click **Update** to refresh the resource information, and the gradation tables.
PostScript Settings

1. In the Print Driver window, click **PostScript**.

2. Adjust the settings as desired.

3. Click **OK** to save the settings.

Working Offline

When the printer is offline, you can select and save settings in the Print Driver software for the selected virtual printer. However, you cannot update the display of information about the printer resources—for example, paper or toner.

Offline mode applies to the following scenarios:

- Your workstation is not connected to the IC-304 print controller.
- The printer and the IC-304 print controller are not communicating.
- You are working in a non-TCP/IP environment—such as a Novell environment.
- The selected printer is not published on the IC-304 print controller.
Disabling the Print Driver Software

Disabling the Print Driver Software in Windows
The Print Driver software is enabled by default. Disable the Print Driver software if you want to access the PPD file parameters.

To disable the print driver software:
1. From the Windows Start menu, select Settings > Printers and Faxes.
2. Right-click the printer icon, and select Properties.
3. Click the Print Driver tab.
4. In the Enable enhanced user interface list, select off.
5. Click Apply.
6. Click OK to close the dialog box.
Disabling the Print Driver Software for Macintosh

1. In the Print & Fax window, double-click the network printer.

2. Click **Utility**.

3. In the **Enable Enhanced User Interface** list, select **Off**.

4. Click **Apply**.
Uninstalling the Print Driver Software

Uninstalling the Print Driver Software in Windows

1. From the Windows Start menu, select Settings > Printers and Faxes.

2. Right-click the IC-304 print controller network printer, and select Delete.
   The printer is deleted from your client workstation.

3. In the Printers and Faxes window, from the File menu, select Server Properties.

4. In the Print Server Properties dialog box, click the Drivers tab, select the printer—for example AdobePS IC-304V2—and click Remove.
   The driver is removed.

5. From the Windows Start menu, select Run.

6. Locate the server.

7. Navigate to D:\Utilities\PC Utilities\Driver Extension.

   The Print Driver software is uninstalled.
Uninstalling the Print Driver Software for Macintosh

1. Browse to the Library\Printers\Creo_Color_Server_Tools folder.

2. Delete the Creo_Color_Server_Tools folder.

3. Browse to the Library\Receipts folder and delete all of the IC-304V2*.pkg files.

4. Open the System Preferences window and select Print & Fax.
5. In the Print & Fax dialog box, select the network printer.
6. Click to delete the network printer.
The Print Driver software is uninstalled.

EZ Connect

EZ Connect enables you to view information about any IC-304 print controller on your network from your Windows-based client workstation. You can:

- View the press status
- Refresh the press status
- Search for jobs
- Access the Remote Workspace, or Web Center
Installing EZ Connect On Your Client Workstation

1. In the D://Utilities/PC Utilities folder on the print controller, locate the EZConnect_v1_0_Setup.exe file, and copy it to your client workstation.

2. On your client workstation, double-click the EZConnect_v1_0_Setup.exe file.
   The EZConnect software installation begins.

Launching EZ Connect

1. From the Windows Start menu, select Programs > EZConnect > EZConnect Runner.
   The EZ Connect icon appears in the Notification area.

2. Double-click the EZ Connect icon.
Adding a Server to the EZ Connect Window

1. In the EZ Connect window, click the **Settings** button, and select **Setup** from the list.

2. Click **New**.

3. In the **Hostname/IP** box, type the server's name or IP address.

4. In the **Display Name** box, type the server name that you want to appear in the EZ Connect window—this is for display purposes only.

5. In the **Type** list, select **IC-304**.

6. Click **Connect**.

   The server is displayed in the EZ Connect window.
7. (Optional) To change the position of the server in the list, click the Move Up or Move Down buttons to change the position of the server in the list.

8. From the Default Launch Application list, select the application (Remote Workspace or Web Viewer) that you will use to access the server.

9. From the Language list, select the required language.

10. Select the Error Status Notification Sign check box to display a sign for errors.

11. Click Save.

   The server appears in the EZ Connect window.

Changing the Server Display Name

1. In the EZ Connect window, click the Settings button, and select Setup from the list.

2. In the list of servers, select the required server.

3. Click Edit.

4. In the Display Name box, type the new display name for the server.

5. Click Save.

   The new name appears in the EZ Connect Setup window.

Deleting a Server

1. In the EZ Connect window, click the Settings button, and select Setup from the list.

2. In the list of servers, select the required server.

3. Click Delete.

   The server is removed from the list.
Refreshing the Status of the EZ Connect Window

- In the EZ Connect window, click the Refresh button.

Searching For a Job on a Server

1. In the EZ Connect window, click the Search button.
2. From the server list, select one of the following to search for the job:
   - All Servers
   - A specific server
3. In the blank white box, type the exact name of the job and then click Search.
   The job appears in the Search Job window.
4. Select the job to display information about the job.

Remote Workspace

With the Remote Workspace application, multiple client workstation can access a IC-304 print controller at the same time.

In the Remote Workspace window, you can:
- Import jobs
- View and manage job queues
- View printer information
- Set job parameters

Note: To use the Remote Workspace application, you must first install the EZ Connect tool.
Launching the Remote Workspace

1. Run the EZConnect software from the Windows Start menu by selecting Programs > EZConnect > EZConnect Runner.
2. Double-click the EZ Connect icon in the Notification area.
3. Click the required server.
4. If this is the first time you are accessing the Remote Workspace application, the Downloading RWS dialog box appears.
5. Click OK to confirm the message.
6. Click Logon.

The Remote Workspace window appears.
Creo Color Server Job Ticket Software

The Creo Color Server Job Ticket software enables you to create a job definition format (JDF) file. This JDF® file contains a set of printing parameters (job ticket) and may also include the path to a file to be printed using those parameters.

**Note:** If you assign a file to a job ticket, make sure that the file location is accessible to the Creo color server.

Because you work on a remote computer, you don’t need to be connected to a Creo color server to create a job ticket. You can assign a job ticket to any type of file. With the Creo Color Server Job Ticket software you can:

- Create a job ticket
- Open a job ticket
- Load job parameters from a selected server
- Send a job to print using a job ticket that you created

Installing the Job Ticket Software

**To install on a Windows-based Client Workstation:**

- From your client workstation, navigate to the D:/Utilities/PC Utilities folder on the IC-304 print controller, and double-click the CreoColorServerJobTicket.exe file.

After the installation process is complete, the Creo Color Server Job Ticket software appears. A shortcut to the Creo Color Server Job Ticket software appears under **Start > Programs > Creo Color Server > Creo Color Server JT.**
Creating a Job Ticket

To create a job ticket via the Windows-based Client Workstation:

1. From the Start menu, select Programs > Creo Color Server > Creo Color Server JT > Creo Color Server Job Ticket V1.0.

2. Set the required job parameters settings.

3. Click Save.

4. In the Save Template box, type a template name for the job ticket and click Save.
The job ticket JDF file is saved in the path specified in the Preferences window. The default path is C:\Documents and Settings\All Users\Color_Server_Client_Tools\Creo_Color_Server_JT\V1_0\Creo_Color_Server_JT\Creo_Color_Server_JT_IC304_1\servers\FactoryDevice.

Loading a Job Ticket

When the Creo Color Server Job Ticket has been created, it appears under File > Load.

- From the File menu, select Load, and then the job ticket name. The job ticket appears.
Submitting a Loaded Job Ticket for Printing

You can submit a job ticket that has been loaded.

1. Select **Submit**.
   
The Submit window appears with the job ticket name.

2. Click **Browse** next to the **Include File** check box to locate the file you want to print using the job ticket.

3. Navigate to the job ticket according to the path specified in the Preferences window and click **Open**.

4. Click **Submit** to submit the job to print.
Managing Servers

**To add a server:**

1. From the Tools menu, select Use Online JT From, and then Other Devices.

2. Click Add.

3. In the Device Name box, type a name for the server that you want to use.

4. In the IP/Host Name box, type the IP address or host name of the server that you want to use.

5. Click Add.

6. Click OK to close the Device Configuration dialog box.

**To remove a server:**

1. From the Tools menu, select Use Online JT From, and then Other Devices.

   The Device Configuration dialog box appears.

2. Select the server you want to remove.
3. Click **Remove**.
4. In the Confirmation message window, click **Yes**.

**To rename a server:**
1. From the **Tools** menu, select **Use Online JT From**, and then **Other Devices**.
   - The Device Configuration dialog box appears.
2. In the list of servers, double-click the server you want to rename.
3. Type a new, unique name for the server.

### Updating the Creo Color Server Job Ticket Software

Use the Check for Updates feature to check if a new version of the job ticket software is available, or if the job parameters settings of the selected server have changed—for example, paper stock, gradation tables, imposition templates, and destination profiles.

**To check for updates:**
- From the **Help** menu, click **Check for Updates**.
  - If there are updates, available, the updating process begins. If there are no new updates, a message is displayed.

### Changing the Location of Saved Job Tickets

1. From the **Tools** menu, select **Preferences**.

![Preferences dialog box]

2. In the **Save JDF Location** box, click **Browse** and navigate to the desired location.
3. Click **Select**, and then click **OK**.
Web Center

The Web Center is a Web page that provides online information and can be accessed from client workstations. You can connect to the Web Center with the Internet Explorer 5.0 (or later) and Safari browsers.

The Web center enables you to:

• View the status of jobs in the queues, the Alerts window in its current state, and the printer system information
• Download remote client tools, utility applications, color profiles, and print drivers
• Link to related vendors and products

To connect to the Web Center from a client workstation:

**Important:** To connect to the Web Center from a client workstation, you must first enable the web connect service on the IC-304 print controller, see "Remote Tools Setup" on page 176.

1. On your desktop, click the browser icon.
2. When the browser starts, in the address field type: http://<IC-304 name>—for example, if the IC-304 station name is print-controller, type http://<IC-304 name>.

**Note:** You can also use the IC-304 print controller IP address—for example, http://192.168.92.10.
The IC-304 print controller Web Center appears.

The Web Viewer page consists of three tabs that enable you to view the jobs that currently reside in the IC-304 print controller queues and Storage area, and also view messages that currently appear in the Alerts window. This information is important when you print from a client workstation because it enables you to monitor your jobs in the queues and then make any necessary changes.

Click the [logo] to return to the Web Center home page.

Table 3: Description of Web Viewer tabs

<table>
<thead>
<tr>
<th>This tab</th>
<th>Enables you to view</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Queues</td>
<td>Jobs that are currently running in the IC-304 print controller Print Queue and Process Queue</td>
</tr>
</tbody>
</table>
The Downloads page enables you to download the most updated IC-304 print controller utilities for Windows and Macintosh client workstations. You can download the following items:

- PPD file
- Color profiles
- Utilities—from the Utilities folder

<table>
<thead>
<tr>
<th>Storage</th>
<th>IC-304 print controller Storage area and the jobs that reside in this window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>IC-304 print controller alerts. For example, if a job that you sent to print from your client workstation has failed—you can view the message in the Alerts window, edit the job parameters, and then resend it for processing and printing on the IC-304 print controller.</td>
</tr>
</tbody>
</table>

Downloads

The Downloads page enables you to download the most updated IC-304 print controller utilities for Windows and Macintosh client workstations. You can download the following items:

- PPD file
- Color profiles
- Utilities—from the Utilities folder

Links

The Links page enables you to connect to the following resources:

- Creo’s VI partners and authoring tool vendors
- Creo Workflow Partnership Program
Basic Workflows

Basic Job Workflow.................................................................68
Importing and Printing Jobs....................................................70
Remote Scanning Application.................................................72
Basic Job Workflow

The basic workflow in the IC-304 print controller consists of three main stages:

1. Submitting a file from a client workstation, or importing and printing from the IC-304 print controller, see Submitting on page 68
2. After a job is imported, the print engine starts to process the job, see Processing on page 68
3. The job is printed and stored in the Storage area for future use, see Storage on page 69

Submitting

There are two methods for submitting a file for printing:

- Submit a file from an application on your client workstation—for example, PDL formats that were created on client workstations that are not connected to the IC-304 print controller, or files that are available only on external media.
- You can also import job files that reside locally on the IC-304 print controller.

Processing

After a job enters the IC-304 print controller, it resides in the queues or the Storage area, depending on the job flow. The queues consists of two areas:

- The Process Queue lists the job currently being processed and all the jobs that are waiting to be processed.
- The Print Queue lists the job that is currently printing and all the jobs that were processed successfully and are waiting to be printed. The Print Queue also lists held jobs—for example, jobs for which the specified paper stock is not available.

Each queue holds jobs in the order in which they enter the queue.
The top job in the queue is the currently running job, while all the others are waiting to run. The Print Queue and Process Queue areas show you the number of jobs and their status. You can change the order of jobs, view and edit the parameters. The suspend and resume buttons in each queue indicates whether the queue is suspended (red) or not (green).

For more information about how to manage the queues, see Managing the Job Queues on page 80.
The **Storage** area is the main repository for jobs. It can contain:

- Completed jobs
- Jobs that were manually moved to the **Storage** area
- Jobs that were aborted during processing or printing
- Jobs that failed to complete processing or printing
- Jobs that were imported or spooled directly from a client workstation.

For more information about the Storage area, see *Managing the Storage Area* on page 89.

**Importing and Printing Jobs**

You import jobs for printing in the following situations:

- When a PDL file is located on an external medium, such as a CD-ROM
- When the desired file resides locally on the IC-304 print controller
Importing Files

1. From the **File** menu select **Import**.

2. To access the desired files, click the **up one level** button, or double-click on the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired file and click **Add**.

   The file appears in the lower list.

4. Select a printer from the **Virtual Printer** list.

   **Note:** To remove a file, select the desired file in the lower list in the Import Job window and click **Remove**.

5. Click **Import**.

   All files currently listed on the lower list are sent to the IC-304 print controller to be processed and printed as defined in the selected virtual printer.
Resubmitting

You can easily reprint processed jobs that are stored in the Storage area. Select the job you want to reprint and then submit it. The job is automatically placed in the Print Queue.

The IC-304 print controller enables you to change job parameters and edit jobs prior to reprinting.

You can change job parameters in the job parameters window. Certain changes to the job parameters require you to re-RIP the job. The IC-304 print controller automatically determines whether your file requires re-RIPing and places it in the appropriate queue when you submit it for reprinting.

Remote Scanning Application

Before you begin using the Remote Scanning Application, you need to install the application on your client workstation. You can find the setup file in the Utilities folder on the installation CD.

The Remote Scanning Application enables you to:

- Set up scan boxes either from the printer or your client workstation, and then set parameters that specify the location of your scanned data, the format in which it is saved, and security settings
- Manage scanned images
A typical scanning workflow with the Remote Scanning Application is as follows:

![Workflow Diagram]

Setting Up Scan Boxes

You can set up scan boxes in the following ways:

- On the printer. You can then modify the scan box settings later on the IC-304 print controller.
- With the Remote Scanning Application. This provides a central location for the system administrator to manage the scan boxes, and set security and email settings, see page 74.

Setting up a Scan Box on the Printer

1. On the printer's touch screen, press the SCAN key.
2. On the printer's touch screen, touch the HDD tab.
3. Touch the Address Input button, and then touch the box name.
4. Enter the box name, and then touch the OK button.
   
   **Note:** When the [Register Name] and the [Search Character] is set, pressing [Register] allows the destination to be registered.

5. Touch the OK button.
6. Touch Scan Settings.
7. Enter the required settings for the scan.

8. Place the image that you want to scan on the printer, and then press the START key.

Note: After completing the operation, press the Reset key on the Control Panel in the Scanner Setting screen and the Select Destinations screen to release the settings. (Touch the Address button to get back to the Select Destinations screen.)

9. To access your scanned data, open the Remote Scanning Application, see Managing Scanned Images on page 77.

Setting up a Scan Box with the Remote Scan Application

1. From the Start menu, select Programs>IC-304>Remote Scan Application>Remote Scan.

2. From the Server Name or IP list, type, or choose, the server hostname or IP address to which you want to connect, and click Connect.

3. In the Remote Scanning Application dialog box, click the Scan Box Manager button.

4. Click the Add button to add a new scan box.
5. In the **Scan Box Name** box, type a name for the scan box.
6. Select the **Automatic Copy** check box to specify that your data is automatically copied to the desired location.
7. In the **Network Path** box, click **Browse**, and navigate to the location to which you want to save the scan box. The scan box is saved on the IC-304 print controller.
8. In the **File Type** box, enter the format in which you want to save the data that is saved to the scan box. The available options are JPEG, TIFF and PDF.
9. Select **Security**.
10. Select the **Secure Scan Box** check box to secure the scan box, and specify a password.

11. Select **Send to Email**.

12. Select the **Send to Email** check box to transmit e-mail automatically to the specified address(es).

13. In the **From** list, type the email address of the sender.

14. In the **To** list, type the address to which the e-mail will be sent. You can add multiple addresses by separating each address with a semi colon.

15. In the **Subject** box, type the subject of the e-mail.

16. In the **Text** box, type the text you want to appear in the body of the e-mail.

17. Select one of the following options:
   - **Send scan as link** to send an e-mail that contains a link to the scan
   - **Send scan as attachment** to send the scanned data as an attachment to the e-mail.

18. Click **Save** to save your changes.
Managing Scanned Images

The Remote Scanning Application provides the following default scan boxes:

- **Public**—the settings for the Public folder can be managed by all users or by an administrator only. These settings are specified in the Preferences window. For more information, see Scan Management on page 181.

- **Scan to Print**—from which data is sent to the Process Queue to be processed and printed.

- **Calibration**—which contains the data saved during calibration.

To manage scanned images:

1. From the Start menu, select Programs>IC-304>Remote Scan Application>Remote Scan.

2. From the Server Name or IP list, type, or choose, the server hostname or IP address to which you want to connect, and click Connect.
3. From the **ScanBox** list select the scan box you want to access.

   ![Remote Scan Application](image)

   All jobs scanned to the selected scan box are displayed.

4. Select the desired job, and click **Save**.
   
   The Save dialog box opens.

5. Select a destination, and click **Save**.
   
   You can now open, and work with your scanned data.
Managing Jobs

Managing the Job Queues ..............................................................80
Managing the Storage Area.............................................................89
Previewing a Job .............................................................................93
Job Accounting .............................................................................100
Creating Virtual Printers.................................................................105
Job Report.....................................................................................107
Managing the Job Queues

After entering the IC-304 print controller, a job resides either in the queues or in the Storage area, depending on the job flow.

There are two queues, Process and Print.

- The Process Queue lists the job that is currently being processed and the jobs that are waiting to be processed.

- The Print Queue lists the currently printing job and the jobs that were processed successfully and are waiting to be printed. The Print Queue also lists held jobs—for example, jobs for which the specified paper stock is not available.

At any time, you can view information regarding the number and status of the jobs in the queues. You can also change the order of the jobs and suspend or resume the queue.

After you start the IC-304 print controller, the queues are displayed.

Each queue holds jobs in the order in which they enter it. The top job in the queue is currently running, while all others are waiting to run.

Note: If there are very short jobs in the Print Queue, several jobs may be printing at the same time. The jobs marked as printing are listed first and printed in the order they are listed.

If necessary, you can change the order of the jobs that are waiting in the queues. You can also view and edit the jobs’ parameters.
Managing the Job Queues

The Queues

After you submit PDL jobs (or resubmit PDL jobs), the Process Queue lists the files to be processed.

Once a file has been processed successfully, it moves to the Print Queue and waits to be printed or to the Storage area (depending on the current job flow or virtual printer).

For more information about operations on the jobs residing in the queues, see "Aborting a Running Job" on page 85.

The queues list information about the jobs that are being processed. Status indicators indicate the status of each job. Table 4 describes the status indicators used in both the Process Queue and Print Queue.

Table 4: Process Queue and Print Queue status indicators

<table>
<thead>
<tr>
<th>Status Indicator</th>
<th>Indicates This</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The job is printing or processing.</td>
</tr>
<tr>
<td></td>
<td>The job is on hold in the Print Queue. If a job is on hold, it indicates that the selected paper stock is not available</td>
</tr>
</tbody>
</table>
You can add, remove, and reorder the columns in the Process Queue and in the Print Queue.

To add columns:

- Right-click the column heading row, select Add and then select the column that you want to add.

  The column is added to the right of the selected column.

To remove columns:

Similarly, you can remove columns in the Process Queue and in the Print Queue. Right-click the column heading row, select Delete, and then select the column you want to remove.

To reorder column headings:

In addition, you can change the order of the column headings. Right-click the column heading row, select Move and then select Left or Right.

<table>
<thead>
<tr>
<th>This Column</th>
<th>Indicates This Information:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong></td>
<td>Current status of the job</td>
</tr>
<tr>
<td><strong>Job Title</strong></td>
<td>Original name of the job and file extension—for example, Lizard.pdf</td>
</tr>
<tr>
<td><strong>Owner</strong></td>
<td>User name of the system from which this file originated</td>
</tr>
</tbody>
</table>
Table 5: Process Queue and Print Queue column descriptions

<table>
<thead>
<tr>
<th>This Column</th>
<th>Indicates This Information:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Size</td>
<td>Page size of the finished, trimmed document</td>
</tr>
<tr>
<td>Submission time</td>
<td>Date and time this job was first submitted to the IC-304 print controller</td>
</tr>
<tr>
<td>Pages</td>
<td>Number of pages to be processed in a PDF job. If the DTP application supported it, the number of pages is indicated for other PDL jobs.</td>
</tr>
<tr>
<td>Copies</td>
<td>Number of copies that were requested to be printed</td>
</tr>
<tr>
<td>Time Passed</td>
<td>Amount of time that has passed since job processing started</td>
</tr>
<tr>
<td>File Type</td>
<td>File format of the PDL job—for example, PS (.ps), PDF(.pdf), VPS(.vps)</td>
</tr>
<tr>
<td>Media Type</td>
<td>Media type defined in the job parameters window</td>
</tr>
<tr>
<td>Account</td>
<td>Account name defined in the job parameters window</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color mode defined in the job parameters window: grayscale or color</td>
</tr>
<tr>
<td>Comments</td>
<td>Comments entered in the job parameters window</td>
</tr>
</tbody>
</table>
Status Information

The printing and processing status areas contain the following information:

- The suspend and resume buttons
- The queue name.
- The number of jobs in the queue—for example, 2.

Suspending and Resuming Queues

If necessary, you can stop a queue temporarily and then later continue its operation afterwards. To do this, use the suspend and resume buttons:

To suspend a queue:

- Click the suspend button.
  
  The processing or printing stops after the current job has finished running.

To resume a queue:

- Click the resume button.
  
  The top job in the queue starts processing or printing.
Changing the Order of Jobs in the Queues

You can rearrange the jobs in a queue to change the order in which they will be processed or printed. This feature is useful when you have an urgent job that takes priority, for example.

To move a job up in the queue:

- Right-click the job, and select one of the following options:
  - Promote: to move the job up one step
  - Promote to top: to move the job to the top of the queue

Note: The job is placed below the Printing or Processing job.

To move a job down in the queue:

- Right-click the job, and select one of the following options:
  - Demote: to move the job down one step
  - Demote to bottom: to move the job to the bottom of the queue.

Aborting a Running Job

To stop processing or printing a running job:

- Right-click the running job in one of the queues, and select Abort.

The job moves from the queue to the Storage area.

The Aborted status is assigned to the job, and the next job in the queue starts running.
To return a job to the Process Queue or Print Queue:

- In the Storage area, right-click the job and select Submit.

### Batching Jobs

The job-batching workflow combines jobs with similar attributes into a single batch to enable the printer to print the jobs continuously without pausing. This feature saves printing time, especially for a large number of small jobs. Jobs that use paper of the same size and weight are suitable for batching.

When a job enters the Print Queue, the IC-304 print controller checks whether the job is suitable for batching with the previous one:

- A job that can be batched appears with the printing status indicator. The printer prints both jobs without pausing between them. All jobs that are batched are grouped together and highlighted.

- A job that cannot be batched with the previous one waits in the queue and appears with the waiting status indicator. It is printed only when the printer finishes the previous job and comes to a stop.

The IC-304 print controller batches suitable jobs only if they are consecutive in the queue. Two jobs are not batched if a job that is not suitable comes between them in the queue.

The job batching option is active by default.

To deactivate job batching:

- In the Preferences window, select Print Queue Manager.
For more information about job batching, see "Print Queue Manager" on page 188.

Moving a Waiting Job to the Storage Area

To postpone processing or printing of one or more waiting jobs, use the **Move to storage** option.

**To move a waiting job to storage:**

**Note:** You can only perform this action if the job is waiting in the queue. If the job is active, this option is not available.

1. Select the job in the **Print Queue** or **Process Queue**.

2. Right-click the job(s), and select **Move to storage**.

   The job(s) move(s) from the queue to the **Storage** area and appears with a **Waiting** status.

**To return a held job from the Storage area to its original queue:**

- Right-click the job, and select **Submit**.

  The job moves from the **Storage** area to the appropriate queue.
Deleting a Job

Once you delete a job from the Process Queue, Print Queue, or Storage area, you need to resubmit it for processing and printing. To temporarily remove a job from a queue, use the Move to storage option (see "Moving a Waiting Job to the Storage Area" on page 87).

To delete a job:

**Note:** You can only perform this action if the job is waiting in the queue. If the job is active, this option is not available.

1. Right-click the desired job in the queue or Storage area, and select Delete.

   ![Delete Jobs dialog box](image)

   Are you sure you want to delete this job?

   Yes  No

2. Click Yes.

   The selected job(s) is deleted.

   **Note:** You can delete more than one job at a time: Select the jobs, and from the Job menu, select Delete.

Unlocking a Job

Locked jobs are jobs that have been password-protected in the Print Driver software before being submitted to print. A locked job must be unlocked before you can change job parameters or send the job to print.

A locked job is identified by the Locked indicator.

For more information about locking a job, see "Controlled Printing" on page 42.
To unlock a job:

1. Depending on which queue the job is in, do one of the following:
   - In the Print and Process queues, right-click the job that you want to unlock and select either **Job Parameters** or **Run immediately**.
   - In the Storage queue, right-click the job that you want to unlock and select **Job Parameters**.

2. In the **Password** box, type the password and click **OK**.
   The job is unlocked.

Managing the Storage Area

In the **Storage** area, you can see the number of jobs that are in storage, their status, and select one of the three views in the **View** list:

- **List**: Displays a list of all jobs in the **Storage** area
- **Preview**: Displays a list of all jobs and a thumbnail view of the selected job
- **Gallery**: Displays a thumbnail of the first page of each job in the **Storage** area
The Storage area contains jobs of various types:

- Printed jobs
- Jobs that you moved to the Storage area or aborted during processing or printing
- Jobs that failed during processing or printing
- Retrieved jobs
- Jobs that were imported directly to the Storage area from the client workstation (by selecting the Store option for the job flow)

Each job in the Storage area is assigned a status as shown in Table 6.

Table 6: Storage area status descriptions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
<th>Indicates This</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>Completed</td>
<td>The job has finished printing.</td>
</tr>
<tr>
<td></td>
<td>Waiting</td>
<td>You moved the job from the queues to the Storage area; or the current job flow or virtual printer moved the job to the Storage area automatically.</td>
</tr>
<tr>
<td>🚨</td>
<td>Failed</td>
<td>The job failed during processing or printing.</td>
</tr>
<tr>
<td>⚡</td>
<td>Aborted</td>
<td>You aborted the job in the queues while the job was running.</td>
</tr>
<tr>
<td>🛋</td>
<td>Locked</td>
<td>The job was locked in the Print Driver software.</td>
</tr>
</tbody>
</table>

Submitting Jobs

To submit a job in the Storage area:

- In the Storage area, right-click the job, and select Submit.

  Processed jobs are submitted to the Print Queue; all other jobs are submitted to the Process Queue.
Duplicating Jobs
Duplicating a processed job creates a PDL version of the job

**To duplicate a job:**
- In the Storage area, right-click the job and select Duplicate.
  
  The selected file is duplicated and is given the name of the original job followed by the suffix _dup.

Archiving and Retrieving Jobs
To keep enough disk space free, it is recommended that you back up jobs and their related files to an external server and then delete them from the Storage area.

This backup process is called archiving. You can retrieve archived jobs and related files later for further use.

**To archive a job on an external server:**
Before you begin this procedure, make sure that you create a folder in which to store the archived jobs.

1. In the Storage area, right-click the job you want to archive and select Archive.
2. Locate the desired folder, and then click Archive. A cabinet file (a compressed file) that contains all the files related to the archived job is created at the selected location.

**Notes:**
- The archived job retains its current status (that is, completed, failed, held, or aborted) and is archived with the information in its job parameters and Job History windows.
- When retrieved, the archived job retains the original job name, not the name assigned when archived.
- You can archive two or more files simultaneously.

3. Delete the job from the Storage area.

**To retrieve an archived job:**

1. From the File menu, select Retrieve. The Retrieve dialog box appears.
2. Find the archived job under its archive name, and select the related cabinet file.
3. Click Add. The selected job appears in the lower list in the Retrieve dialog box.

4. Click Retrieve. The selected job appears at the top of the list in the Storage area. It is assigned the status that is had before archival.

Notes:
- You can retrieve more than one job at a time.
- The files related to the job (for example, PDL) are also retrieved.
- The job is retrieved with the information in its job parameters and Job History windows.
- The cabinet file is not deleted.

5. In the Message Viewer window, verify that the file has been successfully retrieved.

Viewing the Job History Window
- In the Storage area, right-click the job and select Job History.
  The Job History window appears.

For more information about the Job History window, see "Job History" on page 194.

Previewing a Job

The Job Preview & Editor window enables you to preview and edit an RTP job before it is sent to print. You can see all of the job details and verify the job quality and content. While you navigate to the various pages of a job, you can view thumbnails of the job. For an imposed job, you can view the imposed sheets, including the layout of the pages on each sheet.
To open the Job Preview & Editor window:

- In the Storage area, right-click an RTP job that you want to preview, and select Job Preview.

The Job Preview & Editor window appears, displaying the first page of the selected job.

Navigation Buttons

The navigation buttons enable you to view the pages of the current job.

**Note:** When the first page of a booklet is in view, the Previous Page navigation button takes you to the previous booklet. When the last page of a booklet is in view, the Next Page button takes you to the next booklet.

Using the Preview Tools

The preview buttons enable you to switch the display mode of the page.

Table 7: Description of preview buttons

<table>
<thead>
<tr>
<th>This button</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pan</td>
<td>View a different area of the image</td>
</tr>
<tr>
<td>Eye Dropper</td>
<td>Find out the CMYK values of a specific area on the page. To find the values, first click the Eye Dropper button. Then move the pointer to the point on the page where you want to measure the color values and click. The CMYK dot percentage values and Spot color CMYK equivalent values appear as a tool tip.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Magnify the selected area of the page. To return to the previous view, click the Zoom Out button.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Reduce the size of the selected area of the page by 50%. To return to the previous view, click the Zoom In button.</td>
</tr>
</tbody>
</table>
Table 7: Description of preview buttons

<table>
<thead>
<tr>
<th>This button</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:1</td>
<td>View the page at 100% magnification, where one screen pixel shows one image pixel.</td>
</tr>
<tr>
<td>One to One Zoom</td>
<td></td>
</tr>
<tr>
<td>Fit to Screen</td>
<td>Scale the page to fit the available screen space.</td>
</tr>
<tr>
<td></td>
<td>View the image at different preset levels of magnification by selecting a percentage in the list.</td>
</tr>
<tr>
<td>Rotate View</td>
<td>Rotate the page 90°, 180°, and 270°.</td>
</tr>
<tr>
<td>Show/Hide Separation</td>
<td>Turn on or off one or more separations</td>
</tr>
</tbody>
</table>

Viewing Pages in the Job Preview & Editor Window

The Job Preview & Editor window has three tabs—Booklet, Thumbnails, and Imposed Sheets—which enable you to switch between views.

The Booklet Tab

The Booklet tab displays the booklets included in the selected job and the names and numbers of the pages in each booklet. The Booklet tab opens by default. To examine a specific page, double-click the page you want to view on the left pane of the Booklet tab. The page is displayed on the right pane.
The Thumbnails Tab

The Thumbnails tab displays miniature views (“thumbnails”) of each page in the selected booklet. These thumbnails enable you to find a specific page more easily. To examine a specific page, double-click the page you want to view on the left pane of the Thumbnails tab. The page is displayed on the right pane.

The Thumbnails tab also enables you to delete pages from the job.
The Imposed Sheets Tab

The **Imposed Sheets** tab displays imposed RTP jobs. This tab enables you to view the imposed sheets and check your imposition parameters.

![Imposed Sheets Tab](image)

Editing an RTP Job

You can edit an RTP job in the following ways:

- Move pages within the job
- Delete pages from the job
- Insert pages from another job

**Note:** Jobs that you can edit in the Job Preview & Editor window can’t be re-RIPed. Once a job has been saved in the Job Preview & Editor window, it is a new RTP file without an associated PDL file. You can’t apply parameters that require re-RIPing to such jobs.

**To move a page in a job:**

1. Click the **Thumbnails** tab.
2. In the Thumbnail pane, click the page that you want to move.
3. Drag the page to the target location.

   **Note:** The red marker indicates where the page will be inserted.

The page moves to the selected location, and the page numbers are updated accordingly.

4. Click **Save As** to save the changes in the job.

**To delete a page from a job:**

1. In the Job Preview & Editor window, click the page that you want to delete, and click **Remove**.
2. Click **Save As** to save the changes.

**Copying Pages Into a Job**

You can copy one page or all pages from one job to another.

**To copy a page into a job:**

1. In the Job Preview & Editor window, open the job that you want to edit.
2. Click **Merge Job**.

![Merge Job window]

**Note:** The IC-304 print controller displays only those RTP jobs that have the same page size and orientation as the job that you are editing.

3. Select the job that includes the page you want to copy, and then click **OK**.

The thumbnails of the second job appear in a separate window.

4. Find the page you want to copy, and then drag the page to the target location in the job that you are editing.

**Note:** The red marker indicates where the page will be inserted.

The copied page is inserted in the desired location, and the page numbers are inserted accordingly.

**To copy all the pages of a job into another job:**

1. In the Job Preview & Editor window, open the job that you want to edit.
2. Click **Merge Job**.

   The RTP Jobs window appears.
3. Select the job that you want to merge, and then click **OK**.
The thumbnails of the second job appear in a separate window.

4. Click **Merge All**, and then click **Close**.

   All of the pages from the second job that you opened are inserted at the end of the job that you are editing.

5. Click **Save As** to save your changes.

**Job Accounting**

The Accounting Viewer window provides information about all of the jobs that were printed successfully via the IC-304 print controller. By default, all of the jobs that were handled during the past 90 days are listed. The report is in the form of a tab-delimited file. You can filter, sort, and print the jobs in the report and also export the report to a spreadsheet application—for example, Microsoft Excel®—where you can manipulate the data.
Viewing the Accounting Information

> From the **Info** menu, select **Accounting**.

The Accounting Viewer window appears, and lists information related to all the jobs that printed successfully via the IC-304 print controller.

Each row in the accounting report contains information related to a specific job.

**Note:** To see additional columns, use the horizontal scroll bar.

The columns indicate the following information.

<table>
<thead>
<tr>
<th>Table 8: Description of columns in the Accounting Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Column name</strong></td>
</tr>
<tr>
<td><strong>Title</strong></td>
</tr>
<tr>
<td><strong>Type</strong></td>
</tr>
<tr>
<td><strong>Job Size</strong></td>
</tr>
</tbody>
</table>
Table 8: Description of columns in the Accounting Viewer

<table>
<thead>
<tr>
<th>Column name</th>
<th>Indicates the</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender</td>
<td>User name of the system from which this job originated</td>
</tr>
<tr>
<td>Started Process</td>
<td>Date and time in which the job first started processing</td>
</tr>
<tr>
<td>Processing Time</td>
<td>Total time during which the job was processed</td>
</tr>
<tr>
<td>Started Printing</td>
<td>Date and time in which the job first started printing</td>
</tr>
<tr>
<td>Printing Time</td>
<td>Total time during which the job was printed</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Size of the media set for the job—for example, Letter, A3, A4</td>
</tr>
<tr>
<td>Media Type</td>
<td>Paper type</td>
</tr>
<tr>
<td>Weight</td>
<td>Paper weight in gs/m</td>
</tr>
<tr>
<td>B/W Pages</td>
<td>Number of black-and-white pages in the original PDL file</td>
</tr>
<tr>
<td>Color Pages</td>
<td>Number of color pages in the original PDL file</td>
</tr>
<tr>
<td>Blank Pages</td>
<td>Number of blank pages, inserts, or interleaves in the original PDL file</td>
</tr>
<tr>
<td>Total Pages</td>
<td>Number of pages that were printed</td>
</tr>
<tr>
<td>Account</td>
<td>[Optional] string of text, if such was entered in job parameters window</td>
</tr>
</tbody>
</table>
Printing and Exporting the Accounting Log

You can save the accounting information to an ASCII Tab delimited file.

**To export the accounting information:**

1. In the Accounting Viewer window, filter the information as desired.
2. Click **Export**.
3. Find the folder in which to save the report.

---

### Table 8: Description of columns in the Accounting Viewer

<table>
<thead>
<tr>
<th>Column name</th>
<th>Indicates the</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recipient</strong></td>
<td>[Optional] string of text, if such was entered in job parameters window</td>
</tr>
<tr>
<td><strong>Job Comments</strong></td>
<td>[Optional] string of text, if such was entered in job parameters window</td>
</tr>
</tbody>
</table>
4. Click **Export**.

The accounting log is saved as a Tab delimited text file in the specified location.

**Notes:**

- The accounting log includes all the columns (even those that were hidden), listed in the original order and sorting.
- To export specific rows, select them before you click **Export**. The exported accounting log will include only these rows.
- The exported data is not deleted from the accounting report on the IC-304 print controller (that is, it will still be displayed in the Accounting Viewer window).

5. If desired, open the *.txt file in a text editor or in a spreadsheet application—for example, Microsoft Excel—and manipulate the data.

You can print the accounting information (filtered and sorted) to any connected printer.

**To print the accounting log:**

1. In the Accounting Viewer window, filter and sort the report as desired.

   **Note:** To print specific rows, select the desired rows now. The printed report will include only these rows.

2. Click **Print List**.
3. Set the printing options as desired and click OK. The data is printed according to the current filtering and sorting.

Notes:
- To fit the maximum amount of columns on the page, print using Landscape orientation (if your printer supports it).
- The report includes all the columns (including those that were hidden), listed in the original order.

Clearing the Information from the Accounting Viewer

- To clear the information from the Accounting Viewer window, click Clear All.

Creating Virtual Printers

The IC-304 print controller is predefined with three virtual printers:

- **Print**
  Files sent to this printer are automatically processed and printed to the printer through the IC-304 print controller.

- **Process**
  Files sent to this printer are automatically processed and stored in the Storage area of the IC-304 print controller. You can later submit the jobs to be printed, or change the parameters of a job and resubmit it for processing.

- **Store**
  Files sent to this printer are automatically stored in the IC-304 print controller’s Storage area until the print operator submits them for processing and printing.

When you add a new virtual printer, you can specify if it is published on the network and if the parameters of the virtual printer will override the PPD parameters.
If a job that is either sent from the client or downloaded to a particular virtual printer contains preset parameters from the PPD file, these options overwrite the parameters set in the virtual printer for that job. The printer default options defined in the PPD file use the default parameters set for that particular virtual printer.

**To create a new virtual printer:**
1. From the **Tools** menu, select **Resource Center**.
   The Resource Center opens.
2. In the **Resource** list, select **Virtual Printers**.
3. Click **Add**.
4. In the **Name** box, type a name for the new printer you want to add.
5. From the **Based on** list, select an existing printer with similar settings.
6. The **Publish on the network** check box is selected by default. Clear the check box if you do not want to publish the printer on the network.
7. Select the **Override PPD parameters** check box if you would like the virtual printer settings to override the parameters set in the PPD file.
8. In the Comments box, type any comment regarding the virtual printer parameters (optional).

9. Click the Edit button to edit the job parameters of your new virtual printer.

   Note: If you don’t edit the job parameters, the settings of the new virtual printer are taken from the printer on which it was based.

10. Click OK in the Add Virtual Printer dialog box.

    The new printer appears in the Printer list.

**Job Report**

The Job Report window contains all of the information from the job parameters window (including job parameters window title bar data). The Job Report window displays the job parameters on a single sheet and may be exported or printed as a hard copy.

This feature is useful for:

- Retaining job parameters when the same job is planned to be re-printed in the future.

- Providing the client/customer a follow-up tool regarding printed job parameter information.
To open the Job Report window:

1. Right-click a job in the Storage area, and select Job Report.

2. Click Print or Export to print or export the report as a text file.
Production Printing

Imposition.................................................................110
Printing with Page Exceptions.................................117
High-Resolution Workflow........................................119
Fonts..........................................................................121
Managing Paper Type Profiles.................................127
Printing on Tabs Using the Tabs Plug-In for Acrobat ...129
Imposition

Imposition is the process of arranging pages of a job on a press sheet in a particular order so that they will be in the proper sequence after printing, folding, and cutting. Finding the best imposition layout helps create more organized output and saves paper. Imposition does not affect the content of the pages. It affects only the placement of the pages on the press sheet.

The arrangement of the pages on the press sheet depends on many factors, including the size of the pages, the size of the press sheet, and the binding requirements of the finished job. You can also add various marks to the sheets to aid the production process. These marks show where the paper should be folded or trimmed.

Whenever possible, you should define imposition settings before RIPing a job. Changing key imposition settings—for example, template settings—post RIP may result in inefficient re-RIPing of your job.

In the IC-304 print controller, you can define imposition settings in different ways, depending on your needs.

- Use the Imposition tab to define imposition settings for a one-time job or to make changes on the fly. For more information about the Imposition tab, see page 205.
- Use a IC-304 print controller virtual printer to predefine imposition settings for repeat jobs or jobs that have the same imposition settings. For more information about virtual printers, Creating Virtual Printers page 105.

Imposition Workflows

The two examples in this section are typical imposition workflows. The first example shows you how to print business cards, and the second example shows you how to print a brochure.
Printing Business Cards

This example demonstrates how to use the repeat-image imposition method to print business cards. With the repeat-image method, you can print multiple copies of the same image on one large sheet.

In this example, the job contains business cards that are 50 mm × 90 mm (2 in. × 4 in.), imposed on A3 paper.

1. Click the **suspend** button to temporarily stop the **Process Queue**.
2. From the **File** menu, select **Import** to open the Import window.
3. Import your business card file.
   The file is imported to the **Process Queue** with a **Waiting** status.
4. Double-click the business card file in the **Process Queue**.
   The job parameters window appears.
5. Click **Imposition**.
6. For **Imposition Method**, select **Step & repeat**.
7. Click **Size**, and select the following options:
   a. In the **Sheet size** list, select **A3**.
   b. In the **Trim size** list, select **Custom** and then type the custom size in the height and width boxes—for example, 50.0 mm × 90.0 mm.

8. Click **Templates**, and select the following options:
   a. In the **Columns** list, select **5**
   b. In the **Rows** list, select **4**.

   **Note:** Alternatively, select **Best Fit** from the **Layout** list. The print controller automatically calculates the most suitable number of columns and rows. Click **Preview** to view the actual number of pages, and the layout with marks and spaces.
   
   c. In the **Print method** list, select **Simplex**.
9. Click **Spacing**.

10. In the **Marks** list, select **Crop marks**.

A preview of the template layout appears, showing you whether the pages fit on the sheet.
11. Click **Preview** to view a dynamic preview of the layout. If there are conflicts, they are indicated in the following manner:

- Red border: appears if the trim size is bigger than the sheet size
- Dotted lines: appears if the trim size and template settings conflict

12. Click **Close** to close the Preview window.

13. Click **Submit**, and then click the **resume** button to start processing the job.

   The business cards are printed imposed on A3 paper.

### Printing a Brochure

This example demonstrates how to use the saddle stitch imposition method to print a brochure on the IC-304 print controller. The saddle-stitch method arranges the page images on the sheets so that when the sheets are printed, you can take the
sheets out of the printer, fold them, and staple them in the center. In this example, the job contains ten letter-size pages imposed on tabloid paper.

**Note:** You can view your changes to the imposition parameters at any time by clicking the **Preview** button.

1. Click the **suspend** button to temporarily stop the **Process** queue.
2. Click **Import** to open the Import window.
3. Import your brochure file.
   The file is imported to the **Process Queue** with a **Waiting** status.
4. Double-click the brochure file in the **Process Queue**.
   The job parameters window appears.
5. Click **Imposition**.
6. For **Imposition Method**, select **Saddle stitch**.

7. Click **Size**, and set the following options:
   a. In the **Sheet size** list, select **Tabloid (11 × 17)**.
   b. In the **Trim size** list, select **Letter (8.5 × 11)**.
8. Click **Templates**, and select **Rotate 90 deg** check box to rotate all pages 90 degrees to the right.
9. Click Submit, and then click the resume button to start processing the job.

   The brochure is printed imposed on tabloid paper, and is ready for folding and finishing with a staple in the center pages.

   For more information about setting parameters in the Imposition area, see Imposition page 205.

You can use an IC-304 print controller virtual printer to predefine your imposition settings. When you create a new virtual printer or edit an existing one, define the imposition settings for that particular printer. These settings become the printer's default options and are applied to all jobs that use the printer.

For more information about adding virtual printers, see Creating Virtual Printers page 105.

Printing with Page Exceptions

Page exceptions enable you to select a different media type for specific pages within your job. The example in this section uses the brochure from the imposition workflow (see Printing a Brochure page 114) to print a cover with a different paper weight.

1. Make sure that the tray contains tabloid paper that is heavier than the paper needed for the rest of the job.

2. In the workspace, verify which tray contains the heavy paper.

3. In the Storage area, double-click the processed brochure job.

   The job parameters window appears.

   **Note:** This job contains the imposed settings that you set in the previous example.

4. Click Exceptions, and perform the following steps:

   a. In the Type list, select Cover.

   **Note:** The options in the Type list are different when the imposition method is set to saddle stitch.
b. Select the **Duplex** check box.

c. In the **Tray** list, select the tray with the tabloid paper that has the heavy paper—for example, **Tray 1**.

d. Click **Apply**, and then click **Submit**.

The brochure is printed with a tabloid-size cover on heavy paper.

For more information about setting parameters in the Exceptions area, see *Exceptions* page 226.
High-Resolution Workflow

Working with high-resolution files during the design and page layout process can often times be long and inefficient. Processing and manipulating large files and graphics can be very time consuming. To speed up production, it is common to work with low-resolution files until the RIPing stage.

The IC-304 print controller provides Creo APR (Automatic Picture Replacement) and supports Open Prepress Interface (OPI) image replacement workflows for replacing low-resolution files with high-resolution files during the RIP.
Creo APR

Creo APR is an image replacement method for PostScript files. Creo APR is a standardized set of file instructions that specify how an external high-resolution image is placed in a PostScript file as it goes to RIP. The instructions specify the type, size, position, rotation, cropping and location of the high-resolution images themselves.

When you send your PostScript file to be processed, the IC-304 print controller checks it for Creo APR instructions. It then searches for the external high-resolution file, performs the specified image replacement and RIPs the PostScript file.

For more information about setting a high-resolution path and selecting high-resolution or low-resolution images, see APR/OPI page 230.

Export as PDF2Go

PDF2Go is a port through which you can export RTP and PDL files, and convert them to a PDF file during export.

The IC-304 print controller is capable of exporting jobs that are standard PDF files, both before and after processing. For an exported RTP job, the PDF file includes the rasterized data of the job.

The operation converts the RTP information to raster files that can be encapsulated in a PDF format. This process ensures that the file can be processed and printed on any PDF printer.

To export as PDF2Go:

- Select one of the following options:
  - **Print Optimized**: Generates a high-resolution PDF file in 300dpi.
  - **Screen Optimized** (default): Generates a low-resolution PDF file in 72 dpi.

**Tip:** Use the **Screen Optimized** option when you want to generate a light PDF file—for example, a file that you can send as a proof by e-mail.
Fonts

This section lists all the fonts available on the IC-304 print controller, and explains how to work in the **Fonts** area of the Resource Center.

A step-by-step procedure explains how to use the Adobe DownLoader driver to download fonts from a Macintosh client workstation.

You can download Windows fonts from a client workstation to the IC-304 print controller.

Font List

The fonts listed alphabetically in this section are the standard fonts that are available on the IC-304 print controller server.

<table>
<thead>
<tr>
<th>Font Name</th>
<th>Font Name</th>
<th>Font Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdobeSansMM</td>
<td>AdobeSerifMM</td>
<td>AlbertusMT</td>
</tr>
<tr>
<td>AlbertusMT-Italic</td>
<td>AlbertusMT-Light</td>
<td>AntiqueOlive-Bold</td>
</tr>
<tr>
<td>AntiqueOlive-Compact</td>
<td>AntiqueOlive-Italic</td>
<td>AntiqueOlive-Roman</td>
</tr>
<tr>
<td>Apple-Chancery</td>
<td>Apple-ChanceryCE</td>
<td>Arial-BoldItalicMT</td>
</tr>
<tr>
<td>Arial-BoldMT</td>
<td>Arial-ItalicMT</td>
<td>ArialCE</td>
</tr>
<tr>
<td>ArialCE-Bold</td>
<td>ArialCE-BoldItalic</td>
<td>ArialCE-Italic</td>
</tr>
<tr>
<td>ArialMT</td>
<td>AvantGarde-Book</td>
<td>AvantGarde-BookOblique</td>
</tr>
<tr>
<td>AvantGarde-Demi</td>
<td>AvantGarde-DemiOblique</td>
<td>AvantGardeCE-Book</td>
</tr>
<tr>
<td>AvantGardeCE-BookOblique</td>
<td>AvantGardeCE-Demi</td>
<td>AvantGardeCE-DemiOblique</td>
</tr>
<tr>
<td>Bodoni</td>
<td>Bodoni-Bold</td>
<td>Bodoni-BoldItalic</td>
</tr>
<tr>
<td>Bodoni-Italic</td>
<td>Bodoni-Poster</td>
<td>Bodoni-PosterCompressed</td>
</tr>
<tr>
<td>Bookman-Demi</td>
<td>Bookman-Demilight</td>
<td>Bookman-Light</td>
</tr>
<tr>
<td>Bookman-LightItalic</td>
<td>BookmanCE-Demi</td>
<td>BookmanCE-Demilight</td>
</tr>
<tr>
<td>BookmanCE-Light</td>
<td>BookmanCE-LightItalic</td>
<td>Carta</td>
</tr>
<tr>
<td>Chicago</td>
<td>ChicagoCE</td>
<td>Clarendon</td>
</tr>
<tr>
<td>Clarendon-Bold</td>
<td>Clarendon-Light</td>
<td>CooperBlack</td>
</tr>
<tr>
<td>Font Style 1</td>
<td>Font Style 2</td>
<td>Font Style 3</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>CooperBlack-Italic</td>
<td>Copperplate-ThirtyThreeBC</td>
<td>Copperplate-ThirtyTwoBC</td>
</tr>
<tr>
<td>Coronet-Regular</td>
<td>CoronetCE-Regular</td>
<td>Courier</td>
</tr>
<tr>
<td>Courier-Bold</td>
<td>Courier-BoldOblique</td>
<td>Courier-Oblique</td>
</tr>
<tr>
<td>CourierCE</td>
<td>CourierCE-Bold</td>
<td>CourierCE-BoldOblique</td>
</tr>
<tr>
<td>CourierCE-Oblique</td>
<td>EuroMono-Bold</td>
<td>EuroMono-BoldItalic</td>
</tr>
<tr>
<td>EuroMono-Italic</td>
<td>EuroMono-Regular</td>
<td>EuroSans-Bold</td>
</tr>
<tr>
<td>EuroSans-BoldItalic</td>
<td>EuroSans-Italic</td>
<td>EuroSans-Regular</td>
</tr>
<tr>
<td>EuroSerif-Bold</td>
<td>EuroSerif-BoldItalic</td>
<td>EuroSerif-Italic</td>
</tr>
<tr>
<td>EuroSerif-Regular</td>
<td>Eurostile</td>
<td>Eurostile-Bold</td>
</tr>
<tr>
<td>Eurostile-BoldExtendedTwo</td>
<td>Eurostile-ExtendedTwo</td>
<td>Geneva</td>
</tr>
<tr>
<td>GenevaCE</td>
<td>GillSans</td>
<td>GillSans-Bold</td>
</tr>
<tr>
<td>GillSans-BoldCondensed</td>
<td>GillSans-BoldItalic</td>
<td>GillSans-Condensed</td>
</tr>
<tr>
<td>GillSans-ExtraBold</td>
<td>GillSans-Italic</td>
<td>GillSans-Light</td>
</tr>
<tr>
<td>GillSans-LightItalic</td>
<td>Goudy</td>
<td>Goudy-Bold</td>
</tr>
<tr>
<td>Goudy-BoldItalic</td>
<td>Goudy-ExtraBold</td>
<td>Goudy-Italic</td>
</tr>
<tr>
<td>Helvetica</td>
<td>Helvetica-Bold</td>
<td>Helvetica-BoldOblique</td>
</tr>
<tr>
<td>Helvetica-Condensed</td>
<td>Helvetica-Condensed-Bold</td>
<td>Helvetica-BoldOblique</td>
</tr>
<tr>
<td>Helvetica-Condensed-Oblique</td>
<td>Helvetica-Narrow</td>
<td>Helvetica-Narrow-Bold</td>
</tr>
<tr>
<td>Helvetica-Narrow-BoldOblique</td>
<td>Helvetica-Narrow-Oblique</td>
<td>Helvetica-Oblique</td>
</tr>
<tr>
<td>HelveticaCE</td>
<td>HelveticaCE-Bold</td>
<td>HelveticaCE-BoldOblique</td>
</tr>
<tr>
<td>HelveticaCE-Cond</td>
<td>HelveticaCE-CondBold</td>
<td>HelveticaCE-CondBoldObl</td>
</tr>
<tr>
<td>HelveticaCE-CondObl</td>
<td>HelveticaCE-Narrow</td>
<td>HelveticaCE-NarrowBold</td>
</tr>
<tr>
<td>HelveticaCE-NarrowBoldOblique</td>
<td>HelveticaCE-NarrowOblique</td>
<td>HelveticaCE-Oblique</td>
</tr>
<tr>
<td>HoeflerText-Black</td>
<td>HoeflerText-BlackItalic</td>
<td>HoeflerText-Italic</td>
</tr>
<tr>
<td>HoeflerText-Ornaments</td>
<td>HoeflerText-Regular</td>
<td>HoeflerTextCE-Black</td>
</tr>
<tr>
<td>HoeflerTextCE-BlackItalic</td>
<td>HoeflerTextCE-Italic</td>
<td>HoeflerTextCE-Regular</td>
</tr>
<tr>
<td>JoannaMT</td>
<td>JoannaMT-Bold</td>
<td>JoannaMT-BoldItalic</td>
</tr>
<tr>
<td>JoannaMT-Italic</td>
<td>LetterGothic</td>
<td>LetterGothic-Bold</td>
</tr>
<tr>
<td>Font Name</td>
<td>Font Name</td>
<td>Font Name</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>LetterGothic-BoldSlanted</td>
<td>LetterGothic-Slanted</td>
<td>LubalinGraph-Book</td>
</tr>
<tr>
<td>LubalinGraph-BookOblique</td>
<td>LubalinGraph-Demi</td>
<td>LubalinGraph-DemiOblique</td>
</tr>
<tr>
<td>Marigold</td>
<td>Monaco</td>
<td>MonacoCE</td>
</tr>
<tr>
<td>MonaLisa-Recut</td>
<td>NewCenturySchlbk-Bold</td>
<td>NewCenturySchlbk-BoldItalic</td>
</tr>
<tr>
<td>NewCenturySchlbk-Italic</td>
<td>NewCenturySchlbk-Roman</td>
<td>NewCenturySchlbkCE-Bold</td>
</tr>
<tr>
<td>NewCenturySchlbkCE-BoldItalic</td>
<td>NewCenturySchlbkCE-Italic</td>
<td>NewCenturySchlbkCE-Italic</td>
</tr>
<tr>
<td>NewYork</td>
<td>NewYorkCE</td>
<td>Optima</td>
</tr>
<tr>
<td>Optima-Bold</td>
<td>Optima-BoldItalic</td>
<td>Optima-Italic</td>
</tr>
<tr>
<td>Oxford</td>
<td>Palatino-Bold</td>
<td>Palatino-BoldItalic</td>
</tr>
<tr>
<td>Palatino-Italic</td>
<td>Palatino-Roman</td>
<td>Palatino-Bold</td>
</tr>
<tr>
<td>PalatinoCE-BoldItalic</td>
<td>PalatinoCE-Italic</td>
<td>PalatinoCE-Bold</td>
</tr>
<tr>
<td>StempelGaramond-Bold</td>
<td>StempelGaramond-BoldItalic</td>
<td>StempelGaramond-Italic</td>
</tr>
<tr>
<td>StempelGaramond-Roman</td>
<td>Symbol</td>
<td>Tekton</td>
</tr>
<tr>
<td>Times-Bold</td>
<td>Times-BoldItalic</td>
<td>Times-Italic</td>
</tr>
<tr>
<td>Times-Roman</td>
<td>TimesCE-Bold</td>
<td>TimesCE-BoldItalic</td>
</tr>
<tr>
<td>TimesNewRomanPS-BoldItalicMT</td>
<td>TimesNewRomanPS-BoldMT</td>
<td>TimesNewRomanPSItalicMT</td>
</tr>
<tr>
<td>TimesNewRomanPSMT</td>
<td>Univers</td>
<td>Univers-Bold</td>
</tr>
<tr>
<td>Univers-BoldExt</td>
<td>Univers-BoldExtObl</td>
<td>Univers-BoldOblique</td>
</tr>
<tr>
<td>Univers-Condensed</td>
<td>Univers-CondensedBold</td>
<td>Univers-CondensedBoldOblique</td>
</tr>
<tr>
<td>Univers-CondensedOblique</td>
<td>Univers-Extended</td>
<td>Univers-ExtendedObl</td>
</tr>
<tr>
<td>Univers-Light</td>
<td>Univers-LightOblique</td>
<td>Univers-Oblique</td>
</tr>
<tr>
<td>Wingdings</td>
<td>Wingdings-Regular</td>
<td>ZapfChancery-MediumItalic</td>
</tr>
<tr>
<td>ZapfChanceryCE-MediumItalic</td>
<td>ZapfDingbats</td>
<td></td>
</tr>
</tbody>
</table>
Managing Fonts on the IC-304 Print Controller

1. On the toolbar, click **Resource Center**.
2. In the **Resource** list, select **Fonts**.

To set the default font:
- Select a font from the list and click **Set as Default**.

To delete a font:
- Select the font, and click **Delete font**.

Downloading Fonts

Downloading fonts onto your Macintosh IC-304 print controller depends on the Macintosh OS version that you have:

For Mac OS 9.x, you can use the Adobe Fontdownloader for Macintosh environments or clients.

The Fontdownloader is a driver provided for Macintosh environments and enables you to download fonts from Mac OS 9.x clients. The Fontdownloader functions as a communications port
and sends messages between the Fontdownloader software and the IC-304 print controller. You cannot send files through the Fontdownloader, only fonts.

For Mac OS X, you can download fonts using Hot Folders.

The Fontdownloader 5.0.5 software is not compatible with Mac OS X.

To download fonts from Mac OS 9

Note: Mac OS X users that want to download fonts need to use a previous Mac OS version—for example, Mac OS 9. It is recommended that you embed the fonts in your file.

1. From the Apple menu, select Chooser.
2. Select AppleShare and find the IC-304 print controller.
3. Select the IC-304 print controller—for example, IC-304—and then click OK. The Login dialog box appears.
4. Log in as Guest, and click the Connect button.
   The corresponding IC-304 print controller window appears.
5. Select the Utilities/Mac Utilities folder, and then click OK.
   Note: Do not select the check box, otherwise it will mount every time you restart.
6. Double-click the Adobe Downloader 5.0.5 folder.
7. Copy the Adobe Downloader 5.0.5 to your desktop.
8. From the Apple menu, select Chooser.
   The Chooser window appears.
9. Select LaserWriter (8.x) and select the desired fontdownloader.
10. Click Create.
11. Double-click the Downloader 5.05 on your desktop.
12. On the File menu, select Download Fonts.
13. In the Fonts list, select the desired font folder.
14. Verify that the selected device is Disk 0.
15. Add all the desired PostScript fonts and click Download.

Downloading Fonts in a Windows Environment

You can use the HF_Fontdownloader hot folder to install new or missing fonts to the IC-304 print controller fonts dictionary. The hot folder is located in D:\HotFolders and can be used with the following operating systems:

- Windows NT 4.0
- Windows 2000
- Windows XP
- Windows 2003

To download Windows fonts:

- Drag the fonts from your client workstation to the HF_Fontdownloader hot folder.
Managing Paper Type Profiles

The Paper Type Profiles ID window enables you to map paper type profiles to destination profiles. Paper type profiles enable you to work with predefined paper sets instead of separately selecting paper attributes for a job.

Paper profiles are defined on the printer.

To map a paper type profile to a destination profile:

1. On the toolbar, click Resource Manager.
   The Resource Manager appears.

2. In the Resource list, select Paper Type Profiles ID.

3. In the Destination column, select a destination profile for the paper type profile.

4. Click Close.
The following information is available for the paper profile.

Table 9: Description of columns in the Paper Type Profile ID window

<table>
<thead>
<tr>
<th>Column name</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Profile Name</strong></td>
<td>Name of the paper—for example, Heavy Pink.</td>
</tr>
<tr>
<td><strong>Profile ID</strong></td>
<td>ID number of the profile—for example, 1111.</td>
</tr>
<tr>
<td><strong>Paper Size</strong></td>
<td>Size of the paper—for example, A4.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Type of the paper—for example, gloss coated for laser.</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Weight of the paper—for example, 85-105 gsm.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Color of the paper.</td>
</tr>
<tr>
<td><strong>Punched</strong></td>
<td>If the paper was defined as pre-punched (Yes) or not punched (No).</td>
</tr>
<tr>
<td><strong>Destination Profile</strong></td>
<td>(Not defined on printer) The destination profile mapped to the paper type profile. You can change the selected paper type profile to another profile.</td>
</tr>
</tbody>
</table>
Printing on Tabs Using the Tabs Plug-In for Acrobat

The Tabs plug-in is a Creo PODS plug-in, developed for use with Adobe Acrobat version 7.0, on the IC-304 print controller. The Tabs plug-in enables you to create and place tabs in your unprocessed (PDF or PostScript) jobs, manage the tab and text attributes, and save a set of attributes for future use.

To create tabs with the Tabs plug-in:

1. In the Storage window, right-click your unprocessed job and select Job Preview.

   \textbf{Note}: The job must be a PDF or PostScript file.

   The job opens in Acrobat software.

2. From the \textbf{Plug-Ins} menu, select \textbf{Tabs Printing}.

   The Tabs Printing window opens, displaying the \textbf{Text Attributes} tab.
3. In the **Tabs** area, set the tab attributes:

   a. By default, the tab size for letter jobs is set at 9x11, and for A4 jobs, A4+. To change the tab size, select a tab size from the **Size** list.

   b. In the **Type** list, select the number and type of tabs.

   **Note:** If you want your tabs to be reversed—that is, for the lowest tab to be the first one—select one of the reverse tab options.
c. Select the appropriate orientation of the tab.

d. In the Top Offset box, type a value for the distance between the upper edge of the paper and the upper edge of the uppermost tab.

**Note:** The units in the Tabs plug-in are set in the Acrobat Preferences dialog box.

e. In the Bottom Offset box, type a value for the distance between the lower edge of the paper and the lower edge of the lowest tab.

f. In the Length box, type the length of the tab.

g. In the Width box, type the width of the tab.

4. In the Text area, set the attributes of the text on the tabs:

a. (Optional) In the Font list, select a font for the text on the tab.

b. (Optional) In the Size list, select a font size for the text on the tab.

c. (Optional) Click the Color button to change the font color for the text on the tab.

d. (Optional) Click **Bold** to make the text on the tab bold.

e. (Optional) Click **Italic** to make the text on the tab italic.

f. (Optional) Click **Underline** to underline the text on the tab.

g. Click the appropriate alignment button as shown in Table 11.
Table 10: Tab Alignment Buttons

<table>
<thead>
<tr>
<th></th>
<th>Portrait</th>
<th>Landscape</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align Left</td>
<td><img src="image1" alt="Image" /></td>
<td><img src="image2" alt="Image" /></td>
</tr>
<tr>
<td>Align Center</td>
<td><img src="image3" alt="Image" /></td>
<td><img src="image4" alt="Image" /></td>
</tr>
<tr>
<td>Align Right</td>
<td><img src="image5" alt="Image" /></td>
<td><img src="image6" alt="Image" /></td>
</tr>
</tbody>
</table>

h. (Optional) Under **Offset**, type offset values in the x and y boxes to adjust the offset of text on the tab. The x value moves the text horizontally according to the alignment; the y value moves the text vertically.

i. (Optional) Select **Wrap text** to automatically run the text onto the following line when the entire text does not fit on one line.

j. (Optional) Select **Text on both sides** to have the same text appear on both sides of the tab.

k. In the **Direction** area, select the appropriate direction for the text:

![Image](image7) ![Image](image8) ![Image](image9)

*Note:* The **Direction** options are available only for portrait jobs.
5. Click the **Content** tab.

6. In the Before Page column, click the first cell and type the number of the page that you want the tab to precede.

7. In the Text column, type the text for the tab.
The tab appears in the thumbnail area.

8. To add more tabs, repeat steps 6 and 7.

9. Click **Apply** to apply the tab settings to your document.
   The Tabs Printing window closes, and the tabs that you added become part of the document.

10. From the Acrobat **File** menu, select **Save**, and then close Acrobat.
11. Specify that the job contains mixed media by specifying a range of pages:
   a. In the Storage area, right-click the job, and select Job Parameters.
   b. Click the Exceptions parameters, and click the Exceptions tab.
   c. In the Type list, select Page range, and type the pages in the job in which the media type will be different.

   **Note:** For more information about setting the parameters in the Exceptions tab, see Exceptions page 227.

12. Process and print the job.

Managing Tabs in the Tab Printing Window

**To change the location of a tab:**

1. In the thumbnail area, click the tab that you want to move, and drag it to the desired location.

   The tab moves to the selected location, and the tab numbers are updated accordingly.

**To replace a page with a tab:**

1. In the thumbnail area, right-click the page and select Replace with tab page.

   The page is deleted from the document and replaced by a new tab.

2. In the table, type the tab text.

**To insert a tab before or after a specific page:**

- In the thumbnail area, right-click the page and select Insert tab before page or Insert tab after page.
To remove a page or tab from the document:

- In the thumbnail area, right-click the page or tab and select Remove.

Once you have set the tab parameters for a job, you can save the settings. Saved settings are useful when you want to print different jobs with the same tab settings.

To save tab settings:

1. In the upper part of the Tabs Printing window, click Save.

2. In the Setting Name box, type a name for the tab settings.

3. To save the locations and text of the tabs that you created, select the Include Tab location and Caption check box.

   Note: If you do not select this check box, only the text attribute settings are saved.

4. Click Save.

To apply saved settings to a job:

- In the Tabs Printing window, select the settings from the Saved Settings list.

   The saved settings are applied to the job.

   Tip: You can modify any of the settings as desired.

To delete saved settings:

1. In the Tabs Printing window, select the saved settings from the Saved Settings list.

2. Click Delete.

   The saved settings are deleted.
Color Workflow

Calibration .....................................................................................138
Color Tools.....................................................................................146
Calibration

One of the most important issues in obtaining satisfactory print quality is steady toner density. Toner density is affected by many factors such as heat, humidity, and service settings. You should perform calibration every 24 hours to compensate for these factors.

The calibration process corrects the printer colors by measuring their density and creating calibration look-up tables. The IC-304 print controller uses the data in these tables to compensate for the differences between the actual, measured density level and the target level, the target density.

You should perform calibration in the following instances:

• When prints show “color casts”
• After machine maintenance or hardware changes—for example, replacing a “Charge Coroton”
• On drastic ambient changes (temperature and humidity)

Color Calibration Method

The IC-304 print controller uses the target calibration method. This method ensures consistency over time and that the density values of the printed output do not exceed the predefined density values.

Target calibration enables you to calibrate the printer according to the following predefined density values:

Table 11: Fixed density values for uncoated paper

<table>
<thead>
<tr>
<th>Toner</th>
<th>Density value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cyan</td>
<td>1.3426</td>
</tr>
<tr>
<td>Magenta</td>
<td>1.4669</td>
</tr>
<tr>
<td>Yellow</td>
<td>0.9246</td>
</tr>
<tr>
<td>Black</td>
<td>1.7603</td>
</tr>
</tbody>
</table>
Choosing a Calibration Mode

The IC-304 print controller provides you with two calibration modes:

- Off-the-glass: Uses the scanner platen to perform off-the-glass calibration
- Device tool: Uses the GretagMacbeth® Eye-One® spectrophotometer, which is a “high speed” color measurement instrument, to report spectrophotometer and dot data

Before you begin calibration, select the calibration mode in the Preferences window, see "Calibration Device" on page 190.

Performing Off-the-glass Calibration

For best results:

- After you perform the first calibration, you print the IQ_Test_(TAB/A3).pdf file from the D:\Sample_Files\(USA/Europe)\IQ Files folder. Each time you calibrate, use this file as a visual reference to verify that the printer has returned to its start point.
- You calibrate both the printer and scanner at the same time. If you only place the print chart on the platen, the printer is calibrated. If you only place the scanner chart on the platen, the scanner is calibrated.
To perform off-the-glass calibration:

1. In the Preferences window, under **Calibration**, select **Calibration is done off-the-glass**.

2. On the toolbar, click **Calibration**.

3. In the **Tray** list, select the desired tray. The default is **Tray 1**. You can print the calibration chart on any paper size that is equal to or larger than A4 or Letter.

4. In the **Media Type** list, select the desired media type—for example, **Coated**. The default setting is **Use Printer Settings**. When this option is selected, your job is printed on the media type that is defined on the printer.

5. In the **Screening** list, select the screening method. For best results, select the set the screen type to the one that you are going to use to print the job.

6. In the **Number of copies** box, enter the number of copies you want to print.

7. Click **Print**.

The calibration chart prints.
8. Click **Next**.

9. Place both the printer and scanner charts next to each other on the platen and follow the instructions in the Calibration Wizard.

   **Note:** If the calibration chart is not placed within the defined scanning area on the platen, the calibration process may not be successful. To ensure that the calibration process is successful, on the printer, press **HDD > Calibration > Scan Settings**. Then, press **Size Settings > Full Area**, and then press **OK**.

10. When the last chart is successfully measured, click **Next** to apply the calibration to the required media types.
11. Select the **All Media Types** check box to apply the calibration to all media types, or select the **Select** check box, and then select the required media type(s).

12. Click **Finish**.

**Performing Calibration with a Spectrophotometer**

1. In the Preferences window, under **Calibration**, select **Calibration is done using device tool**.

2. Connect one end of the Eye-One spectrophotometer cable to the IC-304 print controller USB port, and connect the other end to the Eye-One Spectrophotometer.

3. Calibrate the Eye-One spectrophotometer, by placing the spectrophotometer on its plate.

4. Load the paper you are going to use for printing in the printer.

5. In the IC-304 print controller software, from the **Tools** menu, select **Calibration**.
6. In the **Tray** list, select the desired tray. The default is **Tray 1**. You can print the calibration chart on any paper size that is equal to or larger than A4 or Letter.

7. In the **Media Type** list, select the desired media type—for example, **Coated**. The default setting is **Use Printer Settings**. When this option is selected, your job is printed on the media type that is defined on the printer.

8. In the **Screening** list, select the screening method. For best results, select the set the screen type to the one that you are going to use to print the job.

9. In the **Number of copies** box, enter the number of copies you want to print.

10. Click **Print**.

    The calibration chart prints.

11. Click **Next**.
12. Place the calibration chart on a flat surface, and scan the chart with the Eye-One spectrophotometer, as follows:

- Press and hold the button on the side of the spectrophotometer, and align the head with the cyan arrow’s tip. The arrow is to the left of the cyan column on the calibration chart. Its tip intersects the semi-dotted line.

- Wait for the spectrophotometer to beep before sweeping it across the cyan column.

- A check mark appears over the cyan icon in the Color Calibration window.

13. Repeat the scanning for the magenta, yellow and black column.

If at any stage the scanning has not been completed properly, click **Reset** and scan again.

14. Click **Next** when calibration is complete.
15. Select the All Media Types check box to apply the calibration to all media types, or select the Select check box, and then select the required media type(s).

16. Click Finish.

Viewing Calibrated Media Type Information

The Calibrated Media Types window provides a list of media types and the date they were last calibrated via the IC-304 print controller.

➤ From the Info menu, select Calibrated Media Types.
The date and time the media was last calibrated appears next to the media type.

If a media type has not been calibrated, N/A is displayed next to the media type.

**Color Tools**

The IC-304 print controller provides you with a number of tools and options that enable you to adjust and improve the color quality in your jobs. The following tools are available:

- Profile Manager, in which you can manage source and destination ICC profiles, see "Managing Profiles" on page 146
- Spot Color Editor, see "Editing and Creating Spot Colors" on page 149
- Gradation Tool window, see "Using the Gradation Tool to Adjust Color" on page 154

**Managing Profiles**

The Profile Manager window enables you to import and delete source and destination ICC profiles.

Source profiles are used to emulate other devices, or color spaces. You can import source CMYK or RGB profiles.

Destination profiles define the color space of your printer and are based on the combinations of paper and toner that you are using. For different media types, you need different destination profiles. Each custom destination profile will be used with coated and uncoated paper.

For more information about selecting source and destination profiles in a job, see "Color" on page 216.

**To import a source ICC profile:**

1. On the toolbar, click **Resource Center**.

   The Resource Center appears.
2. In the Resource list, select Profile Manager.

![Profile Manager](image)

The Source Profile tab displays the predefined source ICC profiles.

3. Click Add.

4. In the Source profile area, click the browse button. Locate and select the required source profile, and then click Open.

The new emulation name is displayed in the Emulation name box; if you would like to change the name you may do so.

5. Click Import.

The new source profile is added to the Source Profile list in Profile Manager. The new source ICC profile is available in the Color Flows tab in the job parameters window.
To import a destination ICC profile:

1. In the Resource Center > Profile Manager, click the Destination Profile tab.

   The predefined ICC profiles are displayed.

2. Click Add. 

3. In the Destination profile area, click the browse button .

   Locate the required source profile, and then click Open.

   The new emulation name is displayed in the Destination Name box; if you would like to change the name you may do so.

4. Click Import.
To delete an ICC Profile:

1. In the Resource Center>Profile Manager, select the profile that you want to delete.

   Note: You cannot delete predefined ICC profiles.

2. Click the Remove button.

   The profile is deleted from the profile list.

Editing and Creating Spot Colors

Individual job pages can contain continuous tone (CT), line work (LW), and spot color elements. The IC-304 print controller Spot Color Editor enables you to edit the CMYK values of every spot color in the Spot dictionary. You can edit these values without affecting the CT or LW page elements. The Spot Color Editor also enables you to create custom spot colors and to define fixed CMYK values for those spot colors. The IC-304 print controller supports HKS and PANTONE 2000 spot colors.

Note: Spot colors—for example Pantone—are not affected by CMYK emulation. A spot color has the same appearance with any selected CMYK emulation.
To edit an existing pantone color:

1. From the Tools menu, select Spot Color Editor.

   The Spot Color Editor dialog box appears with the IC-304 print controller’s entire collection of colors listed.

2. To search for a specific color, perform one of the following actions:

   • In the Color list, search for a particular color.

     Note: You cannot perform an exact query in the Color list. This input stream only reads one character. For example, if you want “Cool Grey 4” and type “Cool”, as soon as you type “C”, the cursor only moves to “Cool Grey 1” and does not continue to a more specific selection.

   • In the Spot dictionary list, select the color dictionary that contains the color you want to edit.

     Note: Use the PANTONE CV dictionary if you are working in—for example, QuarkXPress software.
3. Highlight the required color.
   The color’s CMYK values and a color preview appear in the right hand side of the Spot Color Editor dialog box.
4. Change the CMYK values as required.
5. Click **Apply**.
   The new color is added to the Custom color dictionary.

**To create a new spot color:**

**Note:** If you create a new spot color for an RTP job, perform the following steps before printing:

1. Revert back to the original PDL file.
2. Re-RIP the job.

1. In the Spot Color Editor dialog box, click **Add**.

2. Type the new color name as it exists in the PostScript file.
   **Note:** The spot color names are case sensitive and should match the name as it appears in the DTP application.
3. Adjust the CMYK values as required.
4. Click **Save**.
   The new color is added to the Custom Dictionary.
To delete a spot color (from the custom dictionary only):

1. In the Spot dictionary list, select Custom Dictionary.
2. From the list of custom colors, highlight the color you wish to delete.
3. Click Remove.
4. Click Yes to delete the color.

Protecting RGB and CMYK Colors

This feature enables you to define specific RGB values as RGB spot colors and enter fixed CMYK values for them. You can protect specific colors—for example, official logos or company colors—to help produce color fidelity and color consistency between devices.

To protect RGB and CMYK colors:

1. From the Tools menu, select Spot Color Editor.
   The Spot Color Editor appears.
2. Depending on your workflow, select the Protect RGB or Protect CMYK tab. This procedure describes the Protect RGB workflow, but the procedure is the same for both Protect RGB and for Protect CMYK.
3. Click **Add**.

4. In the **Color name** box, enter a name for the spot color.

5. Enter the RGB source values as they appear in the source file.

6. Enter the CMYK target values you want to use, or from the *(Entire Predefined List)*, select a color from the list of available colors. The CMYK target values are automatically entered.
7. Click **Save**.
   
   The spot color appears in the Spot Color Editor.

8. To use the spot color in your job, select the required options in the **Color > Protect Color** tab of the Job Parameters window, as described on page 221.

### Using the Gradation Tool to Adjust Color

Sometimes you need to perform tone corrections when you print a job. The IC-304 print controller enables you to create a gradation table that will correct your printed output. Changes in gradation can include brightness, contrast, and color balance adjustments throughout the tone range of an entire image or in specific tone ranges.

The Gradation Tool window enables you to create and edit gradation tables as well as visually check the effect of your gradation tables on a specific processed job. The new gradation tables you create are added to the **Gradations** list in the **Color** parameter and can be applied to print jobs.

For more information about selecting gradation tables in the **Color** parameters, see "Gradation" on page 218.

**To open the Gradation Tool window:**

- From the **Tools** menu, select **Gradation**.

  The Gradation Tool window appears.
Previewing a Job

1. Click the Browse button next to the Preview File list.
   
   The Processed Jobs dialog box appears. The jobs that are displayed are the jobs listed in the Storage area.

2. Select the job that you want to preview, and then click Open.
   
   The Original and Edited views display your job.
Editing Gradation Tables

When you open the Gradation Tool window, the default gradation table, DefaultTable, is selected in the Gradation Table list, and is displayed in the graph. This table serves as a baseline and consists of a 45° gradation curve, with Brightness and Contrast set to 0, and Contrast Center set to 50. All of the color separations are selected.

The Gradation Table list includes four other predefined gradation tables:

- Cool: Blue tones appear clearer
- Lively: Increases the color saturation
- Saturated: Increases the strength (chroma or purity) of a color
- Sharp: Increases the contrast
- Warm: Sets the hues in the low densities to a bright reddish color

Gradation tables that you create or edit also appear in the Gradation Table list. When you select a gradation table, the predefined settings are immediately applied to the processed job that you are working with.

The Separations buttons enable you to select one, all, or any combination of separations to edit for a specific gradation table. Selecting a specific separation enables you to change the color balance for a specific tonal range.

When you open the Gradations Tool window, all of the separations are selected.

1. Click the All Colors button to edit all the separations simultaneously.

2. Click the individual separations you wish to edit—for example, select the cyan separation only
3. Click the curve in the graph to add a point, and then drag the point to modify the separation. When you select a point, its value appears in the Input or Output boxes.

   The Input axis represents the tone values of the image before gradation changes. The Output axis represents the tone values of the image after gradation changes.

4. To view gradation changes in your job, click Refresh. Changes are automatically applied to the displayed image in the After view.

5. To remove a point on the curve, select the point and then click Remove.

6. To reset the gradation curve to a 45° curve, click Reset.

7. To revert to the original gradation settings, click Revert.

8. To remove the last change you made to the gradation graph, click Undo.

**Creating a New Gradation Table**

1. In the Gradation Tool window, modify your gradation table as required.

2. Click Save.

   ![Save Gradation Table dialog box]

3. In the Table name box, type the required name for the new gradation table.

4. Click OK.

   The gradation table is saved and added to the Gradation Table list and to the Color Modes tab in the job parameters window.
Deleting a Gradation Table
➢ Select the gradation table, and then click Remove.

**Note:** You cannot delete predefined gradation tables.

Navigation Buttons

The navigation buttons enable you to view the pages or booklets of the current job.

Using the Preview Tools

The preview buttons enable you to switch the display mode in the Original and Edited views.

Table 13: Description of preview buttons

<table>
<thead>
<tr>
<th>This button</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Eye Dropper" /></td>
<td>Find out the CMYK values of a specific area on the page. To find the values, first click the Eye Dropper button. Then move the pointer to the point on the page where you want to measure the color values and click. The CMYK density values and spot color values appear as a tool tip.</td>
</tr>
<tr>
<td><img src="image" alt="Pan" /></td>
<td>View a different area of the image</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Click an area of the page to magnify the area. To return to the previous view, click the Zoom Out button.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Click an area of the page to reduce the size of the page by 50%. To return to the previous view, click the Zoom In button.</td>
</tr>
<tr>
<td><img src="image" alt="One to One Zoom" /></td>
<td>Enables you to zoom into a page to see individual pixels. Each pixel on the screen represents a pixel in the image.</td>
</tr>
</tbody>
</table>
Table 13: Description of preview buttons

<table>
<thead>
<tr>
<th>This button</th>
<th>Enables you to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fit to Screen</td>
<td>Scale the page to fit the available screen space</td>
</tr>
<tr>
<td></td>
<td>View the image at different preset levels of magnification by selecting a percentage in the list</td>
</tr>
<tr>
<td>Rotate View</td>
<td>Rotate the page 90°, 180°, and 270°</td>
</tr>
<tr>
<td>Show/Hide Separation</td>
<td>Turn on or off one or more separations</td>
</tr>
<tr>
<td>Original/Edited view</td>
<td>Toggle between the Original and Edited views</td>
</tr>
<tr>
<td>Original/Edited view</td>
<td>View the Original and Edited views in portrait</td>
</tr>
<tr>
<td>Original/Edited view</td>
<td>View the Original and Edited views in landscape</td>
</tr>
</tbody>
</table>

Brightness and Contrast Slider Controls

The **Brightness** and **Contrast** slider controls are active only when all of the separations are selected.
Brightness

The **Brightness** slider increases or decreases the luminance of the image. Increasing brightness brightens the image and results in a concave curve. Decreasing brightness darkens the image and results in a convex curve.

- Move the **Brightness** slider to the right to increase brightness or to the left to decrease brightness.

Contrast

The **Contrast** slider increases the image contrast by making the highlights lighter and the shadows darker. It can also be used to decrease the contrast.

- Move the **Contrast** slider to the right to increase contrast (S shaped curve), or to the left to decrease contrast (inverted S shaped curve).

Contrast Center

The **Contrast Center** slider increases the image contrast mainly in the midtones. Using Contrast Center, you can adjust where the contrast is increased. To enhance contrast in highlights, the Contrast Center is shifted toward the highlights. To enhance contrast in shadows, the Contrast Center is shifted toward the shadows.

- Set the **Contrast Center** slider to the right to enhance contrast in highlights, or to the left to enhance contrast in shadows.

  Your change affects the gradation graph by moving the point where the curve changes from convex to concave.

**Note:** **Contrast Center** only affects the image if **Contrast** has also been adjusted.
VI Workflow

VI Overview.................................................................162
VI Document Formats..................................................163
Using Variable Print Specification to Print a VI Job.............165
Variable information (VI) jobs are jobs in which the printed materials are individualized for specific recipients or purposes. These materials can include bills, targeted advertising, and direct mailings.

VI jobs are composed of booklets, which are personalized copies of a document. A booklet can consist of one or several pages, but the entire document is targeted at a specific individual or address. For example, a booklet can be either a single-page gas bill or a multipage personalized document.

Each page in the booklet is constructed as a collection of individually RIPed elements that may differ from booklet to booklet, including text, graphics, pictures and page backgrounds. These elements are self-contained graphical entities that may be line art, text, RIPed images, or a combination of these. There are two types of elements in VI jobs:

- Unique elements are used only once for a specific individual or purpose. An individual's name is an example of a unique element.
- Reusable VI elements can be used more than once in different pages, booklets, or jobs. A company logo is an example of a reusable element.

Pages are assembled from the pre-RIPed reusable elements and the RIPed unique elements just before printing. Then the job is printed in the same way as all other jobs.
VI Document Formats

VI jobs are created using VI authoring programs that support Variable Print Specification formats. Most VI authoring programs can convert VI files to conventional PostScript files, which can also be processed by the IC-304 print controller, although less efficiently than Variable Print Specification files. Each authoring program creates VI code that instructs the RIP where to place the VI elements and each authoring program does so in a slightly different manner.

The format you choose can be a stand-alone format that covers all aspects of document design, data management and text capture or it can be an extension of an existing program that enables the creation of VI documents and VI jobs.

The IC-304 print controller can process VI jobs that are in one of the following file formats:

- Creo Variable Print Specification
- Personal Print Markup Language (PPML)
- PostScript
Kodak Variable Print Specification

Kodak Variable Print Specification is the kodak-developed formal language designed for effective production of VI documents.

Variable Print Specification is comprehensive and can specify a complete range of VI documents. It also provides the means for efficient implementation - fast and efficient data processing, and storage prior to printing.

A Variable Print Specification job consists of the following components:

- **Booklet**
  A personalized copy of a document within a single print run where pages and/or elements within a page may vary from booklet to booklet.

- **Sub-job**
  All copies of a particular document—for example, book, brochure, or flyer—within a single print run. On the IC-304 print controller, sub-jobs can be deleted, archived, or reprinted at any time. However, you can still maintain reusable elements for future runs. Reusable elements are cached elsewhere, so only the unique data, which is embedded in the job, is deleted.

- **Reusable Elements**
  Self-contained graphical entities that can be line art, text, raster images or a combination of these types. Reusable elements are represented in PostScript and can be stored as EPS files when appropriate. Reusable elements include clipping and scaling instructions as well as the image data.

  **Note:** Grayscale TIFF and EPS images that are created in CMYK applications (such as PhotoShop) are counted correctly as B&W instead of Color in both the IC-304 print controller and the printer billing meters.
Reusable elements can be used repeatedly in different pages, booklets and jobs. On the IC-304 print controller, all reusable elements are processed once and cached as elements for further use. They can then be reused either within the sub-job itself, or in additional runs of sub-jobs.

• Inline Elements

Unique information is drawn from a database and is embedded in the sub-job. This data prints only once for individual booklets.

PPML

The PPML format is a new XML-based industry standard that print-technology manufacturers developed for the high-speed production of reusable page content.

The IC-304 print controller supports PPML formats. Some of the features that are included enable you to:

• Process PPML jobs efficiently
• Import jobs in various VI formats to the IC-304 print controller

PPML has a hierarchical structure. Document components are separated from their submission file and can be organized and stored in different levels of the hierarchical structure.

PostScript Files

PostScript files are suitable for simple, very short run jobs. All page elements are re-RIPed for each page. These jobs do not use a VI authoring tool at all. Instead, they use a mailmerge function in a Microsoft Word document or a Microsoft Excel spreadsheet.

Using Variable Print Specification to Print a VI Job

To print a VI job:

➢ Submit your job to the IC-304 print controller.
Reusable elements are identified and processed and then are ready for rapid assembly into pages and for reuse during the printing stage.

Your VI job is processed and printed on the IC-304 print controller. The printer prints booklets at full engine speed working uninterrupted from the printer disk. Booklets are compiled concurrently while the printer prints. As pages are sent to the print engine, they are assembled from the various inline and reusable elements on-the-fly.

After the job is completed, it is placed in the Storage area. This job contains the complete variable job including all booklets, variable images, and unique elements.
System Administration

Setting Up and Configuring the IC-304 Print Controller .............. 168
System Messages ..................................................................... 193
Setting Up and Configuring the IC-304 Print Controller

Basic system configuration and settings are defined in the IC-304 print controller Preferences window. The Preferences window contains items that enable you to manage your system.

To open the Preferences window:

- From the File menu select Preferences.

The Preferences window appears. The settings are divided into two lists: Administrator and General. Both lists are explained in the following sections.

Administrator items can be viewed by users of all levels, but are only available to users of Administrator level. General items can be viewed by all user levels, but are only available to users of Administrator and Operator user levels. All items in the Preferences window are view only to Viewer users.
Server Setup

Set the server's name and the current date and time in **Server Setup**.

-changing-the-server-name

1. In the Preferences window, select **Server Setup**.
2. In the Server name area, click Change.

3. In the Computer Name tab, click Change.

4. In the Computer name box, type a new name for the computer.

5. If you want to change the Workgroup or the Domain in which your computer appears, select the desired option and type a new name in the corresponding box.

   **Note:** Do not change the workgroup or domain unless you are instructed to do so.
Important: If you want to change the domain, you will be required to type the password for the domain account. If the password is unavailable, the computer will be locked.

6. Click OK.
7. Click OK in the System Properties window.
   The system prompts you to reboot your computer for the new settings to take effect.
8. Click No if you want to change other system parameters, or click Yes and reboot your computer.

Changing the Date and Time
1. In the Preferences window, select Server Setup.
2. In the Date & Time area, click Change.

3. In the Date & Time tab, select your local time settings.
4. Select the **Time Zone** tab and set the correct time zone.

5. Click **OK**.

**Network Setup**

The **IPX printing** settings, **TCP/IP** settings and the **Apple Talk setup** settings are specified in the **Network Setup** parameter.
IPX Printing

IPX printing enables the IC-304 print controller to act as a job server for the Novell queue. A job server checks each assigned queue at a specified interval, taking care of jobs on a first-in, first-out basis. Once a job is processed, its associated file is deleted from the queue directory.

**Note:** Using this procedure requires further setup by the network administrator.

To set the IC-304 print controller IPX parameter:

1. In the Preferences window, select **Network Setup**.
2. In the **IPX printing** area, click **Change** next to the **Tree** parameter.
   - The Local Area Connection Properties dialog box appears, followed by the NWLink IPX/SPX Properties dialog box.
   - 3. To change the frame type, select a frame type from the **Frame type** list, then click **OK**.
   - 4. Click **OK** also in the Local Area Connection Properties window. You are prompted to restart your computer.
   - 5. Click **No** if you need to make more changes, or **Yes** to reboot.
TCP/IP Setup

The IC-304 print controller is predefined with a default IP address. The TCP/IP option enables you to change this IP address and other TCP/IP settings.

**Note:** Before changing the network settings, consult your System Administrator.

To change the TCP/IP network settings:

1. In the Preferences window, select *Network Setup*.
2. In the *TCP/IP* area, click *Change Settings* next to the *IP Address* parameter.

The Local Area Connection Properties dialog box appears, followed by the Internet Protocol (TCP/IP) dialog box.

3. Select one of the following options:
   - **Obtain an IP address automatically:** To change the IP Address
   - **Use the following IP address:** Type the desired address—for example, *IP address:192.168.62.1 and Subnet mask:255.255.255.0*.

4. Click **OK**.
5. Click **OK** in the Local Area Connection Properties window. You are prompted to restart your computer.

6. Click **No** if you need to make more changes, or **Yes** to reboot.

### Apple Talk Setup

The **AppleTalk Setup** utility enables you to change the AppleTalk zone in which your IC-304 print controller is located.

**To change the Apple Talk network settings:**

1. In the Preferences window, select **Network Setup**.

2. In the **Apple Talk Setup** area, click **Change** next to the **The System will appear in zone** parameter.

   The Local Area Connection Properties dialog box appears, followed by the AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your computer, and click **OK**.
Remote Tools Setup

The Remote Tools Setup enables you to connect from a client workstation to the IC-304 print controller over the network using the Web Center and the Remote Workspace.

For more information about connecting from a client workstation, see Print Driver Software on page 32.

To enable web connections:

1. In the Preferences window, select Remote Tools Setup.
2. Select the Enable WebViewer check box.
3. Select the Enable Remote Connection check box.
4. In the Logoff Automatically after box, enter the amount of time that should lapse before the user is automatically logged off the server.
5. Click Remote Connections Viewer to view users connected to the IC-304 print controller through the Remote Workspace.
Security

User Passwords and Access Levels

The **Auto Log on** check box is selected by default so that you don’t have to log on to the IC-304 print controller at start up. If you want each user to have to log on to the IC-304 print controller, you need to set the security settings.

The security settings consist of three access levels:

- **Administrator (default)**: Enables the user to access all features and settings in the IC-304 print controller
- **Operator**: Enables the user to operate the IC-304 print controller and configure the **General** area in the Preferences window
- **Guest**: Enables the user to view the workspace. A password is not required for this level.

**To set password settings:**

1. In the Preferences window, select **Security**.
2. Clear the **Auto Log On** check box.
3. In the Administrator area, perform the following steps:
   a. If you are changing an existing password, type the password in the Enter old password box.
   b. In the Enter new password box, type a new password.
   c. In the Verify new password box, type the new password again.
   d. Click Apply.
4. If you want to set a password for operators, repeat steps 3a-d in the Operator area.
5. If you don’t want guest users to access the IC-304 print controller, select the Disable guest connection check box.
   **Note:** This option is not available if you selected the Auto Log On option.
6. Click Save.

**Logging On as a Different User**

If you are already working in the IC-304 print controller workspace, you can change your access level—for example, if you are logged on as an operator and you need administrator privileges.

1. From the File menu, select Log On As Different User.
2. In the Access Level list, select a different access level.
3. If you want to log on as an administrator or operator, type your password.
   
   **Note:** If you want to log on as a guest, you don't need a password.

4. Click Logon.
   
   You are logged on with the new access level.

**Disk Wipe**

Usually when you delete a file, the file's dictionary entry is removed but data still remains on the disk. The Disk Wipe utility enables you to clear previously deleted files. The utility eliminates the contents of your deleted files by scanning all of the empty sectors on the disk and replacing them with zeros. Non empty sectors are left untouched. This feature enables you to work in a more secure environment. If there is a system shutdown, the disk wipe operation can begin immediately.

**Notes:**

- The disk wipe operation does not function well when the Norton Utilities application is installed. Before you activate the Disk Wipe utility, make sure that Norton Utilities is not installed on the IC-304 print controller.
- In rare cases, the process of deleting files from the Storage area is not completed—for example, the system shuts down before the deletion process is completed. In these cases, parts of the deleted files still reside in the D:\Output folder. Therefore, it is recommended that before you start the disk wipe operation, check the D:\Output folder to ensure that all the relevant files were deleted.
- The Disk Wipe utility affects the user disk and Printer disk.
- Do not operate the Disk Wipe utility while another application is running.
- The supported language is English.

**To operate the IC-304 disk wipe utility:**

1. In the Preferences window, select **Security**.
2. Select the **Wipe disk on system shutdown** check box.
3. Click **Save**.
4. Exit the IC-304 print controller software.

   After a few minutes, the following window appears.

   ![Disk Wipe Window]

   5. Click **Start Wiping**.

      A progress bar appears while the disk wipe operation permanently deletes files.

   6. When the message **Disk wiping was completed successfully** appears, click **Exit**.

**System Disks**

When the Printer disk or User disk reaches a pre-defined threshold of minimum available space (the default is 250 MB), RIP is suspended and the system provides a warning message. The RIP will resume automatically only after disk space is available.
To set the system disks threshold:

1. In the Preferences window, select **System Disks**.
2. In the **System Disks** area, set the minimum free disk space desired for RIP.
3. 

**Scan Management**

The scanbox access control and scan jobs settings are set in the Scan Management settings.

For more information about using scan boxes, see *Setting Up Scan Boxes* on page 73.
Setting the Scanbox Access Control

1. In the Preferences window, select Scan Management.
2. Set the ScanBox Manager access control for the administrator only or for all users. This option specifies who can set up and manage scan boxes.

Setting the Delete Scan Jobs

1. In the Preferences window, select Scan Management.
2. In the Delete scan jobs after box, set the desired number of days after which the system automatically deletes scanned jobs saved to the Public scan box. By default, the system deletes all of the scanned jobs in the Public scan box on a daily basis.
3. Click the Delete Now button to delete scanned jobs from the Public scan box.
Enabling Remote Scan Application Connections
1. In the Preferences window, select **Scan Management**.
2. Select the **Enable Remote Scan Application connections** check box.

Mail Service

The mail service options to receive and send scanned jobs directly to one or more e-mail addresses are set in the **Mail Service** settings.

In the **Mail service setup** area, specify the following in the appropriate boxes:
- Outgoing mail server
- Maximum attachment size
- Administrator’s e-mail address
In the **Authentication level** area, set the mail authentication level to one of the following options:

- Anonymous
- Basic. If you select this option, type a user ID and a password in the appropriate boxes.

### Connected Finishers

Connected finishers are selected in the **Connected Finishers area.**

**Setting Connected Finishers**

1. In the Preferences window, select **Connected Finishers**.
2. In the **Connected finishers area**, select the required finisher.

**Note:** The options available for the selected finisher are displayed in the **Finisher** tab in the **Finishing** area of the Job Parameters window. For more information, see *Finishing* on page 220.
Localization

The **Localization** measurements and the **Language** are set in the **Localization** area.

**Setting the Localization Measurement**

1. In the Preferences window, select **Localization**.
2. In the **Units** area, select **Millimeters** or **Inches**, as desired.

**Setting the Language**

1. In the Preferences window, select **Localization**.
2. In the **Language** area, select the language, as desired.

**Note:** If you switch to another language, you need to restart the IC-304 print controller software.
Deletion Policy

When jobs have been handled by the IC-304 print controller, they are stored in the Storage area. You can specify a number of days after which the jobs are removed from the Storage area.

To delete jobs from the Storage area:

- Select the Automatically delete jobs from Storage check box, and enter the desired number of days.
Pre-RIP Preview

Setting the PS Preview Preferences
1. In the Preferences window, select Pre-RIP Preview.
2. In the PS Preview area, specify the desired action when you close the Adobe Acrobat preview window, save the file as a PDF, or return to the original PS file.

Setting the VI Jobs Preview
- In the VI jobs preview area, select the desired number of booklets you want to preview before the job is processed.
Print Queue Manager

Setting the Job Batching Policy
1. In the Preferences window, select Print Queue Manager.
2. In the Job batching policy area, enable or disable the job batching option.

Held Jobs Policy
- In the Held jobs policy area, select one of the following options:
  - Bypass held jobs: To bypass held jobs in the Print Queue
  - Don’t bypass held jobs: To stop printing from the Print Queue when a job is assigned a held status
Default Image Size

1. In the Preferences window, select **Default Image Size**.
2. From the **Size** list, select the required size.
   
   This option enables you to temporarily select a paper/image size for a PostScript file that does not contain page size information so that the system can raster the file.
1. In the Preferences window, select \textbf{Calibration Device}.

2. In the \textbf{Calibration Device} area, select one of the following options:
   
   - \textbf{Calibration is done off-the-glass}: Uses the scanner platen to measure the calibration charts
   
   - \textbf{Calibration is done using the device tool}: Uses a spectrophotometer to measure the calibration charts

For more information about how to perform calibration, see \textit{Performing Off-the-glass Calibration} on page 139.
JDF Output Path

The IC-304 print controller receives the JDF job ticket via hot folders, returns JDF output with job accounting information, and submits JMF (Job Messaging Format) signals with the job’s status.

If the JDF job has a target path specified in the job, JDF output is always created. For JDF jobs that do not have a specified target path, the JDF output is only created if this option is selected in the Preferences window.

To enable JDF output:
1. In the Preferences window, select **JDF Output Path**.
2. Select the **Create JDF outputs** check box.
3. Select one of the following:
   - All jobs
   - Only source JDF jobs
4. In the Target path box, type the location of the folder in which you want the JDF output files to be saved, or click Browse to locate the folder.

The folder location you define will only be applied if the JDF job does not contain a target route. If the JDF job does include a target route, the target route specified in the JDF job will override the folder location.

**To enable JMF job signals:**

1. Select the Send JMF signals check box.
2. In the HTTP URL box, type the URL.

**Paper Size Switch**

This option enables you to automatically switch between European paper sizes (A4 and A3) and American paper sizes (letter and tabloid).
In the **Paper size switch due to Region** area, select the required check box. The available options are:

- Auto Switch A4/A3 with Letter/Tabloid
- Auto Switch Letter/Tabloid with A4/A3

### System Messages

While jobs are being handled by the IC-304 print controller, various messages are emitted. Messages about each job are stored in the Job Log and messages generated during a session are stored in the Messages window.

#### System Disks Threshold Message

When the Printer disk or User disk reach a pre-defined minimum available space threshold (usually of 250 MB), RIP is suspended and the system provides a warning message. The RIP resumes automatically only after disk space is available. In this case, you may increase the system disk threshold.
For more information about setting the system disks threshold, see *System Disks* on page 180.

**Job History**

The Job History window lists all of the messages that were generated during the workflow of the selected job. You can view the job title and owner (the user name of the system from which the job originated).
To open the Job History window:

- Right-click a job in the Storage area, and select Job History.

Message Information

For each message, the following information is indicated by default:

- An icon denoting the type of message (Error, Warning, or Information)
- Date and time on which the message was emitted (the time stamp)
- Stage in the workflow—for example, Print Queue or Process Queue
- Message text

You may filter the messages by type, and/or sort the list by one of the column headers.

Messages

To open the Message Viewer window:

- From the Info menu, select Messages.

The Message Viewer window appears and lists all of the messages that were generated during the workflow.
For more information about viewing messages related to a specific job, see Job History on page 194.

Managing Messages

You can filter the messages by type, and/or sort the list by one of the column headers. In addition, you may print the list of messages.

If desired, you may reorder and resize columns, filter the list or sort the list by one of its column headers.

Notes:
- This section is relevant for the Message Viewer window and the Job History window.
- These settings are retained after closing a window.
Filtering the Messages by Type

Each message in the Message Viewer window and Job Viewer window is assigned an icon to denote the message type:

- Information
- Warning
- Error

You can filter the list in order to view only messages of certain types. By default, all message types are listed in the Message Viewer window.

**Note:** If the message type is not selected, messages of this type do not appear in the list.

- Click any message type icon—for example, Error—in order not to list such messages.

  The list updates accordingly.

Printing the Message List

You can print the information as it is presented in the Message Viewer window (as it is currently filtered and sorted).

**To print the message list:**

1. Filter and sort the list as desired (the data is printed according to the current filtering and sorting).
2. Click **Print List**.
   - The Print window is displayed.
3. Set the printing options as desired, and then click **OK**.
Backing Up and Restoring the Configuration

The **Backup & Restore Configuration** feature enables you to backup your IC-304 print controller configuration to a local hard disk, network drive, or to a CD/DVD.

**To backup the configuration of your IC-304 print controller:**

1. On the toolbar, click **Resource Center**.
   The Resource Center window appears.

2. In the **Resource** box, select **Backup & Restore Configuration**.

3. In the **Backup configuration** area, click **Browse**.
   The Save dialog box appears.

4. Find the desired directory path for the backup.

5. Enter a name for the file. For best results, use the current date as part of the file name.

6. Click **Save**.

7. In the Resource Center window, click **Start Backup**.
   After a few minutes, the backup completed message appears.

**Note:** The last path will be saved and displayed to the path box. If the backup was made to an external media, the displayed path will be the default: **C:\IC-304\General\Configuration**.
To restore the configuration of your IC-304 print controller:

1. On the toolbar, click **Resource Center**.
   The Resource Center window appears.
2. In the **Resource** box, select **Backup & Restore Configuration**.
3. In the **Restore Configuration** area, click **Browse**.
   The Open dialog box appears.
4. Locate the directory path in which you backed up the configuration.
5. Select the file (.cnf), and then click **Open**.
6. Click **Start Restore**.

   ![Restore configuration window]

7. Select the categories you want to restore, and click **OK**.

   **Note:** When you restore the configuration, all the custom tables and sets—for example, new virtual printers—are added to the system.
Setting Parameters

Setting Parameters in the Job Parameters Window .....................202
Setting Parameters in the PPD File ..................................................233
Setting Parameters in the Job Parameters Window

This appendix describes each parameter in the job parameters window.

Print

The **Print** parameters enable you to set print-related job parameters such as the print range, the number of copies you would like to print, the print method and order.

The IC-304 print controller uses multiple paper stock parameters such as **Paper size**, **Media type**, and **Tray** to specify the media type.

If the selected media type is unavailable, the current job is held until the appropriate set is available (the job receives an **on hold** status indicator, and a message appears in the Message Viewer window). Other jobs can print while jobs are held.
Copies and Pages

Copies

➢ Enter the number of copies to be printed.

Pages

➢ Select a print range.

If the printed job is a VI job, the Pages option changes to Booklets. To select specific pages, booklets, or page ranges, specify the pages or booklets to be printed as follows:

• Type one or several numbers separated by commas and no spaces—for example, 1,3,5.

• Type a range of pages or booklets with a hyphen between the starting and ending numbers in the range—for example, 1-5.

Note: For imposed jobs, instead of typing the desired pages, type the desired imposed sheets.

Print Method

➢ Select one of the following options:

• Simplex: for single-sided printing

• Duplex HTH (head to head): for printing book-style hard copies (usually used with portrait jobs)

• Duplex HTT (head to toe): for calendar-style hard copies (usually used with landscape jobs)

Paper Stock

Use Paper Profile

Select this check box, and then click Select to choose a paper profile. Paper profiles contain paper stock options such as size, type and weight.

Note: Paper profiles are specified on the printer. For more information about paper profiles, see Managing Paper Type Profiles on page 127.
Paper Size

- Select the desired paper size. If you select Custom, type the required width in the W box and the required height in the H box.

  Note: Units of measurement (mm or inches) reflect system configuration. You choose units in the Preferences window (see Localization on page 185).

Page Orientation

- Select the desired page orientation—Portrait or Landscape. Use this option if you receive undesirable page orientation results in your print out.

Media type

- Select the desired media type. The default setting is Use Printer defaults. When this option is selected, your job is printed on the media type that is defined on the printer.

Gloss Mode

- Select this check box to give a glossy look to your printed output.

Weight

- Select the desired media weight. The default setting is Use Printer defaults. When this option is selected, your job is printed on the paper weight that is defined on the printer.

Punched Paper

- Select this check box if you want to print the job on pre-punched paper. The pre-punched paper must be loaded into the specified tray. If not, the job is held.

Colored Paper

- Select this check box if you want to print the job on pre-colored paper. The pre-colored paper must be loaded into the specified tray. If not, the job is held.
Tray

- Select the desired tray:
  - **Tray 1, Tray 2, Tray 3**: Load the specified stock in this tray.
  - **Auto**: The printer will use any tray with the specified stock.

  **Note**: The Auto tray option uses the paper in the selected tray only if it complies with all the other paper stock parameters. If the paper stock in the assigned tray doesn’t match all of the job’s parameters, the job is held.

Force Tray

- Select this check box to force the job to the specified tray. This option is not available if Auto is selected in the Tray list.

Gallop

Gallop enables you to begin printing a defined number of pages before the entire job has been RIPed.

- Select the **Print after** check box, and in the **Pages** box, type the number of pages to RIP before printing starts.

Imposition

The Imposition parameters enable you to select job options related to the positioning, folding, trimming, and binding of pages.

You can preview your imposition layout in the Preview window at any time by clicking **Preview**. For more information about the Preview window, see page 211.
**Imposition Method**

The **Imposition Method** parameter specifies how printed sheets are finished. You have to choose a method according to the finished format that you need.

- **Select one of the following options:**
  - **None:** This is the default option. If you select *None*, the imposition parameters are unavailable and the thumbnail viewer does not display an image.
  - **Step & repeat:** Use this option for printing multiple copies of the same image so it fills up a larger sheet. This method is used mainly for printing business cards.
  - **Step & continue:** Use this option to print different pages of a job on one sheet according to the selected layout, so that the sheet is filled to capacity.
  - **Cut & stack:** Use this option to enable step & repeat jobs to be printed, cut, stacked and bound in the most efficient manner, while preserving the original sorting. A job’s pages, booklets, or books are sorted in a Z-shape. In other words,
each stack of pages is sorted in consecutive order. When stacks are piled one on top of another, the entire job is already sorted up or down.

- **Saddle stitch**: Use this option for a book-finishing technique where the pages of a book are attached through stitching or stapling in the spine fold—for example, brochures.

  When **Saddle stitch** is selected, the **sets per sheet** option is available. This option enables you to place two or four sets of imposed booklets on a single sheet.

- **Perfect bound**: Use this option for a book-finishing technique where the pages of a book are attached through trimming of the spine fold, roughening the edges of the gathered pages and gluing them together—for example, hardcover books.

**Size**

**Sheet size**

- Select the required sheet size. If you select **Custom**, type the required width in the **W** box, and the required height in the **H** box.

**Trim size**

- In the **Trim size** list, select the desired trim size. If you select **Custom**, type the required width in the **W** box, and the required height in the **H** box.

**Trim orientation**

This option is view only. It is set to **Portrait** or **Landscape** according to the page orientation selected in the **Print > Paper Stock** tab.

Trim size is the size of the finished, trimmed document.
You can adjust your page size by adjusting the trim size.

**Note:** If you set the trim size to be smaller than the page size set in the DTP application, some of the data is cropped. Setting a larger trim size results in a larger border on the printed page.

**Trim orientation** specifies the orientation, portrait or landscape, for the trim size. If the wrong orientation is specified, an unsuitable template might be selected and the job might be cropped as a result.

**Templates**

**Layout**

- Select the desired layout. You can choose:
  - **Best Fit**—to automatically calculate the most suitable number of columns and rows.
  - **Custom**—and then in the **Columns** list, select the number of pages to place horizontally. The rows and columns indicate how the pages will be placed on the sheet. In the **Rows** list, select the number of pages to place vertically.

**Print method**

- Select the desired layout—for example, **Duplex HTH** or **Duplex HTT**.
Binding selection
This check box is only available if the imposition method is either saddle stitch or perfect bound, and the template is 2×1, 2×2, or 4×2.

North south
Select this check box if the template you chose is either step and repeat 2×1 or 1×2. The pages will be placed 180 degrees from each other, on the same side of the imposed sheet.

Rotate 90 deg
Select this check box to rotate all pages 90 degrees to the right. This rotation can help correct imposition conflicts.

Spacing

Marks
➢ In the Marks list, select one of the following options:

  • Crop marks: To print the lines that indicate where the sheet should be cropped. To print the crop marks on both sides of the page, select the Both Sides check box.

  Notes:
  • If you want to use crop marks incorporated in the DTP application, make sure that enough space is left around your page in the PostScript file so that the page prints with crop marks.
  • If your job already includes crop marks incorporated in the DTP application, you do not need to add crop marks here. If you do add crop marks, both sets of crop marks can be printed.

  • Fold marks: To print the lines that indicate where the sheet should be folded.

  • Crop & fold marks: To print the lines that indicate where the sheet should be both cropped and folded.

Bleed size
➢ Enter a value. The value that you enter depends on the paper size and imposition method you choose.
When you set bleed options, you extend part or all of the printed image beyond the trimming boundary. The bleed options ensure that an inaccurate trim setting will not leave an undesired white space at the edge of the page. The bleed options produce sharp page boundaries with color that extends all the way to the edge of the page.

**Notes:**
- You cannot extend the bleed size beyond the sheet fold lines. Bleed does not affect the position of crop.
- Bleeding must be defined in your DTP application in order for the IC-304 print controller to be able to apply the bleed options.

**Margins**
- Enter a value to adjust the spaces between the outside edges of pages and the edges of the sheet on which they are printed.

**Notes:**
- Margin settings should suit finishing equipment and requirements.
- Confirm binding parameters with your binder when planning your sheet.

**Gutter**
- Enter a value. The value that you enter depends on the paper size and imposition method you choose.

The gutter size is the space between pairs of pages (according to the trim size) on a sheet. When the pages are folded into a booklet, the gutter allows space for trimming.

**Spine size**
- Enter a value. The value that you enter depends on the paper size and imposition method you choose.

**Creep**

Creep is a common problem in saddle-stitch jobs. When signatures are inserted inside one another, the signatures inserted last are the farthest from the center of the booklet. As a result, the
outer edges of the inner pages creep past the outer pages.

Note: It is recommended that you use a border around all documents when you use creep.

Creep in
- Select one of the following options:
  - **Auto**: To automatically set a value based on media weight
  - **Custom**: To enter a custom value

Creep out
- Enter a value. The value that you enter depends on the paper size and imposition method you choose.

Preview Window
The Preview window enables you to view your imposition layout and settings. You can open the Preview window at any time and check your imposition settings as you select them.

To open the Preview window:
- Click **Preview** in any of the Imposition parameter window.
The Preview window enables you to:

- View the front of the pages in the job by clicking **Front**.
- View the back of the pages in the job, by clicking **Back**.
- Move between sheets by clicking the navigation arrows.
- Move to a specific sheet by typing a number in the navigation box.

Gray arrows indicate the direction of the pages on the sheet. The sequence of pages is indicated by the page numbers.

If any parameters conflict, **Imposition Conflict appears in red.**

### Quality

The **Quality** parameters enable you to set print quality related job parameters and to improve the quality of printed jobs. These parameters include the possibility to enhance text and graphics quality, set trapping, and to define the black overprint.
IC-304 Image/Graphics Quality

**Graphics quality (Text, Line)**
- Select **High** to improve the quality of text and lines in a job.

  **Note:** It is recommended that you use this option only if your source file includes diagonal lines or text with jaggies.

**Graphics quality (Text, Line)** refers to the Creo anti-aliasing algorithm for text quality. This option causes blends to appear smooth with no banding, and displays crisp diagonal lines without (or with minimal) jaggies (rough edges) that are the result of the limited resolution of the print engine.

**Image quality**
- Select **High** to improve the quality of images in a job.

**Image quality** refers to the ability to maintain the same detail and smoothness with different degrees of enlargement. This feature is especially useful when your PostScript file includes several images at different qualities—for example, images that were scanned at different resolutions, were rotated, or downloaded from the Internet.

**Slim Text/Graphics**
- Select this check box to improve the jagged edges that may result in cases where transparent elements are overlaid on text or vector elements.

**Improve Text/Line in Image**
- Select this check box to significantly improve image quality in cases where high-res data may be reduced in quality during RIP.

In some cases, images in the PDL file contain data that belong to the LW layer, such as screen captures and hi-res rasterized text. During RIP these images are rendered to the CT layer—300 DPI and JPEG compression. The **Improve Text/Line in Image** option recognizes these images and renders them into the CT layer, improved image quality.
C6500 Text/Graphics Quality

Note: The C6500 Text/Graphics Quality settings are printer-enabled features.

Slim Text
- Select this check box to improve the jagged edges that may result in cases where transparent elements are overlaid on text or vector elements. It is recommended to use this option when graphic elements unexpectedly expand—for example, bolded text.

Reversed Type Enhancements
- Select this check box to enhance reversed type (negative) text. It is recommended to use this option when text becomes narrower—for example, white text on a dark background.

Outline Enhancements
- Select this check box to enhance jagged edges of halftone text and graphics. An outline is added to the jagged edges.

Text Smoothing
- Select this check box to reduce the jagged edges of darker text or graphics.

Trapping
1. Select the Enable Trapping check box to apply trapping.

   Note: If you don’t select the Enable Trapping check box, it does not affect trapping incorporated by DTP applications—for example, Photoshop. FAF should not be used with application based trapping. In a PostScript file that already contains trapping from the originating application, it is not necessary to use IC-304 print controller trapping.

2. In the Frame thickness box, enter the desired value for the thickness of the trapping frame.

Protect small text
- Select this check box so that any text that is smaller or equal to 12 pt. is not framed during FAF.
Trapping is a solution that solves misregistration between color separations in both offset and digital printing. This occurs no matter the accuracy of the printing device, and results in white lines around objects on top of a background (in a knock-out procedure) and also between adjacent colors.

Protect small text is an option you may apply for small or complex images, since thicker frames can decrease quality by hiding parts of an image. Selecting this option will protect any text smaller or equal to 12 pt by not framing it while applying the FAF algorithm.

Frame thickness refers to the thickness of trapping. The thicker the frame, the less chance that white areas appear between images.

Overprint

**Black overprint**

This check box is selected by default. It ensures that black text prints cleanly within a tint or picture area. The text appears in a richer, deeper black, with the underlying CMY values equal to those of the printed background.

**PS overprint**

This check box is selected by default, and ensures that the overprint information that exists in the PostScript file is used. This parameter also determines whether the DTP application PostScript overprint settings are honored in the RIP.

Screening

- Select the required option. For CT images, use a dot option, and for LW images, use a line option.

Screening converts CT (Continuous Tone) and LW (Line Work) images into information (halftone dots) that can be printed. The human eye “smooths out” this information, which seems visually consistent with the original picture. Thus, the more lines per inch, the more natural the image appears.

Screening is achieved by printing dots in numerous shapes or lines in an evenly spaced pattern. The distance between the screen dots or lines is fixed and determines the quality of the image.
Printers can work with even amounts of toner and still produce a wide range of colors when you use screening. The darker the color, the larger the dot.

**Smooth Gradient**
This option is selected by default, and improves the appearance of gradient backgrounds or fine shade changes in the printed image.

**Color**

The **Color** parameters provide you with tone compression tools such as brightness, contrast and gradation. You can also select rendering intent, source profiles for RGB and CMYK, and destination profiles.

The tone compression tools, **Gradation**, **Brightness**, and **Contrast** can be applied to your processed jobs without requiring the IC-304 print controller to re-RIP the jobs. The color tools, **Destination Profile**, **Rendering Intent**, **Emulate Paper Tint**, and **Spots**, should be applied prior to initial RIPping or your job will need to be re-RIPped.
Color Mode

- Select one of the following options:
  - **Grayscale**: To print the job as black and white using Black (K) toner only. When a color job is printed using the Grayscale option, the Cyan (C), Magenta (M), and Yellow (Y) separations are also printed in Black (K) toner, giving a dense appearance similar to the CMYK grayscale image.
    
    **Note**: Grayscale images created in RGB applications, such as PowerPoint, should be specified as Monochrome or submitted to the system with Grayscale selected in the PPD file. This selection ensures that grayscale images are counted as black and white instead of color in both the IC-304 print controller and in the printer billing meters.
  
  - **CMYK**: To print the job in color using CMYK.

Color Adjustments

**Brightness**

- Select the required brightness level (the range starts from Lightest, which applies -15%, to Darkest, which applies +15%).

Brightness is generally used to make last-minute adjustments to the print job after proofing. By changing the Brightness setting, you can control how light or dark your output will appear.

**Contrast**

- Select a contrast level for the print job, (the range starts from Less which applies -10%, to More which applies +10%).

Adjusting the Contrast enables you to control the difference between the light tones and the dark tones in your image.

Contrast is generally used to make last-minute adjustments to the print job after proofing.
Gradation

> Select one of the following options:

- **None**: The printer applies maximum dry ink coverage. This is the default setting.
- **Cool**: Blue tones appear clearer
- **Lively**: Increases the color saturation
- **Saturated**: Increases the strength (chroma or purity)
- **Sharp**: Increases the contrast
- **Warm**: Sets the hues in the low densities to a bright reddish color

The Gradation parameter contains a list of gradation tables that were created in the IC-304 print controller Gradation Tool window. Each gradation table contains specific settings for brightness, contrast, and color balance.

When you select your predefined gradation table, your job is adjusted according to the specific table’s settings.

Ink Saving

**GCR**

> Select Yes to conserve toner by replacing the gray component (CMY) of pixels with black toner.

The gray component replacement also prevents the consequences of excessive toner buildup, such as flaking and cracking, or the "curling" effect that may occur when printing transparencies.

While the gray component of each color is replaced by black, there is no change in the color quality of the printed image.

**Identify black**

> Select this check box if you want RGB gray text and graphics to be printed with black toner only.

The Identify black check box not only affects R=G=B values, but may also cause slightly different values \((R+/-4=G+/-4=B+/-4)\) to produce gray.
Color Flow

**CMYK source profile**

- Select the desired CMYK source profile. If you select an emulation profile the following options are available:
  - **Emulate source paper tint**: To emulate the original paper tint if it is included in the profile
  
**Notes:**

  - If the job is simplex, only the front side will be printed using the tint emulation.
  - When the **Emulate paper tint** check box is selected, **Absolute Colorimetric** will be used as the rendering method.
  
  - **Preserve pure colors**: Preserves pure cyan, magenta, yellow, and black during transformation
  
  - **Emulate RGB Elements**: Converts RGB elements according to the selected CMYK emulation method. The RGB elements receive the same look as the CMYK elements, creating a consistent appearance.

**CMYK rendering intent**

- Select the desired CMYK rendering intent.

For more information about rendering intent, see **Rendering Intent** on page 248.

**RGB source profile**

- Select the desired RGB source profile.

**RGB rendering intent**

- Select the desired RGB rendering intent.

**Destination profile**

- Select the required profile. You can select a custom or the predefined destination profile, **C6500**.

  Custom destination profiles imported via the Profile Manager are displayed in the **Destination Profile** list.
Protect Color

The Protect Color options enable you to use spot colors created with the Protect Color tool in your job instead of the original color values in your job. See page 152 for information about working with the Protect Color tool.

**Based on**

In the **Based on** list select the source of the spot color from one of the following options:

- **Original file values** to use the original values specified in the job
- **Spot Dictionary** to use the spot color that was defined for the CMYK or RGB values of the job in the spot dictionary.

**Protect CMYK colors**

Select this check box to protect CMYK colors

**Protect RGB**

Select this check box to protect RGB colors.

Finishing

The **Finishing** parameters enable you to select various options to finalize your printed documents.
Finisher

The options provided in the Finisher tab reflect the type of finisher connected to the printer.

Note: The connected finisher is specified in the Connected Finishers parameters of the Preferences window. For more details, see Connected Finishers on page 184.

Tray

In the Tray list, select an exit tray for your printed output.

Offset

Select this check box to use an offset between sets.

Staples

The Staples list enables you to specify where you want to position the staples on the page.
Punch
The Punch check box is active only if a punch kit is available. There are three punch units available, 2 hole, 3 hole, or 4 hole.

Sample Pages
The Sample Pages option enables you to print a sample set to the Sub tray when you print the job to the Stacker main tray.

1. Select the Print samples every check box, and specify the frequency in which to print the sample set, by typing the number of copies.
2. Specify the frequency in which you want to sample the pages in the job, as follows:
   - All pages to sample all the pages in the job
   - Every X pages
   - Page and type the required page number

Fold type
- In the Fold Type list, select one of the following fold types:
  - Half Fold folds your booklets in the center of the page.
  - Z-Fold folds your booklets with 6-panels and two parallel folds that go in opposite directions. Each panel of the Z-fold is about the same size.
  - 3-Fold-In folds your booklets with six panels with two parallel folds. The left and right edge of the paper fold overlap.
  - 3-Fold-out folds your booklets with six panels with two parallel folds in a spiral fold configuration.
  - Double Parallel Fold folds your booklets in half and then in half again with a fold parallel to the first fold.
  - Gate Fold folds your booklets in three parallel folds. The left and right edges of the paper fold and meet in the middle, without overlapping, along a center fold.

Trim
The Trim check box is active only when a trimmer unit is available.
Center Staples

Select the Center Staples check box if you want center staples.

Note: If you want to staple or punch the other side of your job, on the Layout parameter select the Rotate 180 check box.

Printing Covers

The following options are available when a perfect binder finisher is connected and you are printing a job to the main tray.

3. In the Pull Cover From list, select the tray that contains the paper on which the cover will be printed.

4. In the Cover Content list, select one of the following options:
   - Blank/Preprinted — when your cover is not printed as part of the job
   - Compose from file (Simplex) — when your cover is part of the file, and should be composed and be printed on one side of the page.
   - Compose from file (Duplex) — when your cover is part of the file and should be composed and printed on both sides of the page.
   - Print (Simplex) — when the front and back covers are contained on the same page in the file and printed on one side
   - Print (Duplex) — when the front and back covers are contained on the same page in the file and printed on both sides

5. In the Cover Orientation list, select the print orientation of the cover.

6. If you are composing the cover in the file, in the Spine list, select one of the following options:
   - Blank — to print a blank spine
   - From file, to print the spine content contained in the file.
7. In the **Binding** list, specify the direction of the binding.

   Note the following behavior when loading preprinted covers into feed trays:

   - **Left Binding—Trays 1, 2, or 3**—Load cover face down, top of cover must point to rear of machine
   - **Left Binding—Bypass, Cover tray, PI1, PI2**—Load cover face up, top of cover must point to rear of machine
   - **For Right Binding—Trays 1, 2, or 3**—Load cover face down, top of cover must point to front of machine
   - **Right Binding—Bypass, Cover tray, PI1, PI2**—Load cover face up, top of cover must point to front of machine

**Print Order**

**Collated**

- Select this check box to print a complete copy of the job before the first page of the next copy is printed.

**Reverse print order**

- Select this check box to set the print order from back to front.

**Face up**

- Select this check box to deliver a job face up.

**Face down**

- Select this check box to deliver a job face down.

**Outside Printing**

Select this option if you want the printed side of the media on the outside of the fold.

**Inside Printing**

Select this option if you want the printed side of the media on the inside of the fold.
Slip Sheets

Slip sheets between copies
1. Select this check box to print slip sheets with your job.
   
   If you want to collate the job, the slip sheets are printed between sets. If you want the job uncollated, the slip sheets are printed between groups.

2. In the Tray list, select the tray in which the specified media type is loaded.

Layout

Scaling
- Select one of the following options:
  - Manual: Enter the percent by which you want to proportionally decrease or increase the image size.
  - Fit to output sheet size: For the image to fit the selected paper sheet size.

*Note:* You can also use the Fit to output sheet size option to scale the layout for imposed jobs.

Rotate 180
- Select this check box to rotate your job by 180°.

Image Position

The Image Position feature enables you to change the location of the entire printed image on the sheet (simplex or duplex).

This function uses the following terminology:

Same on both sides
- Select the Same on both sides check box to shift the image on the sheet’s second side (face down image) according to the shift on the sheet’s first side (face up image).

*Note:* Use this option to move duplex page data away from the spine.
• **Rear:** the sheet's edge near the printer rear, where printing stops
• **Lead:** the edge of a sheet at which printing begins

The page’s lead and rear edges are determined just after the page is printed out, before making any change in the page orientation.

### Exceptions

Exceptions are used when you want to use different media types for special exceptions within a job or add inserts (interleaves).
Exceptions

1. In the **Type** list, select the pages in your job in which the media type will be different.

2. Depending on the option you selected in the **Type** list, perform one of the following steps:
   a. For **Page range**, type the page range in the box.
   b. For **Front cover** or **Back cover**, select the **Duplex** check box to print the first two (or last two) pages of the job as the cover page (back cover).
      
      **Note:** If the imposition type is saddle stitch, select **Cover** to print both a front and back cover page on a different media type. Select **Middle sheet** to print the internal sheets on a different media type.
   c. For **Inserts**, select **Before** or **After** and type the page number that will precede or follow the insert. Then, in the **Quantity** box, type the total number of inserts you want to add.

3. In the **Tray** list, select the tray in which the specified media type is loaded.

4. Click **Advanced Options**.

5. In the **Destination profile** list, select a destination profile.

6. In the **Trim orientation** list, select the trim orientation for the job.

7. If you have a perfect binder finisher connected and you want a Z-fold in your job, from the **Folding** list, select **Z-fold**.

8. Select **Apply**.
Mixed Originals

- Select the **Original Mixed paper size** check box to enable you to print a job that has mixed paper orientation—for example, Sef/Lef A4/A3 Letter/Tabloid).
Services

The Services parameters enable you to set job parameters that will assist your job workflow.

Admin Page

1. Select the Admin Page check box.
2. In the Use Tray list, select the tray in which the media type you want to use is loaded.

The administration page contains job-related information such as the job title, page size, number of pages or sets, and the sender name.

The administration page is printed in the same order as the job, for face-down printing the page is printed before each set and for face-up printing the page is printed after each set.

Note: If you change the options in the Admin page parameter, the job needs to be re-RIPed.
APR/OPI

In the APR/OPI area, select one of the following options:

- **High resolution images**: To replace low-resolution images in your job with high-resolution images that are located in a specified APR or OPI path.

- **Low resolution images**: To print the job with the existing low-resolution images—for example, for proofing purposes.

There are two default paths in which the IC-304 print controller searches for high-resolution images:

- **Search in the input folder**: The IC-304 print controller first searches for high-resolution images in the same folder as the PDL file.

- **D:\Shared\High Res**: If you want to save your high-resolution files in this folder, copy the files to D:\Shared\High Res.

You can also add a new high-resolution path, and then edit, or delete the path.

Paths other than the default paths are defined on a per-job basis, or set in the virtual printer. You can specify paths on local hard drives, CD-ROM drives, and the floppy drive connected to the IC-304 print controller. You can also specify paths on remote clients or file servers.

**To add a high-resolution path**:

1. Under the APR path box, click Add.
   
   The HiResPath dialog box appears.

2. Click Add.
   
   The Select dialog box appears.

3. Locate your high-resolution images, and then click Select.
   
   The new path is displayed in the HiResPath dialog box.

4. To promote or demote a selected APR path, use the arrow buttons.

   **Note**: The order in which the APR paths are listed is the order in which the IC-304 print controller searches for the high-resolution images.
To delete a high-resolution path:
1. In the HiResPath dialog box, select the path you want to delete.
2. Click Remove.
   The selected path is deleted.

Job Deletion
Select this parameter when you are printing a large VI job that takes up a substantial amount of the IC-304 print controller disk space. When you select this parameter, the IC-304 print controller deletes each page on the fly once it has been successfully printed. In this way, the IC-304 print controller maintains enough free disk space for the duration of the print run. Reusable elements are not deleted.

➢ Select one of the following options:
  □ Delete printed jobs: To remove pages or jobs from the IC-304 print controller after printing is completed
  □ Delete failed jobs: To remove failed jobs while processing or printing from the IC-304 print controller

Notes:
• The Delete failed jobs option sustains enough free disk space for the duration of the print run and only affects the sub-job.
• The Variable Print Specification file is also deleted.

Font Substitution
➢ Select this check box to substitute a missing font with the default font that is set in the Resource Center.

Notes:
• If a font is substituted, a message appears in the Job History window.
• You can only substitute Latin fonts.
Optimizations

Optimizations enable you to significantly decrease processing time of PDF and Postscript jobs with repeated elements by applying a PDF or PS workflow. The workflow caches the repeated elements in the job once, and reuses them as much as required without repeated processing.

To ensure that repeated elements are marked as repeated in the PDF or PS file, distill the PostScript file using the Adobe Acrobat Distiller software.

**Important:** Verify that in your Acrobat Distiller settings, Optimize for Fast Web View is selected (in Acrobat 4.0 the corresponding option is Optimize PDF).

**PDF optimization**

Select this check box if you have a PDF job with repeated elements and want to significantly decrease processing time by applying the PDF workflow.

**PS optimization**

Select this check box if you have a PostScript job with repeated elements and want to significantly decrease processing time by applying the PS workflow.

**Copy Protect**

This parameter enables you to print a glossy spot or a print overlay as the background on the sheet. The printer engine supports the copy protect feature, and it is only available when the HDD option is installed on the printer engine.

1. In the **Type** list, select the text of the desired watermark from the following options—Copy, Invalid, Illegal copy, Invalid copy. If you do not require text, select None.
2. In the **Background** list, select the desired background from the following options—Cherry blossom, Arabesque, or Lattice.
3. In the **Color** list, select the color in which the background will appear from the following options—Black, Magenta or Cyan.
4. In the **Orientation** list, you can change the orientation of the watermark on the page.
Job Flow
This parameter is active when you edit a published printer. You can specify a specific job flow for a job that is imported to the IC-304 print controller from the network or from IC-304 print controller server folders.

Job Info
This parameter provides the following information:

• **Job title:** Original name of the file related to this job
• **Sender:** User name of the system from which this job originated
• **Account:** Account number of a specific customer or group
• **Recipient:** Name of customer
• **Job comments:** Any special instructions that you want to include with your job
• **URL:** Specifies the JDF output path.

For more information about specifying JDF output paths, see *JDF Output Path* on page 191.

Setting Parameters in the PPD File

The PPD file parameters enable you to set job parameters from a client workstation using the IC-304 print controller. The PPD file parameters are displayed when the Print Driver software is disabled.

For information about disabling the Print Driver software see page 47.
The PPD file parameters are accessed when you select Properties in the Print dialog box of the software from which you are printing.

Notes:

- In the PPD file, the Printer's Default option is selected for all PPD file parameters. The Printer's Default option corresponds to the settings of the currently selected virtual printer.

- The parameter settings that were last modified or applied are the settings that are applied to the job. However, if the Override PPD Parameters option was selected in the virtual printer, the print settings defined in the job file override the parameters of the virtual printer.

- Grayscale images created in RGB applications (such as PowerPoint) should be specified as monochrome or you should select the Identify black check box in the PPD file when you submit the job to the IC-304 print controller. This selection ensures that grayscale images are counted as black and white instead of color in both the IC-304 print controller and in the printer billing meters.
Table 14: List of PPD file parameters

<table>
<thead>
<tr>
<th>PPD Parameter</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Method</td>
<td>See <em>Print Method</em> on page 203</td>
</tr>
<tr>
<td>Media Type</td>
<td>See <em>Media type</em> on page 204</td>
</tr>
<tr>
<td>Gloss Mode</td>
<td>See <em>Gloss Mode</em> on page 204</td>
</tr>
<tr>
<td>Punched Paper</td>
<td>See <em>Media type</em> on page 204</td>
</tr>
<tr>
<td>Color Paper</td>
<td>See <em>Media type</em> on page 204</td>
</tr>
<tr>
<td>Media Weight</td>
<td>See <em>Weight</em> on page 204</td>
</tr>
<tr>
<td>Force Tray</td>
<td>See <em>Tray</em> on page 205</td>
</tr>
<tr>
<td>Color Mode</td>
<td>See <em>Color Mode</em> on page 217</td>
</tr>
<tr>
<td>Brightness</td>
<td>See <em>Brightness</em> on page 217</td>
</tr>
<tr>
<td>Contrast</td>
<td>See <em>Contrast</em> on page 217</td>
</tr>
<tr>
<td>Spots</td>
<td>See <em>Destination profile</em> on page 219</td>
</tr>
<tr>
<td>Gradations</td>
<td>See <em>Gradation</em> on page 218</td>
</tr>
<tr>
<td>GCR</td>
<td>See <em>GCR</em> on page 218</td>
</tr>
<tr>
<td>Identify Black</td>
<td>See <em>Identify black</em> on page 218</td>
</tr>
<tr>
<td>CMYK Source Profiles</td>
<td>See <em>CMYK source profile</em> on page 219</td>
</tr>
<tr>
<td>Emulate Paper Tint</td>
<td>See <em>CMYK source profile</em> on page 219</td>
</tr>
<tr>
<td>Preserve Pure Colors</td>
<td>See <em>CMYK source profile</em> on page 219</td>
</tr>
<tr>
<td>Emulate RGB Elements</td>
<td>See <em>CMYK source profile</em> on page 219</td>
</tr>
<tr>
<td>Rendering Intent for CMYK</td>
<td>See <em>CMYK rendering intent</em> on page 219</td>
</tr>
<tr>
<td>RGB Source Profiles</td>
<td>See <em>RGB source profile</em> on page 219</td>
</tr>
<tr>
<td>Rendering Intent for RGB</td>
<td>See <em>RGB rendering intent</em> on page 219</td>
</tr>
</tbody>
</table>
Table 14: List of PPD file parameters

<table>
<thead>
<tr>
<th>PPD Parameter</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Text and Graphic Quality</td>
<td>See <em>Graphics quality (Text, Line)</em> on page 213</td>
</tr>
<tr>
<td>High Image Quality</td>
<td>See <em>Image quality</em> on page 213</td>
</tr>
<tr>
<td>Trapping</td>
<td>See <em>Trapping</em> on page 214</td>
</tr>
<tr>
<td>Black Overprint</td>
<td>See <em>Black overprint</em> on page 215</td>
</tr>
<tr>
<td>PS Overprint</td>
<td>See <em>PS overprint</em> on page 215</td>
</tr>
<tr>
<td>Screening</td>
<td>See <em>Screening</em> on page 215</td>
</tr>
<tr>
<td>C6500 Slim Text</td>
<td>See <em>Slim Text</em> on page 214</td>
</tr>
<tr>
<td>C6500 Reversed Type enhancements</td>
<td><em>Reversed Type Enhancements</em> on page 214</td>
</tr>
<tr>
<td>C6500 Outline enhancements</td>
<td><em>Outline Enhancements</em> on page 214</td>
</tr>
<tr>
<td>C6500 Text smoothing</td>
<td><em>Text Smoothing</em> on page 214</td>
</tr>
<tr>
<td>Staples</td>
<td>See <em>Finisher</em> on page 221</td>
</tr>
<tr>
<td>Punch</td>
<td>See <em>Finisher</em> on page 221</td>
</tr>
<tr>
<td>Fold</td>
<td>See <em>Finisher</em> on page 221</td>
</tr>
<tr>
<td>Trim</td>
<td>See <em>Finisher</em> on page 221</td>
</tr>
<tr>
<td>Offset</td>
<td>See <em>Finisher</em> on page 221</td>
</tr>
<tr>
<td>Reverse print order</td>
<td>See <em>Reverse print order</em> on page 224</td>
</tr>
<tr>
<td>Slip Sheets</td>
<td>See <em>Slip Sheets</em> on page 225</td>
</tr>
<tr>
<td>Rotate 180</td>
<td>See <em>Rotate 180</em> on page 225</td>
</tr>
<tr>
<td>Image Scale</td>
<td>See <em>Scaling</em> on page 225</td>
</tr>
<tr>
<td>Front Cover (Simplex)</td>
<td>See <em>Exceptions</em> on page 226</td>
</tr>
<tr>
<td>Front Cover (Duplex)</td>
<td>See <em>Exceptions</em> on page 226</td>
</tr>
</tbody>
</table>
Table 14: List of PPD file parameters

<table>
<thead>
<tr>
<th>PPD Parameter</th>
<th>Printing Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Cover (Simplex)</td>
<td>See <em>Exceptions</em> on page 226</td>
</tr>
<tr>
<td>Back Cover (Duplex)</td>
<td>See <em>Exceptions</em> on page 226</td>
</tr>
<tr>
<td>Admin Page</td>
<td>See <em>Admin Page</em> on page 229</td>
</tr>
<tr>
<td>APR</td>
<td>See <em>APR/OPI</em> on page 230</td>
</tr>
<tr>
<td>Automatic Deletion</td>
<td>See <em>Job Deletion</em> on page 231</td>
</tr>
<tr>
<td>Slim Text</td>
<td>See <em>Slim Text</em> on page 214</td>
</tr>
<tr>
<td>Reversed Type Enhancements</td>
<td>See <em>Reversed Type Enhancements</em> on page 214</td>
</tr>
<tr>
<td>Outline Enhancements</td>
<td>See <em>Outline Enhancements</em> on page 214</td>
</tr>
<tr>
<td>Sub Tray</td>
<td>See <em>Tray</em> on page 205</td>
</tr>
<tr>
<td>Printing Side</td>
<td>See <em>Outside Printing</em> on page 224 and <em>Inside Printing</em> on page 224</td>
</tr>
<tr>
<td>Copy Protect</td>
<td>See <em>Protect Color</em> on page 220</td>
</tr>
<tr>
<td>Original Mixed paper size</td>
<td><em>Mixed Originals</em> on page 228</td>
</tr>
<tr>
<td>Job Info (PC Only)</td>
<td>See <em>Job Info</em> on page 233</td>
</tr>
<tr>
<td>Smooth gradient</td>
<td>See <em>Smooth Gradient</em> on page 216</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>24 bit/3 byte image</td>
<td>An image can be either RGB or CMY and each of the three colors uses 1 byte or 8 bits of data. Since 3 bytes equals 24 bits, these images are also known as 24 bit images. This system is used for high quality video imaging and scanning. For process color printing, a fourth color (black) is added for optimum effect.</td>
</tr>
<tr>
<td>32 bit/4 byte image</td>
<td>An image that uses 8 bits each for CMYK pixels, or 8 bits for each RGB pixel and 8 pixels for a mask layer or other future use. Since 4 byte equal 32 bits, these images are also known as 32 bit images. An 8 bit CMYK image is the minimum required for high quality print reproduction.</td>
</tr>
<tr>
<td>4 color printing</td>
<td>Color reproduction method used to create full color output by overlaying cyan, magenta, yellow and black inks.</td>
</tr>
<tr>
<td>8 bit/1 byte image</td>
<td>An image limited to 256 tones of one color or 256 different colors. Since 1 byte contains 8 bits and each bit has two choices, 1 byte equals 28 choices or 256 possibilities.</td>
</tr>
<tr>
<td>Additive color model</td>
<td>Color system in which the picture is composed of the combination of Red (R), Green (G) and Blue (B) light transmitted by the original subject. Effective for monitors and TV’s but not for print. Scanners normally first scan in RGB and it is converted into CMYK for printing. See also RGB, CMYK, Process colors, Subtractive color model.</td>
</tr>
<tr>
<td>Absolute Colorimetric</td>
<td>A rendering intent method similar to Relative Colorimetric except that it does not make adjustments according to the white point. In this method, colors that do not fit within the output color space are rendered at the extremes of the output color space. Colors that fall inside the output color space are matched very accurately. This method is valuable for representing “signature colors”. Colors that are highly identified with a commercial product such as the cyan in the Creo logo.</td>
</tr>
</tbody>
</table>
Amplitude Modulation
Halftone screening, as opposed to FM screening, has dots of variable size with equal spacing between dot centers.

Anti-Aliasing
A step effect in which angled lines or curved edges of elements in an electronic image look broken or jagged, as a result of producing it in a grid format. Increasing resolution can reduce this effect or using a technique called anti-aliasing where the edges are softened.

Binding
The process by which pages of a book or other publication are attached to one another.

Bit
Abbreviation of binary digits. The smallest unit of information used to store information in a computer. Bits are expressed as a binary notation, that is, in ones and zeros.

Bitmap graphics
An image composed of individual pixels. The color value and position of each pixel are individually described in bits and bytes of computer memory. It is called a bitmap because it is effectively a map of bits. See also Raster file.

Bleed
An extra amount of printed image, which extends beyond the trim edge of the sheet or page.

Booklet
VI jobs are composed of booklets, which are personalized copies of a document. A booklet can consist of several pages, but the entire document is targeted at a specific individual or address. VI jobs include elements that may differ from booklet to booklet, including text, graphics, pictures and page backgrounds.

Butt
To join without overlapping or space between.

Byte
A grouping of 8 bits of stored information, giving 256 levels of data. Each byte represents a value or character such as a letter or a number. In a color system, a byte can describe one out of 256 distinct shades.

CIE
Abbreviation for Commission Internationale d'Éclairage. This body was created for the study of illumination problems. CIE color coordinates specify proportions of the three additive colors required to produce any hue and are used for comparative color measurement.
| **CMYK** | The process colors - Cyan, Magenta, Yellow and Black. See also *Color separations*, *Process colors*, and *Subtractive color model*. |
| **Color gamut** | The range of colors possible with any color system. |
| **Color separations** | Separate films are prepared for each of the process printing inks - cyan, magenta, yellow and black. These films are used to prepare the printing plates for printing on press. See also *CMYK*. |
| **Composite mode** | In composite mode, the data required to separate a page into its CMYK components is all contained within one single (composite) file. Brisque or PS/M then separates the file into CMYK as part of the conversion process. This processing mode is the fastest and most efficient in the majority of cases. |
| **Crop** | To eliminate portions of an illustration or photography so the remainder is more clear, interesting or able to fit the layout. |
| **CSA (Color Space Array)** | The spectrum of specific variants of a color model with a specific gamut or color range. For example, within the color model RGB, there are numerous color spaces, such as Apple RGB, sRGB, and Adobe RGB. While each of these define color by the same three axes (R, G, and B), they differ in gamut and other specifications. CSA is comprised of a three-dimensional geometric representation of colors that can be seen or generated using a certain color model and are quantitatively measured. Source CSA is to be used only under the assumption that the upstream color workflow was managed and monitored. Otherwise it should be replaced with a Creo profile, which is the default. |
| **CSA Profiles** | There are three CSA profiles with gammas of 1.8, 2.1 and 2.4. The higher the gamma, the darker the RGB appears. This workflow should be used when you have images from different sources, such as digital cameras, Internet, and scanners and you want the images to have the common RGB color spaces. Other possible CSA profiles are sRGB and Adobe RGB. |
| **CT** | Abbreviation for continuous tone. Color or black and white photographic images with tones that change gradually from dark to light (unlike the abrupt changes in linework). |
| **DCS**       | Abbreviation for Desktop Color Separation, an EPS format containing 5 files. Four of the files contain the color information for each of the CMYK colors and the fifth is a low-resolution composite file for use in electronic page layout. |
| **Degradé**  | A gradual blend or transition between colors. Also known as vignette or graduated blend (Vector drawing). |
| **Digital front end system** | In electronic publishing, this is the workstation or group of workstations containing the applications software for preparing pages of type and graphics. In prepress, this is the workstation that gives access to the user for the operation of hardware. For example, proofer, platesetter, imagesetter. |
| **Digital proof** | A black and white or color image reproduction made from digital information without producing intermediate films. It can be output as a digital hard proof using a peripheral output device or displayed as a digital soft proof on a video monitor. |
| **Dot**      | The individual element of a halftone. |
| **Dot area** | The percentage of an area covered by halftone dots ranging from no dots at 0% to a solid ink density at 100%. The size of a single dot is stated in a percentage of the area it occupies. |
| **DTP**      | Abbreviation for Desktop Publishing. The process of page production using personal computers, off-the-shelf software and an output device such as a printer or imagesetter. Usually, these components form a system that is driven by a device-independent page description language such as PostScript. |
| **EPS**      | Abbreviation for Encapsulated PostScript, a graphic file format used to transfer PostScript, graphic files from one program to another. It includes both a low-resolution preview and the high resolution PostScript image description. On the Macintosh, the preview is in PICT format, on the PC it is in TIFF format. Also known as EPSF. |
| **Finishing stage** | Stage following the press process, which may include procedures such as laminating, perforating and varnishing. |
| **Font**     | A complete assortment of letters, numbers, punctuation marks, characters etc. of a given design and size. |
Frame

A color overlap created intentionally at a color border so as to minimize the effects of misregistration. Also known as trap or grip. See also Trapping.

Frequency modulated screens

A method of creating halftones where the spots are all the same size, but the frequency or number of dot changes in a given area. There are more dots in a dark area and fewer in a light area.

GCR

Abbreviation for Gray Component Replacement. Method for reducing the CMY amounts that produce the gray component in a color, without changing the color hue.

Graduated blend

See Degradé.

Gravure printing

A printing method in which the image is engraved through a screen below the surface of a cylinder. The ink is transferred to paper when pressed to the cylinder. Gravure is used for very long print runs and on many substrates.

Gray component

The amounts of CMY in a color, which result in neutral gray, based on the lowest separation value of the color. See also GCR.

Grayscale

A scale of gray tones from white to black. Digitally, grayscale images have up to 256 different levels of gray. See also 8 bit/1 byte image.

Halftone

A negative or positive image whereby detail of the image is reproduced with dots varying area but of uniform density. Creates the illusion of continuous tone when viewed with the naked eye.

Held job

A job for which the appropriate paper stock is not available, for example, the correct paper type, paper size or paper weight.

Highlights

The whitest portions of the original or reproduction that have no color cast. The highlight dot is ranged in the reproduction from the smallest printable dot to approximately 25%. See also Midtones and Shadows.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HSL</strong></td>
<td>Abbreviation of Hue, Saturation and Lightness. This is a color model, which specifies a color by its wavelength (Hue), chroma or purity of the color (Saturation) and value of its brightness (Lightness).</td>
</tr>
<tr>
<td><strong>Image area</strong></td>
<td>Portion of a negative or plate corresponding to inking on paper. The portion of paper on which ink appears.</td>
</tr>
<tr>
<td><strong>Imposition</strong></td>
<td>The arranging of pages in a press form to ensure the correct order after the printed sheet is folded, bound and trimmed.</td>
</tr>
<tr>
<td><strong>Ink jet proof</strong></td>
<td>A proof of a digital image printed by using jets that squirt minuscule drops of ink. Ink jet proofers can print onto a variety of surfaces.</td>
</tr>
<tr>
<td><strong>Job Flow</strong></td>
<td>Job flow refers to the job parameter settings of selected virtual printers that are automatically applied to all jobs printed using that virtual printer. These settings determine how a sent or imported file is processed. For example, a file sent to a virtual printer with a Process &amp; Print job flow will be RIPped, printed and stored in the Storage area. A file sent to a Process &amp; Store job flow virtual printer will be RIPped and stored, without printing.</td>
</tr>
<tr>
<td><strong>LEF</strong></td>
<td>A printer page orientation, where pages are delivered long edge first.</td>
</tr>
<tr>
<td><strong>Laserwriter driver</strong></td>
<td>A part of the Macintosh system software which generates PostScript instructions from an application file when the Print command is activated.</td>
</tr>
<tr>
<td><strong>Look-up table (LUT)</strong></td>
<td>A two or three-dimensional array of values stored for specified input-output relationships. When one input value is known, the system can automatically determine the correct output value. For example, the system can find the needed dot size for a given set of printing conditions based on the stored gray level; color setups can be saved in color tables (color transformation tables) which are one of the many kinds of LUTs.</td>
</tr>
<tr>
<td><strong>Linework</strong></td>
<td>Linework graphics are characterized by sharply defined lines and very clear transitions from one color to another. Linework is stored in the computer as a series of geometric (vector) drawing instructions.</td>
</tr>
</tbody>
</table>
Metamerism
Metamerism occurs when two colors match under one light source, but appear different under another light source. Those two colors are called a metameric match. A metameric match might cause problems when trying to match proofs to press-sheets under different lighting conditions.

Midtones
Density values of an image (original or reproduction) between the highlights and the shadows. In the reproduction, midtones are printed with dot areas between approximately 40% or 60%. See also Highlights and Shadows.

Misregistration
A situation common during printing where one or more of the color separations is slightly misaligned with regard to the others on press. Misregistration shows up as white gaps or tinted overlaps at the borders of color pairs. Colors containing such files are trapped to compensate for this possibility. On Continuous Tone images, misregistration can lead to blurring. See also Overprint and Trapping.

Moiré
An interference pattern caused by differences in halftone screen angles or rulings. In process color printing, screen angles are selected to minimize this pattern. If the angles are not correct, a pattern that distracts the eye from the picture may be produced.

Newton's rings
Small concentric circles that can appear on film when two surfaces are closed together but not in perfect contact.

Output resolution
The number of laser dots per unit of linear measurement (millimeter, inch etc.) on film or paper.

Output tone curve
A graph showing the relationship of original input densities and the corresponding dot percentages on film.

Overprint
A technique, which overlaps colored elements to eliminate the appearance of gaps between elements caused by misregistration of the various separations during printing. For example, black text is normally set to overprint. See also Trapping and Misregistration.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDL</td>
<td>Printer Description Language files (for example, PostScript, PDF, EPS, VPS). The IC-304 print controller processes image files in PDL formats, converting them into a suitable Ready-To-Print format for direct, high-quality printing.</td>
</tr>
<tr>
<td>PICT</td>
<td>A Macintosh file format for bitmaps and vector graphics.</td>
</tr>
<tr>
<td>Perceptual (Photographic)</td>
<td>(Default for RGB) A rendering intent method which preserves the visual relationship among the colors as they are perceived by the human eye. In other words, all colors are proportionally scaled to fit the output gamut. All or most colors in the original are changed but the relationship between them does not change. This method is recommended when working with realistic images such as photographs, including scans and images from stock photography CDs.</td>
</tr>
<tr>
<td>Pixels</td>
<td>Contraction of Picture Element. The smallest element of a digital image.</td>
</tr>
<tr>
<td>PostScript</td>
<td>A programming and page description language that has become industry standard for electronic publishing. It is used to describe the entire page, including both text graphics and images. PostScript is completely independent of the printing device. Developed by Adobe Systems, Inc.</td>
</tr>
<tr>
<td>Prepress</td>
<td>Generic term used to describe the processes involved in preparing images for printing. Includes the input, edit and output stages.</td>
</tr>
<tr>
<td>Printer description files</td>
<td>PPDs (PostScript Printer Definition), and PDFs (Printer Definition Files). These files are used by the Macintosh applications to prepare page and documents for specific output devices.</td>
</tr>
<tr>
<td>Process colors</td>
<td>The four ink colors used to reproduce full color images - cyan, magenta, yellow and black.</td>
</tr>
<tr>
<td>Quertontone</td>
<td>The tone area of an image influencing highlight detail and with density values between the white point and midtone. Typically, printed with a dot area near 25%. See also Highlights, Midtones, Shadows.</td>
</tr>
</tbody>
</table>
Raster file  A file of data that was scanned, processed or output sequentially, bit by bit and line by line. Also known as a bitmap.

Rasterization  The translation of vector information into bitmap information. Bitmaps may also require a new rasterization to comply with the screening parameters (dot shape, dot size) of the imagesetter that will expose them on film. See also RIP and RIPing.

Register  Fitting of two or more printing images or plates in exact alignment with each other.

Register marks  Crosses or other targets applied to original copy prior to printing. Used for positioning films in register or for register of two or more colors in process printing.

Relative Colorimetric  A rendering intent method in which colors that fall within the output color space remain the same. Only colors that fall outside are changed to the closest possible color within the output color space. When using this method, some closely related colors in the input color space can be mapped to a single color in the output color space. This reduces the number of colors in the image.
Rendering Intent

All printers, monitors and scanners have a gamut or range of colors that they can output (or view in the case of a scanner). If a color needs to be output and is outside the gamut of the output device, it must be mapped or approximated to some other color, which exists within the gamut. Rendering Intent enables you to compress out-of-gamut colors into the color capability of the press you are using. You can set any rendering intent value for RGB elements by selecting the required from the Rendering intent options list. The default value for RGB is Perceptual (photographic). The default value for CMYK is Relative Colorimetric.

There are several methods that can be used when translating colors from one color space to another. These methods are called Rendering Intents because they are optimized for various uses. When working with ICC profiles, it is important that you select the Rendering Intent that best preserves the important aspects of the image. Each rendering method specifies a CRD for color conversions. You can modify the rendering method to control the appearance of images, such as prints from office applications or RGB photographs from Photoshop.

Resolution

The number of pixels, points or dots per unit of linear measurement. For example, pixels per millimeter on a video display, number of dots per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically and horizontally. For example, a square millimeter with a resolution of 12 contains 144 pixels. The higher the resolution, the more image detail is recorded and the larger the digital file size.

RGB

Abbreviation for the additive primaries Red, Green and Blue. They are used in video monitors, scanning, and other uses where the light is direct and not reflected. The component colors are the three predominant colors in the visible light spectrum detected by the human eye. Combining these 3 colors together creates white light.
<table>
<thead>
<tr>
<th><strong>RIP</strong></th>
<th>Abbreviation for Raster Image Processor. This is a software program or hardware device that converts vector information into pixel information to be imaged on an output file. This output file is imaged based on commands from the page description language.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RIPing</strong></td>
<td>The process of rastering or converting bitmaps and vector graphics into raster images suitable to the screening parameters of the output device. Files are RIPed prior to exposure or plotting.</td>
</tr>
<tr>
<td><strong>Saturated color</strong></td>
<td>A color where the high and medium values approach 100%. In a saturated clean color, the values of the wanted colors are near 100% and the value of the unwanted color is near 0%. For example, when the color is red, 5% cyan, 90% magenta, 80% yellow is more saturated than 30% cyan, 90% magenta, 80% yellow.</td>
</tr>
<tr>
<td><strong>Saturated (presentation)</strong></td>
<td>A rendering intent method which scales all colors to the strongest saturation possible. The relative saturation is maintained from one color space to another. This rendering style option is optimal for artwork and graphs in presentations. In many cases, this style option can be used for mixed pages that contain both presentation graphics and photographs.</td>
</tr>
<tr>
<td><strong>Saturation</strong></td>
<td>The strength of a color.</td>
</tr>
<tr>
<td><strong>Screen angle</strong></td>
<td>The angle of rows of halftone dots represented in degrees. During output of films for reproduction, the dot arrangement of each separation film is placed at a distinct and different angle to the other separations. See also <em>Moiré</em>.</td>
</tr>
<tr>
<td><strong>Screen rulings</strong></td>
<td>The number of rows of printing dots per inch on a halftone film. A 150lpi-screen ruling provides much better quality than 65lpi.</td>
</tr>
<tr>
<td><strong>SEF</strong></td>
<td>A printer page orientation, where pages are delivered short end first.</td>
</tr>
<tr>
<td><strong>Shadows</strong></td>
<td>The darkest part of an image (original and reproduction) having densities near to maximum density. In the reproduction, shadows are printed with dot areas between 80% and 100% See also <em>Highlights</em> and <em>Midtones</em>.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Shingling</strong></td>
<td>A procedure that moves the image area of a page toward the direction specified, usually towards the binding, in order to compensate for creep.</td>
</tr>
<tr>
<td><strong>Signature</strong></td>
<td>Sheet of printed pages which when folded becomes part of the publication.</td>
</tr>
<tr>
<td><strong>Solid</strong></td>
<td>The point in the picture printed with a dot area of 100%. See also <strong>Highlights</strong>, <strong>Midtones</strong> and <strong>Shadows</strong>.</td>
</tr>
<tr>
<td><strong>Spot color</strong></td>
<td>An additional separation (fifth, or more) that is used with special inks to achieve difficult color combinations, such as gold, or chocolate brown. Spot color is sometimes used by graphic artists to define special corporate colors, for example, for company logos. On the IC-304 print controller, spot colors are translated into CMYK values using a dictionary, that can be edited to adjust CMYK values.</td>
</tr>
<tr>
<td><strong>Step and Repeat</strong></td>
<td>The procedure of copying the same image by stepping it in position both horizontally and vertically according to a predetermined layout.</td>
</tr>
<tr>
<td><strong>Stochastic screening</strong></td>
<td>A method of creating frequency-modulated halftones that depends on the number of laser dots in a given area rather than the size of the laser dots in a given area. The dots are randomly placed and very small. Areas with a higher dot percent have more spots exposed in that area and those with a low dot percent have fewer spots. Stochastic screening is used to eliminate moiré and improve picture detail and sharpness in high-end color printing.</td>
</tr>
<tr>
<td><strong>Subtractive color model</strong></td>
<td>A color process in which the red, green and blue components of the original subject are reproduced as three super-imposed images in the complementary (subtractive) colors of cyan, magenta and yellow respectively. See also <strong>CMYK</strong>, <strong>Process colors</strong>, <strong>Additive color model</strong>.</td>
</tr>
<tr>
<td><strong>Three quartertone</strong></td>
<td>Tone area of an image influencing the shadow detail and with density values between the Midtone and the Dark Point. Typically printed with a dot area near 75%.</td>
</tr>
</tbody>
</table>
Three quartertone  
Tone area of an image influencing the shadow detail and with density values between the Midtone and the Dark Point. Typically printed with a dot area near 75%.

Tone compression  
The reduction of the density range of an original to the density range achievable in the reproduction.

Tone reproduction curve  
A graph showing the density of each point of the original and its corresponding density on the reproduction.

Trapping  
Creating and overlap (spread) or an underlap (choke) between colors that adjoin each other to hide misregistration during printing. Trapping is sometimes referred to as spreads and chokes, or fatties and skinnies.

UCR  
Abbreviation of Undercolor Removal. This is a method for reducing the CMY content in neutral gray shadow areas of a reproduction and replacing them with black. As a result, the reproduction appears normal but less process color inks are used. See also GCR.

Unsaturated color  
A color whose highest value is less than approximately 80%. In an unsaturated, dirty color, the difference in the values of the wanted colors and the unwanted color is relatively low.

For example, when the color is red, 30% cyan, 80% magenta, 70% yellow is more unsaturated than 0% cyan, 90% magenta, 80% yellow.

Variable Information (VI)  
Variable information (VI) jobs are jobs in which the printed materials are individualized for specific recipients or purposes. These materials can include bills, targeted advertising and direct mailings.

Vector drawing  
The geometric system used to define lines and curves in many computer graphics most often used for line drawings.

Vignette  
See Degradé.

Virtual printer  
For Macintosh and Windows networks, the IC-304 print controller provides three default network printers, known as virtual printers. Virtual printers contain preset workflows that are automatically applied to all print jobs processed with that virtual printer.
**White point**  
The whitest neutral area of an original or reproduction that contains detail and is reproduced with the smallest printable dot (typically 3% to 5%).
Index

A
Accounting Viewer
  printing and exporting, 103
  viewing information, 101
Alerts window, 12
AppleTalk Setup, 175
APR/OPI, 230
  about, 119
  deleting high resolution path, 231
  setting high resolution path, 230
  archiving and retrieving jobs, 91
Auto tray, 205

B
Black overprint, 215
Brightness slider, 159

C
Calibrated media types, 145
  calibration
    about, 138
    method, 138
    mode, 139
    off the glass, 139
  Calibration Device, 190
  CMYK rendering intent, 219
  CMYK source profile, 219
  Collated, 224
  Color Mode, 217
  color tools, 146
    Gradation Tool window, 154
    Profile Manager, 146
    Spot Color Editor, 149
configuration
  backup, 198
  restoring, 199
  Contrast Center, 160
  Contrast slider, 159
  Copies and Pages, 203
  Creep in, 211
  Creep out, 211
  CT (Continuous Tone) images, 215
Cut & Stack, 206

D
date and time
  changing, 171
Destination profile, 219
  destination profile
    deleting, 149
    importing, 148
  Disk Wipe, 179
  Domain
    changing, 170
Downloads page, 65

E
Emulate RGB Elements, 219
Emulate Source Paper Tint, 219
EPS, 4
Exceptions, 226
  exporting
    accounting log, 103
    as PDF2Go, 120
    job report, 108

F
Face down, 224
  file formats supported, 4
  fonts, 121
    list, 121
    managing, 124
  using the downloader for Mac, 124

G
  GAP files, 30
  Gloss Mode, 204
  Gradation, 218
  Gradation Tool window
    about, 154
    controlling brightness, 159
    controlling contrast, 159
    creating tables, 157
    editing tables, 156

  navigation buttons, 158

  opening, 154
  previewing a job, 155
  using preview tools, 158

  Graphics quality (Text, Line), 213

H
Help menu
  opening About window, 18
  high-resolution workflow
    about, 119
    Creo APR, 120
  hot folders
    about, 29
    file formats supported, 30
    from Mac OS X, 31
    from Windows, 31

I
IC-304 Image/Graphics Quality, 213
IC-304 print controller
  overview, 2
  turning off, 19
  turning on, 8
Identify black, 218
Image Position, 225
Image quality, 213
importing
  destination profiles, 148
  files, 70, 71
  source profiles, 146
imposition
  about, 110
  printing brochure, 114
  printing business cards, 111
  workflows, 110
inline elements, 165
IPX printing
  about, 173
  setting parameter, 173

J
job
abort running, 85
accounting, 100
archiving, 91
batching, 86
deleting, 88
duplicating, 91
importing, 70
moving to storage, 87
on hold, 80
retrieving archived, 92
running, 80
submitting, 90
waiting, 80
Job History window
opening, 195
viewing, 93
Job Info area, 12
job parameters window, 16
Color, 17
Exceptions, 17
Finishing, 17
Imposition, 17
Print, 17
Quality, 17
Services, 17
Job Preview & Editor window
Booklet tab, 95
navigation buttons, 94
opening, 94
preview tools, 94
Thumbnails tab, 96
Job Report window, 108
about, 107

L
localization
setting language, 185
setting measurement units, 185
LW (Line Work) images, 149, 215

M
Mac OS X
copying PPD file, 26
setting network printer, 27
using a hot folder, 31
Macintosh
printing from, 28
Media Type, 204
menu bar, 9
messages
filtering, 196
printing list, 197
system disks threshold, 193
Messages window, 195, 197
N
network printer
setting for Mac OS X, 27
Network Setup, 172
O
on hold status, 80
P
page exceptions
sample workflow, 117
Paper Size, 204, 207
Paper Stock, 203
passwords, 177
PDF2Go
exporting, 120
PDL files, 6, 22
Perfect bound, 207
Personal Print Markup Language (PPML), 4, 163
PostScript files
in VI, 165
PPD file
copying for Mac OS X, 26
setting job parameters, 202
PPML. See Personal Print Markup Language (PPML)
Preferences window
Administrator, 168
date and time, 171
General, 168
Localization, 185
Network Setup, 172
opening, 14, 168
Remote Tools Setup, 176
Security, 177
Server Setup, 169
System disks, 180
Preserve pure colors, 219
Preview window, 211
Print, 6, 105, 202
Print Method, 203
Print Optimized, 120
Print Order, 224
Print parameter, 202
Print Queue, 68, 80
status indicators, 81
printer driver
copying from Windows, 24
Printer Status pane, 10, 11
printing
using a hot folder (Mac OS X), 31
using a hot folder (Windows), 31
Process, 6, 105
Process Queue, 68, 80
status indicators, 81
processing a job, 68
Profile Manager
about, 146
deleting profile, 149
importing destination profile, 148
importing source profile, 146
PS overprint, 215
Q
Quality, 212
QuarkXPress, 150
queues, 10
adding columns, 82
changing order, 85
managing, 80
removing columns, 82
reorder columns, 82
resuming, 84
suspending, 84
R
Remote Scanning Application, 72
Resource Center
Backup & Restore
Configuration, 198
Fonts, 124
opening, 15
Profile Manager, 146
Virtual Printers, 105
restoring
configuration, 199
resubmitting
processed jobs, 72
reusable elements, 164
RGB rendering intent, 219
RGB source profile, 219

S
Saddle stitch, 207
Scaling, 225
scan box
managing, 73
scanned images
managing, 77
Screen Optimized, 120
Screening, 215
Security
Disk Wipe, 179
setting passwords, 177
Separations
buttons, 156
Server name
changing, 169
Server Setup
changing date and time, 171
changing server name, 169
Simplex, 203
Slip sheets between copies, 225
source profiles
deleting, 149
importing, 146
spot color
creating new, 151
deleting, 152
status indicators
in queues, 81
status information, 84
Step & continue, 206
Step & Repeat, 206
Storage area, 6, 65, 69, 87
Store, 6, 105
submitting
job, 68
job from Storage area, 90
suspend/resume button, 84
system disk threshold
setting, 181
System Disks, 180

T
target calibration, 138
TCP/IP Setup, 174
time, changing, 171
title bar, 9
toolbar, 9
Trapping, 214
Trim orientation, 208
Trim Size, 207
turning off
IC-304 print controller, 19
turning on
IC-304 print controller, 8

U
user passwords, 177

V
Variable data Intelligent Postscript
Printware (VIPP), 165
Variable Information (VI)
about, 162
booklet, 164
document formats, 163
inline elements, 165
jobs, 162
printing VI jobs, 165
sub-job, 164
Variable Print Specification (VPS),
4, 163
virtual printer
adding new, 106
Print, 105
Process, 105
Store, 105
VPS. See Variable Print
Specification (VPS)

W
Web Center
about, 63
connecting from a client, 63
Downloads page, 65